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Model Repository

[

Enterprise Architect is a rich modeling platform that can be used in a wide range of modeling and design situations, from
a single user accessing a file based repository to a large and distributed team of thousands of modelers working all over
the world using a Cloud Based Repository. The repositories can be scaled up and down, and a project that started with a
single user can be seamlessly scaled up to a large multi-user repository.

Enterprise Architect has been built to support inter-disciplinary modelers collaborating to create a single and unified
view of a system or enterprise, and the platform has numerous built in features to support this team development. By
taking advantage of the base UML modeling language, in addition to the numerous extension languages such as BPMN
and SysML, plus highly effective frameworks such as TOGAF and UPDM, modelers, designers, managers and others
can build comprehensive, inter-connected models that fully expresses the capabilities, structure and behavior of fully
functioning, multi-layered, complex systems and/or enterprises.

In addition, there are features that allow modelers to discuss the model, such as the element discussion window, and
review work that has been in progress in the Team Review window. Modelers can even send model mail to
communicate ideas. Model Security can be implemented, which facilitates collaboration and prevents work accidentally
being overridden.

There are a range of project management features, such as tasks and resource allocation and a Gantt Chart to view
progress on tasks over time, and a Project Calendar that keeps track of important project events.

Integration is so easy and the feature sets so powerful that strategic thinkers, business managers, architects, information
and data modelers, testers, software engineers and many others will derive great benefit from using the tool and
incorporating their models into the overall vision.

Key Concepts

Repository Format Enterprise Architect models are stored in standard relational databases. This
approach has been built into Enterprise Architect from the very first version.
Using a relational database provides a huge advantage over other tools that are
limited in scope and capability by relying on a simple text file based model storage
system. With support for two file based repository formats (MS JET and Firebird)
plus a number of industry standard DBMS servers (such as SQL Server, MySQL
and Oracle) plus Cloud based storage, Enterprise Architect provides fast, scalable,
flexible and transparent access to models in a wide range of deployment scenarios.

Modeling Languages Enterprise Architect is based on industry standard UML, a specification
maintained by the Object Management Group (OMG). Although initially
conceived as a modeling language primarily for software development, over the
years the capabilities and formal (standard) extensions have allowed the UML to
develop into a rich set of constructs and modeling behaviors that provide very rich
and detailed support for everything from software, to business processes,
embedded software, enterprise architecture, organizational charts, strategic model,
mind mapping, requirements management and much more. The success of UML
has been proven over and over again in the real world and the number of new
technologies and modeling profiles that use UML as the underlying
'meta-language' are tribute to the power and effectiveness of UML.

Team Development From the very first version of Enterprise Architect the goal has been to provide the
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best and most accessible support for Team based development. A wealth of tools
and capabilities have been designed into the platform over the years to support
security, scalability, information sharing, concurrent access, management,
reporting and querying. With the growth of the internet and distributed
development scenarios, Enterprise Architect has evolved to be the pre-eminent
platform for developing models and designs in a globally distributed situation. The
Cloud Server based deployment offers high availability, excellent performance
and simple configuration to rapidly bring diverse and distributed teams into a
single, living repository where work can be easily shared, reviewed, discussed and
managed.

Scalability By leveraging the power of today's DBMS servers and Cloud Based technologies,
Enterprise Architect can be easily scaled up to truly epic proportions. Millions of
objects can be stored and accessed by large and dispersed teams in real time. The
level of scalability is limited solely by the choice of DBMS or Cloud Technology
and the capabilities of the network and server infrastructure the model is deployed
on. In practice, over the many years that Enterprise Architect has been used in
industry, modelers and designers have taken advantage of the powerful in-built
scalability to construct stunning and often huge models that capture an enormous
amount of information about complex and highly inter-connected systems and
enterprises.

Security Due to the nature of the Repository used by Enterprise Architect and the possible
deployment scenarios, security can be managed in a number of ways. In the
Corporate edition of Enterprise Architect and above, there is built-in support for
defining users and groups that permit locking and management of elements and
Packages within the model. This will be discussed later in the section on Security.
In addition, it is also possible to restrict general access to models by using file
based security access for the MS JET and Firebird based models ((EAP and FDB)
and DBMS server authentication and access for the larger database server based
systems. As a further refinement it is also possible to restrict access to a model
using the HTTPS protocol when connecting to a Cloud Based server.

Versioning Enterprise Architect uses industry standard XMI (XML Interchange) format files
to store and version model Packages. By integrating the import and export of XMI
model fragments into a version control system (such as SVN) supported by
Enterprise Architect, you can maintain multiple versions of the same model in
different repositories and exercise fine control over the development and design
process. Given the nature of this versioning system, there are several different
scenarios that can be used to maintain different models and how teams access
information. For example, where the versioning system is used as the single point
of truth and de-facto Repository, it could be convenient to use many workgroup or
single user based Repositories that reflect the actual model at a particular point in
time. In contrast, where the versioned files are mainly held for backup and
baseline purposes only, a larger, Team based DBMS server would be used to
provide the model sharing and collaboration capabilities. So whatever the actual
needs are, Enterprise Architect has a number of solution scenarios that can be
adapted to provide the right level of change management and collaborative
development.

Example Repository Tasks

Task
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Create a project in a simple, file-based repository (EAP and .FEAP files)

Create the project in one of a range of DBMS repositories - these provide for larger models with more concurrently
connected users (Corporate and extended editions)

Manage change within the model
Maintain the integrity of the project data
Share the reference data used across the project, between models and between projects

Allow each user to configure their personal preferences for how project tools display and behave on their
workstation

Document your model through document or web reports, which you can tailor to your purposes
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Repository Overview

An Enterprise Architect repository is stored in a relational database; this can be a file based database such as MS Access
or Firebird, or a database management system (DBMS) such as Oracle or MS SQL Server, on a network or in a Cloud
Based Repository. It is common to start with a File Based Repository and, when the project gets some momentum and
there are a number of modelers accessing the repository, to transfer it to a DBMS. Whichever type of repository is
implemented, the user interface remains the same and users can seamlessly move from one type of repository to another
and continue to contribute as a team member on this powerful modeling platform.

Concepts

Concept Description

Repository as a File In any version of Enterprise Architect you can store a project in a single file with a
.eap or .feap extension.

e A .cap file is a Microsoft JET database, so you can also open it using MS
Access 97, 2000, 2003 or 2013, or any other reporting tool that can work with
JET databases

e A feap file is a Firebird project file

Repository in a DBMS In the Enterprise Architect Corporate edition (and above) you can also use a
(Database Management suitable DBMS repository for projects.

System) DBMS projects have the same logical structure as .eap and .feap files, but provide

much greater scalability and concurrent access. You connect to a DBMS using
ADO/ODBC (see Connect to a Data Repository). Please note that when
configuring an ODBC data source on a 64 bit machine, you should access the
ODBC data manager using the 'Main Menu | Tools | ODBC Data Sources' menu
option, as this will load the correct ODBC manager to access 32 bit data sources as
used by Enterprise Architect.

Repository in the Cloud In the Corporate Edition (and above) of Enterprise Architect you can further enable
the distributed capabilities of Enterprise Architect and use the Internet or local
network to connect to a Cloud Based server on which one or more Repositories
have been installed and configured for access. The Cloud Server is free software
available from Sparx Systems and is relatively simple to set up and configure on a
suitable Windows based machine. Firebird files or any DBMS server are the
required Repository types supported by the Cloud Server, and these can reside on
the same machine for best performance or on another machine to maximize local
and network access. Cloud based repositories provide the ultimate in distributed
development and minimal client configuration. It is in fact much easier to deploy a
Firebird based repository on a Cloud Server for distributed development than to set
up and manage a full DBMS solution.

Models Enterprise Architect uses this terminology when discussing Repositories and their
contents.

1. A Model is a related group of content that expresses some focused aspect of a
system or enterprise that is related by the modeling tools and paradigm used. For
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example, you might build a 'Usecase Model' that describes behavior and scenarios
using UML Use Cases. Process models, architectural models, behavioral models,
structural models, Class models and so on are all Models within the current Project.

2. A Project is a group of models that has a single unifying purpose. For example, a
Project to design the navigation systems for a new aircraft or automobile would be
considered a single Project. Within this Project there would be multiple models.
Projects typically define levels of security, types of views and models necessary,
procedures and other management tasks necessary to deliver the product. Project
management capabilities in Enterprise Architect are quite rich and allow for
resource management, security, change management, testing and other typical
project management tasks.

3. A Repository is a single File, DBMS database or Cloud Server address that
contains one or more Projects. Typically, file based repositories such as MS JET
and Firebird models contain a single Project with multiple models that can be
shared by a small workgroup or only accessed by a single modeler. DBMS and
Cloud based Repositories will often contain more than one Project, especially
where the Projects are somehow inter-related or co-dependent.

Adding Initial Content After creating and accessing your new project in whatever form the Repository
takes, you can now use the Model Wizard to create Model Packages that range
from generic and simple views to more complex and pattern based content.

You can add Models to a project from the Project Browser by:

e Right-clicking on an existing model and selecting the 'New Model' or 'Add a
New Model using Wizard' options

e Right-clicking on a Package and selecting the 'Add | Add a New Model using
Wizard' option

e Clicking on an existing model, pressing the Insert key and selecting the 'New
Model' or 'Add a New Model using Wizard' menu options

e Clicking on a Package, pressing the Insert key and selecting the 'Add a New
Model using Wizard' menu option

Opening Existing Projects Existing Projects are accessible via the 'Main Menu | File | Open Project' option.
They are also accessible from the 'Recent' list in the Main Menu and on the Start
Page.

Connecting to an existing DBMS or Cloud based Repository is discussed in more
detail under the relevant sections on working with those Repository types.

For new users, you can use the 'Main Menu | Help | Open Example Model' option to
open and explore the Enterprise Architect Example Repository supplied with
Enterprise Architect. This example is not so much a fully worked example as a
collection of models that show how you can leverage the power of the Enterprise
Architect platform and the UML to create a wide range of visual and text based
models.

DBMS Repositories You can connect to any of these data repositories:

e MS Access 97, 2000, 2003 and 2013 (in all editions - .eap files are stored in
Microsoft JET databases)

e Access 2007

e SQL Server 2000 onwards

e SQL Server Express 2005 onwards
e MySQL

e Oracle 9i, 10g, 11g and 12¢

e  PostgreSQL

e Adaptive Server Anywhere
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In brief, to create a new data repository, you first create a new database with the
DBMS management software, then run supplied scripts to create the logical
structure.

You then use Enterprise Architect data transfer functions to move a project from a
.eap, .feap or DBMS model into the new project. Details are available under the
Server Based Repositories section.
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Projects Defined

An Enterprise Architect Project is a repository for storing, manipulating and managing one or more Models. A single
repository can contain many models, and a Repository can be either file based, hosted in a larger DBMS system or based
in the Cloud.

Concepts

Concept Detail

Project A project can contain a single model, or a number of models, each of which defines
a particular system or process. A model contains the diagrams, elements,
relationships and associated metadata that define the structure and function of the
system or process. These components are organized into a hierarchy of Packages,
which help to group and manage related components.

Model Different aspects of the process or system - or their development - are defined by
Model Packages, which you generate from templates specifically structured to
support the aspects that the Model Packages represent, such as requirements or
deployment. You can generate these templated Packages at any level of the
hierarchy, but as they are created with their own content they are more useful at the
top levels.

View The top-level Packages in a model can also be Views, which represent partitions of
the model that you define yourself.

You can start with standard Views such as Class or Component, or create whatever
partitions are appropriate to your model.

Example Project Structure + | gy Development Model
= Lgi Requirements Model
+ @] Requirements View
= | Use Case Model Package
22 Use Case Diagram
+ [ Actors
= | Primary Use Cases
22 Primary UCDiagram
| Customer Setup
+ D Use Casel
(D Use Case?

Each View or Model Package contains Packages; Use Case Model Package
contains:

e  Actors and

e  Primary Use Cases

It also contains the diagram Use Case Diagram, which could be an overview of the
Package structure or function.

Each Package itself can contain one or more diagrams, one or more Packages, and
several elements; the Primary Use Cases Package contains the:

e  Primary UCDiagram

e  Customer Setup Package
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e Use Casel element
e  Use Case2 element

Each subordinate Package also contains diagrams, elements and (if necessary)
further Packages; the elements are related by connectors created in the diagrams,
and each element and connector has properties, attributes, operations and
extensions defined in the respective 'Properties' dialogs.

Note that models do not have to be constructed this way. Depending on the
methodology you are following and information you need to model, the project
structure might look completely different. In addition, many architectural
frameworks such as TOGAF and Archimate specify their own project structure as
part of their overall solution architecture.
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Opening a Project

An Enterprise Architect project is used for storing and managing the components of one or more UML models. The
Desktop and Professional versions of Enterprise Architect work on file-based projects (.eap files). If you are using the
Corporate edition (or above), you can also use one of a number of DBMSs such as Oracle or MySQL, or a Cloud Based
server to host the project repository.

When you select to open a project, you can:

e Select a shortcut to a recent project, to open it

e  Browse for another existing project to open

e Remove a shortcut from the list of recently-opened projects

e  Specify connection details for opening a project hosted on a DBMS

e  Connect to a project via the Cloud

e C(Create a new Enterprise Architect project file

Access

Ribbon

Menu

Keyboard Shortcuts

Options

Field/Button

Local File

Connect to Server

Connect to Cloud

(c) Sparx Systems 2015 - 2016

> Open Project

File | Open Project

Ctrl +O

Action

Click on this button to open a file browser dialog, and locate and select an existing
.EAP or .FEAP file; the .EAP file can be a project file or a shortcut to a project
hosted on a DBMS. Alternatively, click on the drop-down arrow and select the
'New Project' option to create a new project.

Click on this button to specify connection details for opening an Enterprise
Architect project that is hosted on a DBMS. The 'Windows Data Link Properties'
dialog displays; start to define the connection to the project's server-based
repository.

You can also click on the drop-down arrow and select:

e 'Connection Wizard' - the 'Data Link Properties' dialog again displays

e 'Connection String' - the 'Connection String' dialog displays; type in or paste
the connection string and click on the OK button to connect directly to the
project

Click on this button to connect to a project through the Cloud. The 'Cloud
Connection' dialog displays, on which you specify the server, URL and model name
to access via the Cloud.
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Recent Projects This panel lists the most recently opened projects, up to a maximum of ten. To open
one of these projects either double-click on the name, or click on it and then click
on the Open button.

Each project name is shown with its access path. You can edit the access path by
right-clicking on it and selecting the 'Edit Connection String' context menu option;
make the changes on the 'Connection String' dialog, and click on the OK button.

This list is also displayed:
e  On the Start Page, under the 'Recent' heading

e As adrop-down menu under the Open Project button on the Default Tools
toolbar

e  As part of the 'File' menu

Remove Selection from Click on a project name and click on this button to remove that project name from
List the Recent' list.

Show this Dialog at Startup Select the checkbox to show this 'Open Enterprise Architect Project' dialog
automatically upon starting Enterprise Architect. Deselect the checkbox to hide the
dialog.

Default Project to Open Click on a project name in the 'Recent' list and select this checkbox to open the
selected project automatically whenever you start up Enterprise Architect.

Open Click on this button to open the currently selected project in the Recent Project list.
Cancel Click on this button to close this dialog without any further action.
Help Click on this button to display this Help topic.

Notes

e Use of a DBMS and/or Cloud for hosting the model repository is available in the Corporate, Business and Software
Engineering, Systems Engineering and Ultimate editions of Enterprise Architect

e  Enterprise Architect supports these DBMS products for hosting model repositories:
- SQL Server and SQL Server Express;
- MySQL
- Oracle 91, 10g, 11g or 12¢
- Postgre SQL and
- ASA
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Project Shortcuts

Enterprise Architect enables you to create a desktop shortcut (or proxy file) to an Enterprise Architect project (Cloud,
DBMS or file-based). Each shortcut is a file containing the connection string for the model. In addition, the shortcut also
defines views that Enterprise Architect should open when it opens the model, as outlined here. In this manner it is a
convenient and customizable way of quickly sharing a connection to a Cloud based model without requiring other users
to know the details of the connections string, model name and other parameters.

Access

Ribbon > Save As Shortcut

Menu File | Save as Shortcut
Topics
View Detail
Diagrams Define one or more specific diagram(s) to be loaded on opening the project.
Model Search Open the Model Search with a specific text string and search type.

For searches operating on the current tree selection, a diagram in the target Package
must be opened first.

If you use a custom SQL search, the SQL must include ea guid AS CLASSGUID
and the object type.

You specify a single Model Search to open.

The Relationship Matrix Open the Relationship Matrix with a saved profile.
with a saved profile

You specify a single Relationship Matrix profile to open.
The default Team Review Open the default Team Review document.

You specify the Team Review once.

Working Set Open a working set.
You specify a single Working Set to open.

This is very similar to the shortcut itself, opening a defined set of diagrams and
views. However, the working set can also open source code editors, therefore
widening the capabilities of the shortcut alone.

Working sets make it easy to customize the main views you want to open without
having to resave your project short cuts. The working set is easy to tailor to your
changing requirements, adding greater flexibility to any short cut that calls the
working set.

Also, working sets provide the capability of storing the currently-engaged files
when closing a model, and reopening them in the context in which you were last
using them. The basic project shortcut can also do this, but once the work
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environment is captured the shortcut returns to the same set up each time you use it.
The working set always captures the current work environment each time the model
closes.

This option can be very useful in, for example, a coding environment when you
want to return to the last files you were editing.

Workspace Layout Apply a selected Workspace Layout, which opens and sets out the appropriate
screens and windows for a specific area of work, such as model simulation.

You specify a single Workspace Layout to open. However, by creating and using
separate shortcuts you can open Enterprise Architect in exactly the configuration
you need for the work you want to do - modeling, coding, or debugging, for
example.

An example shortcut You might create a shortcut to open, in sequence:
e A Development module
e The Model Search for a simple search on the term Issue
e The module Issues diagram
e The module 'Changes' diagram

Enterprise Architect opens the appropriate windows in the sequence in which you
list the options, displaying the last view in the list as the active view.

In this example, the project opens with the Enterprise Architect work area showing
the two diagram tabs and the 'Model Search' tab, and with the 'Changes' diagram
displayed in the Diagram View.

Notes

e If specified, the shortcut views override any default diagram defined for the model or current user

e A shortcut does not affect the original Enterprise Architect .exe file or icon, or any other shortcut you might have
defined; you can use all of these independently

e Ifyou are using a database repository other than MS Access 97, 2000, 2003 or 2013, you can configure the shortcut
to encrypt the password used to set up the connection between Enterprise Architect and the repository; the
Enterprise Architect user does not have the real password, thereby preventing them from accessing the repository
using other tools such as Query Analyzer or SQLPIus
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Create Project Shortcut

You can create a shortcut to an Enterprise Architect project (either a DBMS project or file based project). The shortcut
can specify additional windows and diagrams to open up automatically every time the shortcut is run, to create a working
environment in advance for other users.

Shortcuts are stored with a .EAP extension, but are actually small text files that tell Enterprise Architect what project to
open and what initial views and windows to display.

Access

Ribbon

Menu

: Save as Shortcut

File | Save as Shrotcut

Create a project shortcut

Step

1

Action

Open Enterprise Architect.

Open the required project.

Select the 'File |Save Shortcut' menu option.

The 'Save Project Shortcut' dialog displays.

Click on the D button at the end of the 'Target File' field.
The 'Save Project As' dialog displays.

Browse for the appropriate file location and, in the 'File name' field, type an appropriate filename.
All shortcuts are .EAP files, regardless of whether the model itself is a .EAP file or a DBMS model.

Click on the Save button to return to the 'Save Project Shortcut' dialog.

Click on the Add Other button and select the required option to define:

A diagram to open

A Relationship Matrix profile to open
The Team Review

A Model Search to perform

A working set to apply

A workspace layout to apply

The appropriate browser or dialog displays to define the view to display; enter the details and click on the
OK button.
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The view is added to the 'Actions when model is opened' field; the entry is automatically selected, with a
tick in the checkbox.

9 Repeat steps 7 and 8 for as many additional views as you require.

10 Review the items in the 'Actions when model is opened' field.
e Ifyou decide not to have an item in the shortcut, deselect its checkbox
e [fyou want to clear all selected items, click on the Include None button

Unselected entries are deleted when you save the shortcut.

11 If you decide to change the sequence and/or make a different view display first in the Diagram View:
e Click on the appropriate entry
e  Click on the 'Up Hand' or 'Down Hand' buttons

12 Click on the OK button to save the shortcut.

Notes

e When you subsequently open the 'Save Project Shortcut' dialog, it lists the currently-opened views in the order in
which they were opened; you can add further views or remove them from the shortcut
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Capture Current Work Environment

You can capture the current Enterprise Architect work environment in your shortcut. This maintains the work
environment from that point, and is useful if you intend to close and re-open the model and return to the same
configuration many times.

If you simply want to return to whatever work environment you happen to be in each time you close the model, you
should use a work set that captures the current environment, either by itself or as part of a broader project shortcut.

Access

Ribbon : Save as Shortcut

Menu File | Save as Shortcut

Capture your current work environment

Step Action

1 Open Enterprise Architect.
2 Open the required project and work in it.
3 At the point at which you decide to capture your work environment in a shortcut, ensure that:

®  You have opened all diagrams you require

e [fnecessary, you have opened the Team Review, Model Search (with appropriate search term and
type) and/or Relationship Matrix (at the appropriate profile)

e The view you want to resume work on is the last one opened

4 Select the 'Save As Shortcut' menu option.
The 'Save Project Shortcut' dialog displays, showing a list of actions derived from the views you currently
have open.

5 If you accessed Enterprise Architect via a shortcut, the 'Target File' field displays the file location of that
shortcut.

Otherwise, click on the D button at the end of the 'Target File' field.
The 'Save Project As' dialog displays.

6 Browse for the appropriate file location and, in the 'File name' field, type an appropriate filename.
All shortcuts are .EAP files, regardless of whether the model itself is a .EAP file, .FEAP file or DBMS
model.

7 Click on the Save button to return to the 'Save Project Shortcut' dialog.

8 In the 'Actions when model is opened' field, click on the Include All button.

(c) Sparx Systems 2015 - 2016 Page 21 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

9 If you also want to save current window positions click 'Add Other' followed by 'Add Workspace Layout'.
The dialog shown allows you to select an existing layout or save the current layout.

10 Click on the OK button to save the shortcut.

(c) Sparx Systems 2015 - 2016 Page 22 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

Encrypt Repository Password

If your model is developed on a DBMS repository, the 'Save Project Shortcut' dialog has an 'Encrypt Connection String'
check box.

You can create the shortcut actions and, if necessary, select the checkbox to encrypt the database connection string.

You distribute the shortcut file to the database users who are to access the model. The users then have an encrypted
string that prevents them from directly accessing the database using other tools.
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File Based Projects

O
0—0

Enterprise Architect provides a convenient light-weight, low-barrier and portable file based repository out-of-the-box,
which is ideal for modelers who want to start work immediately; with the file based repository you can be modeling
within a few minutes. When a number of colleagues want to contribute to the models, the file can be moved to a
file-share and it is possible to work with this setup even when the model becomes quite large and the number of users
increases to ten or more. All editions of Enterprise Architect support this type of repository in the form of a .eap file in an
Access database, or a .feap file in a Firebird repository.

You can create your own repository from scratch, but a default repository (EABase.eap) is conveniently supplied, which
is located in the Enterprise Architect installation directory. The file acts as a template for creating new projects and can
be copied to give you a head start in creating a repository. You can tailor this repository to suit your organization or
create your own base repository. A File Based Repository can be easily transferred to a DBMS based repository using
the Project Transfer feature, allowing a project to be scaled up when the team increases in size or organizational policy
dictates it.

File-based project tasks

Task Detail

Create .EAP Project Files Select one of:
e 'File | New Project' menu option
e 'Local File | New Project' option on the 'Manage Projects' dialog, or
e 'New File' option on the Start Page

All of these options display the New Project' dialog; select a directory and enter a
file name for your project.

Once the project has been saved, the Model Wizard displays, which makes a
selection of Model Patterns available; select the Model Patterns to use.

Enterprise Architect adds a model containing the selected Model Packages to the
Project Browser.

Create .FEAP Project Files As for a .eap file (above), except that in the "New Project' dialog, in the 'Save as
Type' field, click on the drop-down arrow and select the .feap file extension.

Enterprise Architect will check your input and display an error message if:

e  Your Firebird repository is not located on the local drive; a Firebird repository
is not appropriate for a network shared project

e The file path contains characters that are not in the system codepage

Location of default The default installation directories, depending on which version you have installed,
(EABase.eap) repository are:
template e Registered version: C:\Program Files\Sparx Systems\EA

e  Trial version: C:\Program Files\Sparx Systems\EA Trial
e Lite version: C:\Program Files\Sparx Systems\EA Lite

A base project contains templates and reference data from which you can quickly
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develop your own project.

Note that in addition to deriving a new model from EABase.eap. it is also possible
to start a new project by copying an existing one. While it is possible to simply
"copy" the EAP file at the file system level, this results in two identical models -
and should only be used when that is the required behavior - for example when
distributing a model to a client for verification etc. If you use the built in functions
within EA to create a new model based on a pre-existent one, Enterprise Architect
will modify the unique identifiers (GUIDS) for all elements and related constructs
so that the new model is essentially unique, and not a simple copy of the existing
one.

Configure Project Having created your project, you can set a range of project parameters to define
defaults, tailor the project to particular coding languages, and ensure consistent
development and use of the project.

Create Custom Templates You can customize any Enterprise Architect project as a template project with
company standards, tutorials, frameworks and any other common piece of modeling
already in-built; with careful planning you can save yourself many hours of work at
project start-up.

Best Practices for File Based Repositories

Single User Simple file based repositories (.eap and .feap files) are best suited to single user
development with the model file placed on the modelers local drive. This is fast,
very efficient and provides a very powerful means of getting started out in
modeling a particular solution. Many models will start out as single user
repositories and only later be migrated into a DBMS or Cloud based scenario for
larger team access. If you need to quickly start work on a project and do some
exploratory work, or you are working alone as a consultant, the .eap or .feap file
format is ideal.

Small Workgroup With the Professional version of Enterprise Architect and above it is possible to
share a .eap file at the network file level. This is really only a suitable solution for
small workgroups (up to say 5 members) who are collaborating on a shared model.
This solution is very much at the mercy of the quality of the network connection
and may be less than ideal if collaborating users increase in number and/or the
model grows very large. As Enterprise Architect on the user's machine is still
running all the queries and performing all database operations on a network file, a
slow network will result in less than ideal performance. As team size and model
size increases it is best to upsize to either a DBMS or Cloud based architecture.

In Conjunction with One additional scenario in which file based repositories can be used to great effect

Version Control is with a version control system such as SVN. If the SVN system holds the master
content, then individual developers/modelers can check out the material of interest
to them into a local .eap or .feap file. When they have made their changes they can
migrate their work back into the shared master. This style of development is quite
effective, and as the import and export of model material from the version control
system works best with single user local project files, it is a good match and a good
use of the two technologies.

Copy of Repository for A further use of the single file repository is for distribution to clients and others for
review and comment, where the original model(s) is located in a DBMS or Cloud
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Storage or Review that the recipient would not have access to. As it is relatively easy to bulk copy a
DBMS model to a local .eap file, this is a good method for passing on a model to a
client or another interested party. If some of the material is restricted, it is possible
to delete sections from this single file repository after the bulk copy is complete and
before passing it on.

Replication If network access is limited and DBMS and Cloud based solutions are not possible,
another (less than optimal but still effective) team based solution is to use the built
in replication features of the .EAP file format. By creating a design master and
distributing replicas to other modelers, it is possible to effectively share and
contribute to a model without having direct shared access to the common model.
On the down side, someone will have to perform the model merges as required and
if there are replication conflicts (two changes to the same item) this will require
manual resolution.

Notes

®  You can also add Model Packages to a project using the New Model From Pattern icon in the Project Browser
toolbar
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Copy a Base Project

When you create a new project, you can use the Model Wizard to define the structure and contents. Alternatively, you
can copy an existing template or base project which is already largely set up, containing company standards, tutorials,
frameworks and any other common modeling structures. You can also copy an operational .EAP or .FEAP project file to
a new file location under a new name to, for example:

e Provide separate copies for individual team members
e Create an evaluation or distribution version of the project

If you intend to use an existing project file as the template for a new project, it is important to use this method rather than
simply copying the .EAP file using Windows Explorer. This process provides the option to reset all the unique identifiers
for Packages and elements, so that your new project is truly unique - otherwise you create an exact copy of the original
project.

Access

Open the template project or existing operational project then;

Ribbon : Save Project As

Menu File | Save Project As

Create a new project from a base project

Field/Option/Button Action

Target Project Type the new project filename.

You can either type in the file path as well, or click on the Browse button and
browse for the required file path.

If this is to be a shared project, store the file on a shared network resource such as a
Network Server or Workgroup Server.

Source Project Defaults to the path and name of the currently-open template or project.

Reset New Project GUIDs If the target project is to be a different project from the source (such as when you
copy a base template), select this checkbox to replace all GUIDs from the base
model with fresh GUIDs in the new model.

However, if the new project is to be a direct copy of the source, or based on a
project that is under version control, we recommend that you deselect this checkbox
to prevent duplication of Packages when the Get Latest facility is used.

Save As Click on this button to save and open the new project.
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Sharing File Based Projects

Enterprise Architect offers a diverse range of functionality designed specifically for sharing projects in team-based and
distributed development environments, through network deployment of model repositories, DBMS based repositories,
Cloud based models, replication and XMI Import/Export.

Features

Feature Detail

Network Deployment Network deployment is possible under three different schemas:
e File based repositories
e DBMS server based repositories, or
e Cloud based deployment (recommended)
DBMS server based repositories offer better:

e Response times than files on networks, due to the inherent structure of the
DBMS

e  Solutions when networking problems are encountered, as they have the ability
to backtrack transactions caused by external breakdowns

Replication Replication enables data interchange between .EAP based repositories and is
suitable for where many different users work independently in parallel
development.

Modelers merge their changes into a Design Master only as required; it is
recommended that a backup is carried out prior to replication.

Replication cannot be performed on repositories stored on a DBMS server.

XMI Import and Export XMI Import/Export can be used to export and share discrete Packages between
developers; XMI enables the export of Packages into XML files which can then be
imported into any model.

Package control can be used to set up Packages for version control and to enable
batch export of Packages using XMI; version control enables a repository to be
maintained by a third-party source code control application that is used to control
access and record revisions.

Notes

e DBMS Repository support is available with the Corporate, Business and Software Engineering, System Engineering
and Ultimate editions of Enterprise Architect
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Share Enterprise Architect Projects

The most efficient way of using Enterprise Architect to manage a team development is to share a project amongst a team
of designers, developers and analysts.

Facilities
Facility Detail
By Sharing a project e  Many people can work on the model at the same time and contribute their
particular skill
e Team members can always see what the latest changes are, keeping the team
informed and up to date with the project status
You can share a project in e Place the project in a shared network directory
three ways e Use replication
e  Use a shared DBMS-based repository
Notes

e Project Sharing and Replication are available in the Professional, Corporate, Business and Software Engineering,
System Engineering and Ultimate editions of Enterprise Architect

e DBMS repositories are supported in the Corporate, Business and Software Engineering, System Engineering and
Ultimate editions of Enterprise Architect
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Refresh View of Shared Project

When a user of a shared model checks out a Package and makes changes, other users can see those changes by refreshing
their view of the Package or the changed diagram within the Package, in a number of ways.

Refresh the view

Object Options

Project e Right-click on the Package name in the Project Browser and select the
'Contents | Reload Current Package' option, or

e Select the 'File | Reload Project' menu option, or

~
e Select the "# (Reload Project) icon in the Project toolbar, or
e Press Ctrl+Shift+F11, or

e Close the project and reopen it
Diagram e Select the "'Window | Reload Current View' menu option, or

e Right-click on the opened diagram tab in the Diagram View, and select the
'Reload <diagram name>' option
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Share a Project

The easiest way to share a project amongst a work group of developers and analysts is to place the project file on a
shared network drive, to which people connect from their workstations.

Individual developers and analysts can then open and work on the project concurrently.

Network Issues

Enterprise Architect accepts a number of concurrent connections without issue; however, there are points you should
consider:

Issue Description

Lock Outs There can be occasional 'lock-outs' when one user tries to access or update
something another user is in the process of modifying.

Other Changes Changes to the Project Browser (and other project views) are not automatically
updated; to compensate for this, users must occasionally reload their project to see
changes made by other users.

Diagrams If two or more people work on the same diagram concurrently, unexpected results
can occur; it is best to allow only one analyst to work on a diagram at a time.

System crashes (.EAP files only) If a user's machine crashes, the network suffers an outage or a
machine is turned off unexpectedly, the project file might require repair to
compensate for the sudden inconsistency; a repair facility is provided (Project |
Data Management | Manage .EAP File | Repair .EAP File) to carry out this task.

Notes

e Firebird-based projects (.feap files) are not suitable for sharing over a network
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Distributed Development

Enterprise Architect supports distributed development using two different techniques.

Replication

Using replication, geographically separated analysts can update and modify parts of the model in replicas, then merge
these back together at a central location.

XMI Import/Export

Using XMI-based import/export, you can export discrete Packages to XML to share among the development team; this
has several benefits over replication:

e  You can assemble a model from only the parts necessary to get your job done
®  You can assemble a full model if required

e  You can assemble a model from different Package versions for different purposes (such as customer visible, internal
release only)

®  You can roll-back parts of a model as required
e There is less chance of 'collisions' between developers if each works on a discrete Package
e The process is controllable using a version control system, or through Package control

XMI based import/export is UML1.3 / XMI1.1 compliant; you can also write XML based tools to manipulate and extract
information from XML files to enhance the development process.

XMI-based Import/Export is accessed through Package | Import/Export.

(c) Sparx Systems 2015 - 2016 Page 32 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

Replication

Apart from sharing Enterprise Architect projects in real time over a network, you can also share projects using
replication.

Guide

Facility Detail

Replication Replication is a powerful means of sharing projects between isolated or mobile
users; it enables different users to work independently of one another, and to merge
their changes at a later time.

In Replication:
e A project is converted to a design master, then replicas are made of the master

e  Users take the replicas away, modify the project, then bring their replicas back
to be synchronized with the master file

Use Replication To use replication:
1. Convert the base project to a design master.
2. Create replicas from the design master.

3. Take the replica away and work on it as required, then bring it back for
synchronization with the design master.

4. Synchronize the replicas, during which all changes to both the master and the
replica are propagated in both directions, so they both finally contain the same
information.

Enterprise Architect Merge Enterprise Architect follows these rules in merging:

Rules e Additions are cumulative; that is, two replicas each creating three new Classes

result in six new Classes after merging

e Deletions prevail over modifications; if one replica changes a Class name and
other deletes the Class, merging replicas results in both files losing the Class

Conflicting modifications appear in the 'Resolve Replication Conflicts' dialog.

Upgrades and Replicas When you upgrade your version of Enterprise Architect, you must not open a
replica until you have opened the design master and then synchronized the replicas
with the master; you cannot directly upgrade a replica.

Avoid Change Collisions If two or more people make changes to the same element, Enterprise Architect
arbitrarily overwrites one person's change with the other's; to avoid this, different
users should work on different Packages.

However, since Enterprise Architect does not enforce this rule, it is possible for
users' work to conflict; to minimize difficulties, please note these guidelines:

e [fusers are likely to have worked in the same area of the model, they should
both witness the synchronization and confirm that they are happy with the net
result

e If small pieces of information have been lost, they should be typed into one of
the merged models after synchronization

e [falarge piece of information has been lost (for example, an overwritten large
Class note) use the 'Resolve Replication Conflicts' dialog
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Disable or Remove If you have converted a project to a design master but now want to disable the
Replication Features replication features, you can remove Replication; ensure that you back up all your
files first.
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Design Masters

A design master is the first converted Enterprise Architect project that supports replication. You create the master project
from which you create replicas that can be modified independently of the master project and re-merged later.

Access
Ribbon Configure > Model > Check Integrity > Manage .EAP File > Make Design Master
Menu Project > Data Management > Manage .EAP File > Make Design Master

Create a design master

Step Action

1 Take a back-up of the required Enterprise Architect project.
2 Select the project in the Project Browser.
3 Select the 'Make Design Master' menu option and follow the on-screen instructions.
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Create Replicas

A replica is one of several copies of the design master of an Enterprise Architect project. You create the copy of the
master project for you or another user to modify independently and re-merge later.

Access
Ribbon Configure > Model > Check Integrity > Manage .EAP File > Create New Replica
Menu Project > Data Management > Manage .EAP File > Create New Replica

Create a replica

Step Action

1 First create a design master, then select the 'Create New Replica' menu option and follow the on-screen
instructions.
2 Edit the replica over time and, when required, return the file for merging with the design master.
Notes

e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have Manage Replicas permission to create a replica
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Synchronize Replicas

Synchronizing replicas combines the changes made to each file. You can:

e  Merge the changes made to each replica with the design master, so that a new set of replicas with all changes can be
generated and distributed

e Combine the changes made to two replicas, should it be necessary for two team members to combine their work

Access
Ribbon Configure > Model > Check Integrity > Manage .EAP File > Synchronize Replicas
Menu Project > Data Management > Manage .EAP File > Synchronize Replicas

Synchronize replicas

Step Action

1 Open the design master project file (or the first required replica).

2 Select the 'Synchronize Replicas' menu option.

3 Locate and select the (second) required replica to merge the open project and the replica.
Notes

e Information is copied both ways, including deletes, updates and inserts; both projects end up containing identical
information

e If this process generates 'conflicting changes' errors, you should review and, if necessary, resolve these conflicts

e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have Manage Replicas permission to create a replica
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Remove Replication

Replication makes many changes to the database structure of your model, so the model file becomes considerably larger
with additional information; you might, therefore, decide not to use the replication feature any more.

Access
Ribbon Configure > Model > Check Integrity > Manage .EAP File > Remove Replication
Menu Project > Data Management > Manage .EAP File > Remove Replication

Remove replication from your model

Step Action

1 Ensure that you have open a temporary repository (not the one having replication removed) - the menu
option is not available if no repository is open.

2 Select the 'Remove Replication' menu option.

The 'Remove Replication Wizard' displays.

3 Enter the full path and file name of the project to have replication removed.
Click on the Next button.

4 Enter the full path and file name of the base Enterprise Architect model (with no replication) to act as
template.

Click on the Next button.

5 Enter the full path and required file name for the output file.
Click on the Next button.

6 Select whether to have a log file created and, if so, enter a file name for the log file.

7 Click on the Run button to begin removing replication.
Enterprise Architect creates a new project containing all the model information.

Your model has now had replication removed, and should be considerably smaller.

Notes

e  You cannot remove replication from a model with Auditing enabled - if you want to remove replication:
e Disable Auditing

e If prompted to do so, allow Enterprise Architect to roll back the database version
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e Remove replication
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Upgrade Replicas

A new release of Enterprise Architect might contain changes to the underlying project structure, such as more tables or
changed queries. If you use Replication, you must take care with your upgrade.

Considerations
Consideration Detail

Open Design Master After installing the new version of Enterprise Architect, it is very important that

Project first you open the design master before opening any of the replicas with the updated
version.

Changes to the database Changes to the database design in a replicated project can ONLY be done to the

design design master; trying to update a replica at best does nothing, and at worst causes
the update of the master to fail.

Propagate Changes Design changes are propagated through to the replicas the next time the replicas are
synchronized with the master.

Alternatively One other strategy is to remove replication from a copy of the replica set, upgrade
that project and convert it into a new design master from which new replicas are
created.

(c) Sparx Systems 2015 - 2016 Page 40 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

Resolve Conflicts

If two or more people each work on the same model object in their respective replicas between synchronizations, the
replication engine has problems in resolving which change is the master. You need to select which of two conflicting
changes you should save to the Design Master and/or replicas, where a substantial piece of information has been
overridden by a user and you want to retrieve it.

Access
Ribbon Configure > Model > Check Integrity > Manage .EAP File > Resolve Replication
Conflicts
Menu Project > Data Management > Manage .EAP File > Resolve Replication Conflicts
Considerations
Consideration Detail
Avoid the problem Ensure that each team member always works in a separate area of the model within
their replica.
Check for conflicts After synchronizing replicas, open the 'Resolve Conflicts' dialog (see next table)
and check if there were any conflicts.
Response to conflicts When a project record has been modified in different ways by different users, the

replication engine selects one of the conflicting values based on rules within the
JET replication manager.

However, the replication engine stores the discarded changes and flags the conflict
on the 'Resolve Conflicts' dialog so that you can choose to roll in the discarded
change instead.

Normally it is not necessary or desirable to examine conflicts, since they represent
relatively inconsequential pieces of information that can very easily be modified
through the normal Enterprise Architect interface; for example, by moving a
diagram element.

The only case in which the 'Resolve Conflicts' dialog should be used is where a
substantial piece of information has been overridden by a user, and you want to
retrieve it.

Resolve conflicts in changes to the same model object in two separate replicas

Step Action

1 Synchronize a replica with the Design Master, and display the 'Resolve Conflicts' dialog.
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2 In the Table with Conflicts list, click on the entry that is likely to contain the lost information.

3 Click on each entry in the Conflicting Records list.
When the lost information appears in the Conflict Details list, click on the Overwrite with Conflict
button.

4 In the 'Conflicting Records' list, you can also copy each Row ID to the clipboard by right-clicking on the

row and selecting the 'Copy to Clipboard' menu option.

You can locate the object that is in conflict in the Project Browser or diagrams, by right-clicking on it
and selecting the 'Find in Project Browser' or 'Find in Diagrams' option.
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Server Based Repositories

-J

As a repository becomes larger, or the number of concurrent users increases or organizational policy dictates, it might be
more appropriate to use a database management system (DBMS) to store the repository. A File Based Repository can be
created and used in any edition of Enterprise Architect; however, if you decide to use a DBMS based repository you will
need to use the Corporate, Business and Software Engineering, Systems Engineering or Ultimate editions. Enterprise
Architect has a function to transfer your repository from a file based repository to a server based one, helping you to get
started quickly and with no changes in the user-interface.

Note that the performance of the Repository as experienced by end users will depend very much on the quality and
power of the server machine and the network infrastructure on which the DBMS and user are located. Using a DBMS
over a very high latency (10ms or higher) network can result in significant delays and visibly inferior performance.
When network latency is an issue, Sparx Systems recommends using a Cloud Based Server as the interactions are
optimized to reduce the effect of network latency.

Also it is important to note that all models are quite different and although Sparx Systems does its best to maximize
performance based on what is expected to be held in a repository, sometimes this is not quite sufficient. In these rare
cases a review of the database indexes would be good practice to maximize data retrieval and access. This will ensure
that end users receive the best possible performance even when models contain millions of constructs.

Set up a Project on a DBMS repository

To set up your project on a DBMS repository, you work through these stages:

1. Set up your DBMS software and create a repository.

2. Create the required tables in your repository, by running a script supplied on the Sparx Systems website.
3. (For certain DBMS products) Set up an ODBC driver to enable connection to the repository.
4

Transfer the project from the source file to the DBMS repository; the source file can be:
- a .EAP or .FEAP base model, to begin a new project from scratch, or
- a previously-developed project file, to move an existing project into the DBMS repository

5. Connect to your repository.

DBMS Products you can use

You can set up your project on a repository in:

e  Firebird from v2

e  MySQL from v5

e Microsoft SQL Server from 2005, all editions including Express and Azure
e  Microsoft Access from 2007

e Oracle from 9i (all editions)

e  PostgreSQL from v8

e Sybase Adaptive Server Anywhere 8 or 9, or SQL Anywhere 10, 11 or 12

For information on creating a project on a specific DBMS from this list, see Learn more.
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Notes

e You cannot move a model from a source .eap file of an Enterprise Architect version earlier than 3.5.0 without
updating it first

e  Before proceeding, you must have MDAC 2.6 or higher installed on your system

e  (Optional, but recommended) before actually transferring the project structure from the file to the repository,
perform a Project Data Integrity Check on the file
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Create a Project in a MySQL Database

To create a project in a repository on MySQL 5, you work through these stages:

e Stage 1: Create an empty database repository and set up the data tables

e Stage 2: Set up the ODBC Driver

e  Stage 3: Perform a project integrity check on the project file you are using as a base (optional, but recommended)
e  Stage 4: Transfer the data

e Stage 5: Connect to the repository and open the project

Prerequisites

e A machine with MySQL version 5 or higher installed and running,

e  MySQL ODBC - either 5.1.5, or higher than 5.2.4 (other versions are not recommended)

Create a MySQL Repository

MySQL supports two different storage engines - InnoDB and MyISAM. In older versions of MySQL MyISAM was the
default storage engine, but from MySQL v5.5 onwards InnoDB is the default. As of Enterprise Architect v13 Sparx
Systems will no longer provide updates to the MyISAM script and recommend all users to choose InnoDB as it supports
transactions and UTFS.

Step Action

1 Create a new empty database and configure it to your installation's defaults.

2 Load the EASchema 1220 MySQL.sql file from the Sparx Systems website into your SQL
managmenet console of choice (ie MySQL Workbench).

3 Run the script to create the required database schema.

Set Up the ODBC DSN

Step Action

1 Create a suitable ODBC Data Source to point to your new database.
Select the following extended options:
e 'Return matched rows instead of affected rows'

e 'Allow big result sets'

Perform a Project Integrity Check
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Step Action

1 In Enterprise Architect, open the file-based project or template from which you are creating the project on
the repository.
2 Select and run 'Project | Data Management | Project Integrity Check'.

This ensures your project data is 'clean' and free from errors before being copied to the repository.

Transfer the Project Data

Step Action

1 Open Enterprise Architect.
(If the 'Open Project' dialog displays, click on the Cancel button to open with no project loaded.)

2 Select the 'Project | Data Management | Project Transfer' menu option.

The "Project Transfer' dialog displays.
3 In the 'Transfer Type' panel, select "EAP to DBMS'.

4 In the 'Source Project' field, type the name of the project file to copy to the repository.

If the .EAP file has Replication enabled, this must be removed before performing the transfer.

5 . ‘ : N
At the right of the 'Target Project' field, click on the LJ button.
The 'Datalink Properties' dialog displays.
6 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.
Click on the Next button.
7 In the 'Use Data source name' field, click on the drop-down arrow and select the ODBC Data Source you
configured to point to your new database.
Click on the OK button. The 'Project Transfer' dialog redisplays.
8 If required, select the 'Logfile' checkbox and type a path and filename for the data transfer log file.
9 Click on the Transfer button to begin the data transfer process.
10 When the process is complete, you have created a project on a MySQL database and can now connect to it

and open it from Enterprise Architect.
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Create a MySQL Repository

Creating a MySQL database is fully documented in the product information provided with your MySQL installer.

Having created your MySQL database, use the SQL script provided by Sparx Systems to create the required table
definitions for Enterprise Architect.

You can obtain the scripts from the Sparx Systems website, on the:
e Registered Corporate edition 'Resources' page (Registered users)

e  Corporate edition 'Resources' page (Trial users)

Third Party Tools

If you are unfamiliar with MySQL and DBMS systems in general, you might want to consider a suitable front end tool.
MySQL Administrator is one such tool, providing a convenient graphical user interface to enable the creation of
databases, the execution of scripts, and backups and restores.

You might, therefore:

1. Run MySQL Administrator and create a new database, then

2. Run MySQL Query Browser, and open and execute the MySQL repository script

After creating a MySQL data repository in Enterprise Architect, you must set up the MySQL ODBC driver.

Notes
e  This feature is available in the Corporate, Business and Software Engineering, System Engineering and Ultimate

editions

e  Ensure that the collation is set to the alphabet you use, such as Latin or Cyrillic
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Set up a MySQL ODBC Driver

After you have created a repository on your MySQL database, you set up the MySQL ODBC driver so that you can
connect to a project on that repository from Enterprise Architect.

Prerequisites

Install:
e  MySQL DBMS and repository
e  MySQL ODBC driver software version 5.1.5 or higher than 5.2.4

Set up the ODBC Driver

Your MySQL driver is now available to connect to the repository from Enterprise Architect.

Step Action

1 Under both 32-bit and 64-bit operating systems, Enterprise Architect requires 32-bit ODBC drivers to
connect to a repository through ODBC. You can quickly load the correct 32-bit ODBC Data Source
Administrator by selecting "Tools | ODBC Data Sources'.

The ODBC Data Source Administrator window displays.

2 Click on the Add button.
The 'Create New Data Source' dialog displays, enabling you to add a new DSN.

3 Select the appropriate MySQL ODBC Driver from the list.

4 Click on the Finish button.
The 'MySQL Connector/ODBC' dialog displays.

5 Enter these configuration details:
e A data source name for the connection
e A description (optional)
e The host address of the DBMS server
e  User name and password

e The database name on the selected server
6 To set the advanced options, click on the Details>> button.

7 Select these checkboxes (where provided):
e Return matched rows instead of affected rows ('Connection' or 'Cursors/Results' tab)

e Allow big result sets ('Connection' tab)
8 Click on the Test Connection button to confirm that the details are correct.

9 If the test succeeds, click on the OK button to complete the configuration.

If the test does not succeed, review your settings.
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Connect to a MySQL Data Repository

15 July, 2016

To access a project in your MySQL data repository, you must connect to the data repository from Enterprise Architect.

Prerequisites

e The MySQL repository and the project already exist
e  You have SELECT, INSERT, UPDATE, DELETE, EXECUTE and SHOW VIEW access permissions
e The MySQL ODBC driver has been set up

Access

Ribbon : Open Project

Menu File | Open Project

Keyboard Shortcuts Ctrl+ 0O

Connect to the repository

Step Action

1 In the 'Open Project' dialog, select the 'Connect to Server' checkbox.

Click on the B button.
The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.

4 Click on the Next>> button.
The 'Connection' tab displays.

5 Click on the 'Use data source name' radio button and on the drop-down arrow in its field.

From the list, select the ODBC driver you have set up to connect to your MySQL repository.

6 If required, type in a User name and Password.

7 If required, type in an initial catalog.

8 Click on the Test Connection button to confirm that the details are correct.
9 If the test does not succeed, revise your settings.
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If the test succeeds, click on the OK button; the 'Connection Name & Type' dialog displays.

10 Give the connection a suitable name so that you can recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

11 If required, select the 'Encrypt Connection String' checkbox.
This encrypts and hides the connection details of the database from the users that the connection string is
given to.

12 If required, select the 'Lazy Load' checkbox to not load the full project view when the model is loaded;

instead, only the parts that are necessary to display the visible portion of the tree are loaded.

With this setting, the model loads faster and users can begin work sooner, but at the expense of later small
delays as Enterprise Architect loads specific portions of the model.

13 If required, select the 'Use WAN Optimization' checkbox.

To improve performance over a Wide Area Network, remote database calls can be routed through a WAN
Optimizer that compresses the data returned from the repository, reducing transfer time.

If you select this checkbox, complete the next three fields (see your administrator for the correct values);
otherwise go to step 17.

14 In the 'Server' field, type the network name or address of the optimizer server.

15 In the 'Port' field, type the port on which the server is running on the remote machine.

16 In the 'DSN' field, type the data source name of the database as it appears on the remote machine.
17 Click on the OK button to complete the configuration and open the project.

This also adds the project name to the 'Recent’ list on the 'Start Page'; from now on, you can open the
project again just by clicking on this name.

Notes

e This feature is available in the Corporate, Business and Software Engineering, System Engineering and Ultimate
editions of Enterprise Architect
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Create a Project in an Oracle Database

To create a project in a repository on Oracle 9i, 10g, 11g or 12c, you work through these stages:
e Stage 1: Create an empty database repository and set up the data tables

e Stage 2: Set up the ODBC Driver (if required; you can connect to an Oracle repository using either OLE DB or an
ODBC driver; if you intend to connect through the ODBC driver, you must first set it up)

e Stage 3: Perform a project integrity check on the project file you are using as a base (optional, but recommended)
e  Stage 4: Transfer the data
e Stage 5: Connect to the repository to open the project

Prerequisites

e A machine with Oracle 9i, 10g or 11 g installed and running

e Oracle Client installed on the client machine, please ensure that both the ODBC and OLE/DB drivers are installed

Create Database Repository

Step Action

1 Create the empty database.

2 Load the EASchema 1220 Oracle.sql file from the Sparx Systems website into your SQL

managmenet console of choice (ie Oracle SQL Developer)

3 Run the script to create the required database schema.

Set Up the ODBC DSN

Step Action

1 Create a suitable ODBC Data Source to point to your new database.

Perform Project Integrity Check

Step Action

1 Open the file-based project or template.

2 Select and run "Project | Data Management | Project Integrity Check'.

This ensures your project data is 'clean' before uploading.

(c) Sparx Systems 2015 - 2016 Page 52 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

Transfer the project data to the repository

Step Action

1 Open Enterprise Architect.
(If the 'Open Project’ dialog displays, click on the Cancel button to open with no project loaded.)

2 Select the 'Project | Data Management | Project Transfer' menu option.

The "Project Transfer' dialog displays.
3 In the 'Transfer Type' panel, select "EAP to DBMS'.

4 In the 'Source Project' field, type the name of the project file to copy to Oracle.
If the .EAP file has Replication enabled, this must be removed before performing the transfer.

5
At the right of the 'Target Project’ field, click on the D button.
The 'Datalink Properties' dialog displays.
6 Select 'Oracle Provider for OLE DB' from the list.
Click on the Next button.
7 On the 'Connection' page of the 'Datalink Properties' dialog, enter the Oracle service name in the 'Data
Source' field, and the user name and password as required.
Click on the OK button. The 'Project Transfer' dialog redisplays.
8 If required, select the 'Logfile' checkbox and type a path and filename for the data transfer log file.
9 Click on the Transfer button to begin the data transfer process.
10 When the process is complete, you have created a project on a Oracle database and can now connect to it
and open it from Enterprise Architect.
Notes

e  When transferring a project to Oracle you must have access rights to execute the CREATE SEQUENCE command
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Create an Oracle Data Repository

Creating an Oracle database is fully documented in the product information provided with your Oracle installer.

Before creating an Oracle data repository, install the appropriate version of Oracle (91, 10g, 11g or 12¢) and MDAC 2.6
or higher, and obtain access permission to create a new database.

Having created your Oracle database, use the SQL script (Oracle EASchema.sql) provided by Sparx Systems to create
the required table definitions and indexes for Enterprise Architect. You can obtain the script from the Sparx Systems
website, on the:

e Registered Corporate edition 'Resources' page (Registered users), or
e Corporate edition 'Resources' page (Trial users)

When you eventually connect to the Oracle database from Enterprise Architect, you can do so using either OLE DB or
ODBC; if you intent to use ODBC, after creating the Oracle data repository you set up the Oracle ODBC driver.

Third Party Tools

If you are unfamiliar with Oracle and DBMS systems in general, you might want to consider a suitable front end tool.
You could connect to the database and execute the scripts with a program such as Oracle SQL*Plus or SQL Plus
Worksheet.

Notes

e  This feature is available in the Corporate, Business and Software Engineering, System Engineering and Ultimate
editions

e  With Windows 7 the OLE/ODBC connection is set using the 32 bit ODBC driver, installed using
C:\Windows\SysWOW64\odbcad32.exe; the connection can be set using either ODBC or OLE

e Ifyou intend to connect via the OLE connection, download the 32-bit ODBC driver from here

e  Set the collation to the alphabet you use, such as Latin or Cyrillic

(c) Sparx Systems 2015 - 2016 Page 54 of 353 Created with Enterprise Architect


http://www.oracle.com/technetwork/topics/dotnet/utilsoft-086879.html

User Guide - Model Repository 15 July, 2016

Set up an Oracle ODBC Driver

After you have created a repository on your Oracle database, you set up the Oracle ODBC driver so that you can connect
to a project on that repository from Enterprise Architect (in preference to using an OLE DB connection).

Prerequisites

Install:
e  Oracle DBMS and repository

Set up the Oracle ODBC driver

Your Oracle driver is now available to connect to the repository from Enterprise Architect.

Step Action

1 Under both 32-bit and 64-bit operating systems, Enterprise Architect requires 32-bit ODBC drivers to
connect to a repository through ODBC. You can quickly load the correct 32-bit ODBC Data Source
Administrator by selecting 'Tools | ODBC Data Sources'.

The ODBC Data Source Administrator window displays.

2 Click on the Add button.
The 'Create New Data Source' dialog displays, enabling you to add a new DSN.

3 Select 'Oracle in OraDB11g_homel' from the list (or similar, depending on the ODBC installation).

4 Click on the Finish button.
The 'Oracle ODBC Driver Configuration' dialog displays.

5 Enter these configuration details:
e A data source name for the connection
e A description (optional)

e The TNS Service Name (click on the drop down arrow and select from the list)

e UserID

6 Click on the Test Connection button and enter the Oracle user password to confirm that the details are
correct.

7 If the test succeeds, click on the OK button to complete the configuration.

If the test does not succeed, review your settings.
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Connect to an Oracle Data Repository (ODBC)

To access a project in your Oracle 91, 10g, 11g or 12¢ data repository, you connect to the data repository from Enterprise
Architect.

Prerequisites

e  The Oracle repository and the project already exist
e  You have SELECT, UPDATE, INSERT and DELETE access permissions
e The Oracle ODBC driver has been set up

Alternatively, you can connect to your Oracle project using OLE DB - see Connect to an Oracle Data Repository (OLE
DB).

Access

Ribbon : Open Project

Menu File | Open Project

Keyboard Shortcuts Ctrl+ O

Connect to an Oracle Data Repository using an ODBC Driver

Step Action

1 In the 'Open Project' dialog, select the 'Connect to Server' checkbox.

Click on the D button.
The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.

4 Click on the Next>> button.
The 'Connection' tab displays.

5 In the 'Data source' field, click on the drop-down arrow and select the data source name.
6 Type in the User name and Password.

7 Click on the Test Connection button to confirm that the details are correct.

8 If the test does not succeed, revise your settings.
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If the test succeeds, click on the OK button; Oracle prompts you for the password.

9 Type in the password.
The 'Connection Name and Type' dialog displays.

10 Give the connection a suitable name so that you can recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

11 If you want to encrypt and hide the connection details of the database from the users that the connection
string is given to, select the 'Encrypt Connection String' checkbox.

12 The Lazy Load facility does not load the full project view when the model is loaded; instead, it loads only
the parts that are necessary to display the visible portion of the tree. With this set, the model loads faster
and users can begin work sooner, but at the expense of later small delays as Enterprise Architect loads
specific portions of the model.

If you want to use the Lazy load facility, select the 'Lazy Load' checkbox.

13 To improve performance over a Wide Area Network, remote database calls can be routed through a WAN
Optimizer that compresses the data returned from the repository, reducing transfer time. If you are using a
WAN, and want to apply this facility, select the 'Use WAN Optimization' checkbox; otherwise go to step
16.

If you select this checkbox, complete the next two fields (see your administrator for the correct values).

14 In the 'Server' field, type the network name or address of the optimizer server.
15 In the 'Port' field, type the port on which the server is running on the remote machine.
16 Click on the OK button to complete the configuration and open the project.

This also adds the project name to the 'Recent’ list on the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

e  This feature is available in the Corporate, Business and Software Engineering, System Engineering and Ultimate
editions
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Connect to an Oracle Data Repository (OLE DB)

To access a project in your Oracle 91, 10g, 11g or 12¢ data repository, you connect to the data repository from Enterprise
Architect.

Prerequisites

e The Oracle repository and the project already exist
e  You have SELECT, UPDATE, INSERT and DELETE access permissions

Alternatively, you can connect to the repository using an Oracle ODBC driver - see Connect to an Oracle Data
Repository (ODBC).

Access

Ribbon : Open Project

Menu File | Open Project

Keyboard Shortcuts Ctrl+ O

Connect to an Oracle Repository using OLE DB

Step Action

1 In the 'Open Project' dialog, select the 'Connect to Server' checkbox.

Click on the B button.
The 'Data Link Properties' dialog displays.

3 Select 'Oracle Provider for OLE DB' from the list.
Do not select 'Microsoft OLE DB Provider for Oracle'; Enterprise Architect might not work as expected.

4 Click on the Next>> button.
The 'Connection' tab displays.

5 In the 'Data source' field, click on the drop-down arrow and select the data source name (the service name
of the Oracle database).

6 Type in the User name and Password.

7 Click on the Test Connection button to confirm that the details are correct.

(c) Sparx Systems 2015 - 2016 Page 58 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

8 If the test does not succeed, revise your settings.

If the test succeeds, click on the OK button; the 'Connection Name and Type' dialog displays.

9 Give the connection a suitable name so that you can recognize it in the 'Recent Projects' panel on the
'Open Project’ dialog.

10 If you want to encrypt and hide the connection details of the database from the users that the connection
string is given to, select the 'Encrypt Connection String' checkbox.

11 If required, select the 'Lazy Load' checkbox to not load the full project view when the model is loaded;
instead, only the parts that are necessary to display the visible portion of the tree are loaded.

With this setting, the model loads faster and users can begin work sooner, but at the expense of later small
delays as Enterprise Architect loads specific portions of the model.

12 To improve performance over a Wide Area Network, remote database calls can be routed through a WAN
Optimizer that compresses the data returned from the repository, reducing transfer time. If you are using a
WAN, and want to apply this facility, select the 'Use WAN Optimization' checkbox; otherwise go to step
15.

If you select this checkbox, complete the next two fields (see your administrator for the correct values).

13 In the 'Server' field, type the network name or address of the optimizer server.
14 In the 'Port' field, type the port on which the server is running on the remote machine.
15 Click on the OK button to complete the configuration and open the project.

This also adds the project name to the 'Recent' list on the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

e  This feature is available in the Corporate, Business and Software Engineering, System Engineering and Ultimate
editions
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Create a Project in a PostgreSQL Database

To create a project in a repository on PostgreSQL 7, 8 or 9, you work through these stages:

e Stage 1: Create an empty database repository and set up the data tables

e Stage 2: Set up the PostgreSQL ODBC Driver

e  Stage 3: Perform a project integrity check on the project file you are using as a base (optional, but recommended)
e  Stage 4: Transfer the data

e Stage 5: Connect to the repository to open the project

Prerequisites

e A machine with PostgreSQL 7.3.2 or higher installed and running
e psqlODBC, version 7.03.01.00 or higher has been installed (do not use version 8.3.4 or 8.4.1)

Create Database Repository

Step Action

1 Create the empty database.

2 Load the EASchema PostgreSQL 1220.sql file from the Sparx Systems website into your SQL

managmenet console of choice (ie pgAdminIII).

3 Run the script to create the required database schema.

Set Up the ODBC DSN

Step Action

1 Create a suitable ODBC Data Source to point to your new database.

Select the following extended options:
Page 1:

Disable Genetic Optimizer - Uncheck
Use Declare/Fetch - Check
Unknowns as LongVarChar - Check
Bools as Char - Uncheck

Max Varchar - 1024

Max LongVarChar - 1000000

Page 2:
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bytea as LO - Check
Disallow Premature - Check
Protocol - 7.4+

Perform a Project Integrity Check

Step Action

1 In Enterprise Architect, open the file-based project or template from which you are creating the project on
the repository.
2 Select and run 'Project | Data Management | Project Integrity Check'.

This ensures your project data is 'clean’' before being copied to the repository.

Transfer the project data to the repository

Step Action

1 Open Enterprise Architect.
(If the 'Open Project’ dialog displays, click on the Cancel button to open with no project loaded.)

2 Select the 'Project | Data Management | Project Transfer' menu option.

The "Project Transfer' dialog displays.
3 In the 'Transfer Type' panel, select ."EAP to DBMS'.

4 In the 'Source Project' field, type the name of the project file to copy to the repository.

If the .EAP file has Replication enabled, this must be removed before performing the transfer.

5 . . .
At the right of the 'Target Project’ field, click on the D button.
The 'Datalink Properties' dialog displays.
6 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.
Click on the Next button.
7 On the 'Use Data Source Name' field, click on the drop-down arrow and select the ODBC Data Source
you configured to point to your new database.
Click on the OK button. The 'Project Transfer' dialog redisplays.
8 If required, select the 'Logfile' checkbox and type a path and filename for the data transfer log file.
9 Click on the Transfer button to begin the data transfer process.

When the process is complete, you have created a project on a PostgreSQL database and can now connect
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10 to it and open it from Enterprise Architect.

Notes

e During the transfer, if an error message displays reporting '...nonstandard use of \\ in a string literal...", set the server
variable in the postgresql.conf file to: escape string warning = off
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Create a PostgreSQL Repository

Creating a PostgreSQL database is fully documented in the product information provided with your PostgreSQL
installer.

Having created your PostgreSQL database, use the SQL script provided by Sparx Systems to create the required table
definitions for Enterprise Architect. You can obtain the scripts from the Sparx Systems website, on the:

e Registered Corporate edition 'Resources' page (Registered users)

e  Corporate edition 'Resources' page (Trial users)

Third Party Tools

If you are unfamiliar with PostgreSQL and DBMS systems in general, you might want to consider a suitable front end
tool. One such tool is pgAdminlIl. It provides a convenient graphical user interface to enable creation of databases,
execution of scripts and restores.

After creating a PostgreSQL data repository in Enterprise Architect, you must set up the PostgreSQL ODBC driver.

Notes
e  This feature is available in the Corporate, Business and Software Engineering, System Engineering and Ultimate

editions

e  Ensure that the collation is set to the alphabet you use, such as Latin or Cyrillic
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Set up a PostgreSQL ODBC Driver

After you have created a repository on your PostgreSQL database, you set up the PostgreSQL ODBC driver so that you
can connect to a project on that repository from Enterprise Architect.

Prerequisites

Install:
e  PostgreSQL DBMS and repository

e  PostgreSQL ODBC driver software version 7.03.01.00 or above (note that versions 8.3.4 and 8.4.1 of the
PostgreSQL ODBC Driver are not supported)

Set up the ODBC driver

Your PostgreSQL driver is now available to connect to the repository from Enterprise Architect.

Step Action

1 Under both 32-bit and 64-bit operating systems, Enterprise Architect requires 32-bit ODBC drivers to
connect to a repository through ODBC. You can quickly load the correct 32-bit ODBC Data Source
Administrator by selecting '"Tools | ODBC Data Sources'.

The ODBC Data Source Administrator window displays.

2 Click on the Add button.
The 'Create New Data Source' dialog displays, enabling you to add a new DSN.

3 Select 'PostgreSQL UNICODE' from the list.

4 Click on the Finish button.
The "Postgre SQL Connector/ODBC' dialog displays.

5 Enter these configuration details:
e A data source name for the connection
e The actual name of the database
e  The host address of the DBMS server
e User name
e A description (optional)

e  The password

6 To set the advanced options, click on the Datasource button and set the options on 'Page 1' and 'Page 2'
as shown:
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on Page 2 select:

e In the 'Protocol' panel, the '7.4+' radio button

8 Click on the OK button to complete the configuration.
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Connect to a PostgreSQL Data Repository

To access a project in your MySQL data repository, you must connect to the data repository from Enterprise Architect.

Prerequisites

e The PostgreSQL repository and the project already exist
e  You have SELECT, UPDATE, INSERT and DELETE access permissions
e  The PostgreSQL ODBC driver has been set up

Access

Ribbon : Open Project

Menu File | Open Project

Keyboard Shortcuts Ctrl+ 0O

Connect to the repository

Step Action

1 In the 'Open Project' dialog, select the 'Connect to Server' checkbox.

Click on the B button.
The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.

4 Click on the Next>> button.
The 'Connection' tab displays.

5 Click on the 'Use data source name' radio button and on the drop-down arrow in its field.

From the list, select the ODBC driver you have set up to connect to your PostgreSQL repository.
6 Click on the Test Connection button to confirm that the details are correct.

7 If the test does not succeed, revise your settings.

If the test succeeds, click on the OK button; the 'Connection Name & Type' dialog displays.

8 Give the connection a suitable name so that you can recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.
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9 If required, select the 'Encrypt Connection String' checkbox.
This encrypts and hides the connection details of the database from the users that the connection string is
given to.

10 If required, select the 'Lazy Load' checkbox to not load the full project view when the model is loaded;

instead, only the parts that are necessary to display the visible portion of the tree are loaded.

With this setting, the model loads faster and users can begin work sooner, but at the expense of later small
delays as Enterprise Architect loads specific portions of the model.

11 If required, select the 'Use WAN Optimization' checkbox.

To improve performance over a Wide Area Network, remote database calls can be routed through a WAN
Optimizer that compresses the data returned from the repository, reducing transfer time.

If you select this checkbox, complete the next three fields (see your administrator for the correct values);
otherwise go to step 15.

12 In the 'Server' field, type the network name or address of the optimizer server.

13 In the 'Port' field, type the port on which the server is running on the remote machine.

14 In the 'DSN' field, type the data source name of the database as it appears on the remote machine.
15 Click on the OK button to complete the configuration and open the project.

This also adds the project name to the 'Recent' list on the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

e  This feature is available in the Corporate, Business and Software Engineering, System Engineering and Ultimate
editions
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Create a Project in an Access 2007 Database

In setting up a project in an Access 2007 repository, you could be working in one of two situations:

e  You are able to work in Access 2007 itself, in which case you can convert your .eap project directly to an Access
2007 .accdb database file, which you can connect to and open in Enterprise Architect

e You have access to an empty Access 2007 .accdb file, and need to transfer a .eap project into that .accdb file

In either case, before you convert or transfer the project data, you could perform a project integrity check on the .eap file
you are using as a base (optional, but recommended).

Prerequisites

e  The 'Microsoft Office 12.0 Access Database Engine OLE DB Provider' ODBC driver installed

Perform a Project Integrity Check

Step Action

1 Open the base project or template .eap file.

2 Select and run 'Project | Data Management | Project Integrity Check'.

This ensures your project data is 'clean’ before uploading.

Convert a .eap file in Access 2007

Step Action

1 Open MS Access 2007 and open the source .eap file within this product.
Allow Access to convert the .eap file to a .accdb file. This forms the Access 2007 repository.

Transfer the project data into an empty .accdb file

Step Action

1 Open Enterprise Architect.
(If the 'Open Project’ dialog displays, click on the Cancel button to open with no project loaded.)

2 Select the 'Project | Data Management | Project Transfer' menu option.

The 'Project Transfer' dialog displays.

3 In the 'Transfer Type' panel, select 'File to DBMS'.
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4 In the 'Source Project' field, type the name of the .EAP file to copy to the repository.

If the .EAP file has Replication enabled, this must be removed before performing the transfer.

5 : . , N
At the right of the 'Target Project’ field, click on the LJ button.
The 'Datalink Properties' dialog displays.
6 Select 'Microsoft Office 12.0 Access Database Engine OLE DB Provider' from the list.
Click on the Next button.
7 On the 'Data Source Details' page of the 'Datalink Properties' dialog, type in the full path to the Access
2007 .accdb file.
Click on the OK button to return to the 'Project Transfer' dialog.
8 If required, select the 'Logfile' checkbox and type a path and filename for the data transfer log file.
9 Click on the Transfer button to begin the data transfer process.
When the process is complete, you have created your project in an Access 2007 database and can now
open it directly from Enterprise Architect, browsing for the .accdb file location in the 'Open Project'
dialog.
Notes

e This feature is available in the Corporate, Business and Software Engineering, System Engineering and Ultimate
editions

e Ifyou do not have Access 2007, you can download the Access Database Engine from the Microsoft downloads site

e  Ensure that the collation is set to the alphabet you use, such as Latin or Cyrillic
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Create a Project in a SQL Server Database

To create a project on a repository in SQL Server 2005 and above, or SQL Server Express 2005 and above, work through
these stages:

e Stage 1: Create an empty database repository and set up the data tables

e Stage 2: Perform a project integrity check on the project file you are using as a base (optional, but recommended)
e  Stage 3: Transfer the data

e  Stage 4: Connect to the repository to open the project

Prerequisites

e A machine with SQL Server installed and running
e  MDAC 2.6 or higher on the client machine

e Permissions to create databases on SQL Server

Create a SQL Server Repository

Step Action

1 Create a new empty database.

2 Load the EASchema 1220 SQLServer.sql file from the Sparx Systems website into your SQL

managmenet console of choice (ie Microsoft SQL Server Management Studio).

3 Run the script to create the required database schema.

Perform a Project Integrity Check

Step Action

1 In Enterprise Architect, open the file-based project or template from which you are creating the project on
the repository.
2 Select and run "Project | Data Management | Project Integrity Check'

This ensures your project data is 'clean' before being copied to the repository.

Transfer the project data to the repository

Step Action
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1 Open Enterprise Architect.
(If the 'Open Project’ dialog displays, click on the Cancel button to open with no project loaded.)

2 Select the 'Project | Data Management | Project Transfer' menu option.

The 'Project Transfer' dialog displays.
3 In the 'Transfer Type' panel, select .EAP to DBMS'.

4 In the 'Source Project' field, type the name of the project file to copy to the repository.
If the .EAP file has Replication enabled, this must be removed before performing the transfer.

5 —
At the right of the 'Target Project' field, click on the LJ button.
The 'Datalink Properties' dialog displays.

6 Select 'Microsoft OLE DB Provider for SQL Server' from the list.
Click on the Next button.

7 On the 'Data Source Details' page of the 'Datalink Properties' dialog, type in the server name, database
name and any security details required.
Click on the OK button. The 'Project Transfer' dialog redisplays.

8 If required, select the 'Logfile' checkbox and type a path and filename for the data transfer log file.

9 Click on the Transfer button to begin the data transfer process.

10 When the process is complete, you have created a project on a SQL Server database and can now connect

to it and open it from Enterprise Architect.
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Create a SQL Server Repository

Creating a SQL Server database is fully documented in the product information provided with your SQL Server installer.

Having created your SQL Server database, use the SQL script (SQLServer EASchema.sql) provided by Sparx Systems
to create the required table definitions for Enterprise Architect. You can obtain the script from the Sparx Systems
website, on the:

e Registered Corporate edition 'Resources' page (Registered users)
e  Corporate edition 'Resources' page (Trial users)

If you are unfamiliar with SQL Server and DBMS systems in general, you might want to consider a suitable front end
tool, such as SQL Enterprise Manager.

SQL Enterprise Manager example

Step Action

1 In SQL Enterprise Manager, locate the server on which to create your new project; for example:
DBSERVERO02\SQLEXPRESS.

2 Right-click and choose the 'New Database' option.

3 Enter a suitable name for the database. Set any file options as required.

Ensure that the database collation is set to the alphabet you use, such as Latin or Cyrillic, and
case-insensitive.

4 Click on the database to select it, then select the New Query' menu option.
5 In the Query window, use the 'Open File' dialog to locate the SQLServer EASchema.sql script file.
6 Click on the Open button. In the drop-down menu, check that you have selected the correct database to

run the script in.

7 Click on the Execute button; SQL Server executes the script, which creates the base tables for an
Enterprise Architect project.

Notes

e  This feature is available in the Corporate, Business and Software Engineering, System Engineering and Ultimate
editions

e  When creating a project in a SQL Server database you must have 'db_ddladmin' permission in order to execute the
SET IDENTITY INSERT (table) {ON | OFF} command
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SQL Server Security Permissions

The security model implemented by Microsoft's SQL Server is quite powerful and highly configurable, supporting many
different possible solutions for securing the data contained in SQL Server databases, ensuring it is only accessible to
users with the required permissions. For a more detailed description and explanation of SQL Server permissions, see the
SQL Server documentation.

Enterprise Architect users who plan to add, edit and delete contents in a SQL Server repository must have permissions to
perform SELECT, UPDATE, INSERT and DELETE statements on all Tables in the Enterprise Architect database. The
easiest way to achieve this is to grant the database roles of 'db_datareader' and 'db_datawriter' to each user.

Additional Permissions for Project Transfers

When an Enterprise Architect repository is transferred into a SQL Server based repository it is necessary for Enterprise
Architect to perform a number of SET IDENTITY INSERT (table) {ON | OFF} commands during the process. This
means the user performing the transfer must have a high level of security, the role of 'db_ddladmin'.

Does Enterprise Architect support Windows Authentication?

Enterprise Architect does support Windows Authentication. However, the type of authentication is determined by the
configuration of the connection used and not by Enterprise Architect.

Windows Authentication to SQL Server is commonly used by Enterprise Architect users, but this requires that all
Windows users in Enterprise Architect be defined on the SQL Server server and be granted the security roles
'db_datareader' and 'db_datawriter' for the repository.
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Connect to a SQL Server Data Repository

To access a project in your SQL Server data repository, you must connect to the data repository from Enterprise
Architect.

Prerequisites

e The SQL Server repository and the project already exist
e  You have SELECT, UPDATE, INSERT and DELETE access permissions

Access

Ribbon : Open Project

Menu File | Open Project

Keyboard Shortcuts Ctrl+ 0O

Connect to the repository

Step Action

1 In the 'Open Project' dialog, select the 'Connect to Server' checkbox.

Click on the D button.
The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for SQL Server' from the list.

4 Click on the Next>> button.
The 'Connection' tab displays.

5 Type in the server details, including Server Name, User Name and Password.

6 Click on the 'Select the database on the server' option and on the drop-down arrow.

From the list, select the project to connect to.

7 Click on the Test Connection button to confirm that the details are correct.

8 If the test does not succeed, revise your settings.

If the test succeeds, click on the OK button; the 'Connection Name & Type' dialog displays.
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9 Give the connection a suitable name so that you can recognize it in the 'Recent Projects' panel on the
'Open Project' dialog.

10 If required, select the 'Encrypt Connection String' checkbox.
This encrypts and hides the connection details of the database from the users that the connection string is
given to.

11 If required, select the 'Lazy Load' checkbox to not load the full project view when the model is loaded;

instead, only the parts that are necessary to display the visible portion of the tree are loaded.

With this setting, the model loads faster and users can begin work sooner, but at the expense of later small
delays as Enterprise Architect loads specific portions of the model.

12 If required, select the 'Use WAN Optimization' checkbox.

To improve performance over a Wide Area Network, remote database calls can be routed through a WAN
Optimizer that compresses the data returned from the repository, reducing transfer time.

If you select this checkbox, complete the next two fields (see your administrator for the correct values);
otherwise go to step 15.

13 In the 'Server' field, type the network name or address of the optimizer server.
14 In the 'Port' field, type the port on which the server is running on the remote machine.
15 Click on the OK button to complete the configuration and open the project.

This also adds the project name to the 'Recent' list on the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

e  This feature is available in the Corporate, Business and Software Engineering, System Engineering and Ultimate
editions
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Create a Project in a Sybase ASA Database

To create a project in a repository on Sybase Adaptive Server Anywhere 8 or 9, or SQL Anywhere 10, 11 or 12, you
work through these stages:

e Stage 1: Create an empty database repository

e  Stage 2: Set up the ASA ODBC Driver

e Stage 3: Perform a project integrity check on the project file you are using as a base (optional, but recommended)
e  Stage 4: Transfer the data

e Stage 5: Connect to the repository and open the project

Prerequisites

e A machine with Adaptive Server Anywhere installed and running

e Install SQL Anywhere Studio 8 or higher, this also installs the ASA ODBC driver or just the ASA ODBC driver

Create Database Repository

Step Action

1 Create a new empty database.

2 Load the EASchema 1220 SybaseASA.sql file from the Sparx Systems website into your SQL

managmenet console of choice (ie Sybase Central).

3 Run the script to create the required database schema.

Set up the ODBC DSN

Step Action

1 Create a suitable ODBC Data Source to point to your new database.

Perform Project Integrity Check

Step Action

1 In Enterprise Architect, open the file-based project or template from which you are creating the project on
the repository.
2 Select and run "Project | Data Management | Project Integrity Check'.
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This ensures your project data is 'clean' before being copied to the repository.

Transfer the Project Data

Step Action

1 Open Enterprise Architect.
(If the 'Open Project’ dialog displays, click on the Cancel button to open with no project loaded.)

2 Select the 'Project | Data Management | Project Transfer' menu option.

The 'Project Transfer' dialog displays.
3 In the 'Transfer Type' panel, select .EAP to DBMS'.

4 In the 'Source Project' field, type the name of the project file to copy to the repository.

If the .EAP file has Replication enabled, this must be removed before performing the transfer.

s —
At the right of the 'Target Project' field, click on the l_J button.
The 'Datalink Properties' dialog displays.

6 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.
Click on the Next button.

7 In the 'Use Data source name' field, click on the drop-down arrow and select the ODBC Data Source you
configured to point to your new database.
Click on the OK button. The 'Project Transfer' dialog redisplays.

8 If required, select the 'Logfile' checkbox and type a path and filename for the data transfer log file.

9 Click on the Transfer button to begin the data transfer process.

10 When the process is complete, you have created a project on an ASA database and can now connect to it

and open it from Enterprise Architect.
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Create an Adaptive Server Anywhere Repository

Creating an ASA database is fully documented in the product information provided with your ASA installer.

Having created your ASA database, use the SQL script (ASA_EASchema.sql) provided by Sparx Systems to create the
required table definitions for Enterprise Architect. You can obtain the scripts from the Sparx Systems website, on the:

e Registered Corporate edition 'Resources' page (Registered users)

e  Corporate edition 'Resources' page (Trial users)

Third Party Tools

If you are unfamiliar with ASA and DBMS systems in general, you might want to consider a suitable front end tool.
Sybase Central is one such tool, that can be installed along with the DBMS. It provides a convenient graphical user
interface to enable creation of databases, execution of scripts and restores.

After creating an ASA data repository in Enterprise Architect, you must set up the ASA ODBC driver.

Notes
e  This feature is available in the Corporate, Business and Software Engineering, System Engineering and Ultimate

editions

e  Ensure that the collation is set to the alphabet you use, such as Latin or Cyrillic
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Set up an ASA ODBC Driver

After you have created a repository on your ASA database, you set up the ASA ODBC driver so that you can connect to
a project on that repository from Enterprise Architect.

Prerequisites

Install:
e Adaptive Server Anywhere - SQL Anywhere Studio 8 or higher, and create a repository
e ASA ODBC driver software (installed with the ASA DBMS)

Set up the ODBC Driver

Your ASA driver is now available to connect to the repository from Enterprise Architect.

Step Action

1 Under both 32-bit and 64-bit operating systems, Enterprise Architect requires 32-bit ODBC drivers to
connect to a repository through ODBC. You can quickly load the correct 32-bit ODBC Data Source
Administrator by selecting "Tools | ODBC Data Sources'.

The ODBC Data Source Administrator window displays.

2 Click on the Add button.
The 'Create New Data Source' dialog displays, enabling you to add a new DSN.

3 Select 'Adaptive Server Anywhere' or 'SQL Anywhere' from the list.

4 Click on the Finish button.
The 'ASA Connector/ODBC' dialog displays.

5 Enter these configuration details:
e A data source name for the connection, on the 'ODBC' tab
e  User name and password on the 'Login' tab (dba, sql are the defaults when ASA is installed)
e The server name and the path to the database, on the 'Database' tab

e  The network protocol on the 'Network' tab (if the database is on a network location)
6 Return to the 'ODBC' tab and click on the Test Connection button to confirm that the details are correct.

7 If the test succeeds, click on the OK button to complete the configuration.

If the test does not succeed, review your settings.

(c) Sparx Systems 2015 - 2016 Page 80 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

Connect to an ASA Data Repository

To access a project in your Adaptive Server Anywhere (ASA) data repository, you must connect to the data repository
from Enterprise Architect.

Prerequisites

e  The ASA repository and the project already exist
e  You have SELECT, UPDATE, INSERT and DELETE access permissions
e The ASA ODBC driver has been set up

Access

Ribbon : Open Project

Menu File | Open Project

Keyboard Shortcuts Ctrl+ O

Connect to the repository

Step Action

1 In the 'Open Project' dialog, select the Connect to Server button.

Click on the B button.
The 'Data Link Properties' dialog displays.

3 Select 'Microsoft OLE DB Provider for ODBC Drivers' from the list.

4 Click on the Next>> button.
The 'Connection' tab displays.

5 Click on the 'Use data source name' radio button and on the drop-down arrow in its field.

From the list, select the ODBC driver you have set up to connect to your ASA repository.
6 Click on the Test Connection button to confirm that the details are correct.

7 If the test does not succeed, revise your settings.

If the test succeeds, click on the OK button; the 'Connection Name & Type' dialog displays.

8 Give the connection a suitable name so that you can recognize it in the 'Recent Projects' panel on the
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'Open Project’ dialog.

9 If required, select the 'Encrypt Connection String' checkbox.
This encrypts and hides the connection details of the database from the users that the connection string is
given to.

10 If required, select the 'Lazy Load' checkbox to not load the full project view when the model is loaded;

instead, only the parts that are necessary to display the visible portion of the tree are loaded.

With this setting, the model loads faster and users can begin work sooner, but at the expense of later small
delays as Enterprise Architect loads specific portions of the model.

11 If required, select the 'Use WAN Optimization' checkbox.

To improve performance over a Wide Area Network, remote database calls can be routed through a WAN
Optimizer that compresses the data returned from the repository, reducing transfer time.

If you select this checkbox, complete the next three fields (see your administrator for the correct values);
otherwise go to step 15.

12 In the 'Server' field, type the network name or address of the optimizer server.

13 In the 'Port' field, type the port on which the server is running on the remote machine.

14 In the 'DSN' field, type the data source name of the database as it appears on the remote machine.
15 Click on the OK button to complete the configuration and open the project.

This also adds the project name to the 'Recent' list on the Start Page; from now on, you can open the
project again just by clicking on this name.

Notes

e This feature is available in the Corporate, Business and Software Engineering, System Engineering and Ultimate
editions
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The WAN Optimizer

You can significantly improve Enterprise Architect's performance in a Wide Area Network (WAN) by reducing the
amount of data transmitted and, in turn, the number of network calls made. To achieve this, you can use the Sparx
Systems Wide Area Network (WAN) Optimizer, a lightweight server installed on a Local Area Network (LAN)
connection to a Database Management System (DBMS) that hosts an Enterprise Architect repository. You can configure
the server to listen for client connections on a particular port; it acts as a local proxy to execute queries and return the
results in a compressed format to the client.

In this diagram, transmission between Enterprise Architect and a DBMS is depicted first without and then with the WAN
Optimizer.
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WAN Optimizer

You can download the WAN Optimizer installer from the 'Downloads' page of the Registered Users section of the Sparx
Systems website. The Wan Optimizer Service installer package provides two installable features for the target machine:

e WAN Optimizer Service - the installer also helps register and start the service on the target machine, and add it to
the Windows Startup folder

e  WAN Optimizer Admin Client - to enable an administrator to administer and configure the service from a remote
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client
The Optimizer has its own Sparx Systems WAN Optimizer User Guide. See that Guide for more information on:
e WAN Optimizer Components
e Installing and Starting the WAN Optimizer Service
e Configuring the Service

e Troubleshooting
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Cloud Based Repositories

With a simple connection to the internet or web - the 'Cloud'’ - you can access and work on projects stored in repositories
at remote locations anywhere in the world, or access local repositories from such locations, using the Enterprise
Architect installation on your machine. The advantages of working in this way include:

e  You, as a user, do not need to have database drivers installed on your machine or to create a database connection, as
you do to work directly on projects held on a DBMS server; your system administrator performs the driver set-up
and connection once only, during server configuration

e The http and, especially, https connections apply a firewall and all the security facilities provided by the web server -
whether Apache or IIS - to your project work, such as URL authorization, domain authentication and IP security

e The Cloud Server can be configured to encrypt all communications using standard TLS/SSL protocols; you can be
certain that your data is not intercepted during transmission across insecure networks

Using the Cloud can help to reduce lag time for common tasks such as opening Packages and editing model data.
Requests are cached and sent together, rather than individually, which reduces communication delays to a minimum.

Using the Cloud server is most beneficial when:
e  You want to minimize the set-up requirements each user has on their workstation
e  You want to expose models held outside your private network

e  Your users are accessing their models over slow connections

Notes

e  This facility is available through the Corporate, Business and Software Engineering, Systems Engineering or
Ultimate editions
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Introducing the Cloud Server

The Sparx Systems Cloud Services solution provides seamless access to Enterprise Architect repositories (models) from
anywhere in the world, providing high performance for remote access, secure encrypted links and optimization for high
latency WAN connections.

Cloud-based repositories provide easy access to models, not only for people within your local team, but for remote team
members, external customers and consultants anywhere around the world with Internet access. Collaborative and
distributive modeling and design are dramatically enhanced by using a Cloud-based repository, and can provide the
shared backbone for a wealth of development scenarios.

This section will:
Familiarize you with the concepts of the Cloud Services
Walk you through the process of setting up a server
Walk you through the process of connecting for the first time

1

2

3

4. Discuss considerations of when and where you should use a Cloud server

5. Highlight some of the additional functionality available through the Cloud server
6

Outline working with Active Directory using IIS

Overview

Connecting to models stored in a Cloud Server is as simple as entering a single URL. Enterprise Architect models are
stored in databases. With standard connection to DBMS repositories, such as SQL Server and Oracle, Enterprise
Architect requires users to install the appropriate drivers for the database and create ODBC or other connections.

When connecting to a Cloud Server that procedure is dramatically simplified, requiring only a URL to the provided
Cloud repository. No special drivers or further configuration is required.

Connecting to a Cloud Server provides a number of key benefits:

1. Improved performance for models used for distributed development. The Cloud server provides benefits to
connections that involve high latency and reduced data transfer speeds.

2. The process of setting up drivers and connections can now be performed once by an administrator during the server
configuration. The only set-up required on a user machine is to install Enterprise Architect and connect to any model
on the Cloud server using a simple URL.

3. Database servers no longer have to be exposed through a firewall; the Cloud server can be run from inside a
corporate firewall. All model connections are now created using HTTP, allowing firewalls to completely isolate your
database server.

4. A Cloud server can be configured to encrypt all communication. Using standard TLS/SSL protocols, you can be
confident that your data is not intercepted during transmission on insecure networks.

5. A Cloud server can be configured to provide HTTP-level authorization to any model taken directly from the model
user list. Even when the model is exposed on a public network, you can be assured that only authorized users are
able to access your model.

6. A Cloud server can be configured to provide read-only access to any model; for example, for clients required to
review a model.

Security Considerations

As with any web connected service, there are a number of security concerns that must be considered when setting up a
new service. To help you minimize risks, consider these points:

e Ifany data is considered private, always use an HTTPS connection and require user authentication. There is an
option on each of the service's database configurations to prompt for this.
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e  There is an implicit trust in sharing a model with anyone. Security is available in models, which prevents a wide
range of possible interactions. However, due to Enterprise Architect's flexibility determined users can circumvent
this. In particular Model Search SQL queries can be run in a number of places that allow data to be read that would
not otherwise be accessible. Of note, this includes user IDs and hashes of their passwords. To prevent this type of
access to a list of users, you could use Global Authentication instead of Model Authentication. This is discussed
further in the Cloud Server Configuration topic.
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Cloud Server Installation

The Sparx Systems Cloud Server runs as a Windows Service, accepting network connections from Enterprise Architect
clients and sending the data required by the system back over the network. The service installer can be downloaded from
the registered user section of the Sparx website:

http://www.sparxsystems.com.au/registered/index.html

Installing the service and editing configuration files will both require you to have Administration rights. To ensure that
you are running as Administrator, right-click on the downloaded installer and select 'Run as Administrator'.

Cloud Server Components

Component Description
Sparx Systems Cloud The Windows service that will accept connections from Enterprise Architect and
Service the management client.

Note: The only time you will not want this installed is when you are installing the
IIS integration or management client on a different machine to the one running the
service.

Http Support Optional component for integration with IIS.

Note: This is only required when using the advanced authentication method
available through IIS; it can be installed on a different machine to the service itself.
See the Cloud Server Using IIS topic.

Management Client This is used for management tasks - including configuration of databases to connect
to - and some server options.

Note: This can be installed separate from the service itself, allowing many
management tasks to be performed without logging directly into the server.

Firewall Settings

When setting up a server, you do need to check that the Firewall on the server is set to allow the incoming ports for the
database connections that you have created.

For example, in the default SSCloudServices.config the ports 804 and 805 are set as operative. If you have a firewall you
must set these ports as enabled for inbound traffic.
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See also the Windows documentation Open a Port in Windows Firewall.

Note: Another common cause of failure is that other services are already using the allocated ports. This is especially
likely when using the default http (80) and https (443) ports.

Self-Signed Certificate using OpenSSL

In order to use a secure connection to your model, a server certificate is required. For a production environment,
particularly one providing access to external users, you should obtain a certificate from an appropriate certificate
authority. However, to help with initial setup and testing purposes these instructions are included for generating your

own certificate.

This is a simple batch file that assumes that openssl is available on the windows path and is appropriately configured. If
you paste this code into a batch file and run it with the target hostname as a parameter, it will generate an appropriate key

file, which can then be placed in the service install directory.
echo off
if not "%1" =="" goto generate
echo ERROR: No target specified
echo USAGE: %0 url
echo EXAMPLE %0 localhost
goto end
:generate
echo on
openssl genrsa -out %1.key 2048
openssl req -new -x509 -key %1 .key -out %1.cert -days 3650 -subj /CN=%1
copy /b %1.cert+%1 .key server.pem

:end
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Cloud Server Configuration

Many configuration settings for the Cloud Server are set by directly editing the configuration file
SSCloudServices.config found in your service directory.

To edit the configuration file, open it in a text editor (running as an administrator).

Once it is opened, you can edit the file to set configuration options, including the ports the server will listen on.

Management Client Connection Settings

The first settings you will see in the configuration file are to control how the Management Client will connect to the
server. The default values are:

SERVER_PORT=803
SERVER_PASSWORD=

Use of the Management Client is discussed in the Cloud Server Management Client topic.

Setting Description
SERVER PASSWORD SERVER_PASSWORD is the password to protect the administration functions of
the server.

Note: This can be changed within the Management Client, which means a full
server restart will not be necessary.

SERVER PORT SERVER _PORT is used when you connect to the Management Client or opt to
use the IIS integration instead of the integrated web-server. For more detail see the
Cloud Server Using I1S topic.

Note: When changing this port, check for other services on the same one. We
recommend that this port is not exposed to any external networks, as encryption
cannot be applied to it.

General Settings

The next list of settings is the default global settings across the entire service:
DBMAN DEFAULTMAXSIMQUERIES=10
AUDIT TIME PERIOD=3600
TEMP_DIRECTORY=%SERVICE PATH%\Temp
LOGGING LEVEL=SYSTEM
LOGGING DIRECTORY=%SERVICE PATH%\Logs
LOGGING FILECOUNT=3
LOGGING_FILESIZE=1048576

Setting Description
AUDIT TIME PERIOD The number of seconds between the system logs recording activity on each
database.

DBMAN DEFAULTMAX The default maximum number of queries that can be run at a time for any
configured database. This can be changed directly within the Management Client
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SIMQUERIES (sece Default Max Simultaneous Queries under Global Server Options in the
Cloud Server Management Client topic).

Note: As this can be set directly within the Management Client, a full server restart
will not be required.

TEMP_DIRECTORY The location to write temporary files before they are sent to clients. You should not
generally need to change this.

LOGGING_LEVEL Determines how verbose the server should be when writing log files. The valid
values are: OFF, FATAL, WARNING, INFO and SYSTEM. The value can be
changed directly within the Management Client. (See Log Level under Global
Server Options in the Cloud Server Management Client topic).

Note: As this can be set directly within the Management Client, a full server restart
will not be required.

LOGGING_DIRECTORY Defines where the log files are to be stored. The default is set to:
=%SERVICE PATH%\Logs

Note: The =%SERVICE PATH% refers to the directory where the Cloud service is
installed.

LOGGING_FILECOUNT Determines the maximum number of rolling log files kept. When the file count is
exceeded, the oldest file is automatically deleted.

LOGGING_FILESIZE Determines the maximum file size of each log file. When the logging file size is
reached a new log file is created.

For more details on using the logs see the Cloud Server Troubleshooting topic.

Client Connection Settings

Using the Cloud Server you can define an arbitrary number of different ports on which to listen for connections from
Enterprise Architect, each with a different configuration. Each port is denoted in the configuration file, with open and
close parentheses, on their own lines.

(

SERVER PORT=804

REQUIRE SSL=0

DEFAULT _MODEL=

MODEL AUTHENTICATION=

GLOBAL AUTHENTICATION=user model
OSLC _SUPPORT=1

)
Setting Description
SERVER PORT The port on which the server will listen for HTTP connections; each connection

must be unique and not used by any other services on the machine. You must check
that no firewalls are blocking this port on the client or server. You can use the
standard HTTP port (80) or HTTPS port (443).

Note: When changing this, check firewall settings and other services using that
port.
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REQUIRE SSL Should be set to 1 to enable HTTPS on this port; HTTPS should be enabled for all
connections that are being exposed on public networks. HTTPS requires a private
key file (server.pem), to be included in the same directory as the configuration file,
before it will run.

Note: This unique file must be user-created. See Creating a Self-Signed Certificate
using OpenSSL in Cloud Server Installation.

DEFAULT MODEL Allows a single model to be exposed on a port, making it possible to use a different
port for each model. Model Names are discussed further in the Connecting
Enterprise Architect to a Cloud Server topic.

MODEL AUTHENTICAT Can be set to 1 to request HTTP authorization using the user security defined in the

ION Enterprise Architect model being connected to. Passwords must be explicitly and
individually assigned in that model using the Maintain Users procedure; the default
administrator password and any passwords imported from Windows Active
Directory do not work. Note that if you are not using SSL to connect, the usernames
and passwords will be sent in plain text.

If the model does not have security enabled, the Cloud user is not prompted for a
password.

This option is mutually exclusive with GLOBAL_AUTHENTICATION.

GLOBAL AUTHENTICA Can be set to the name of an Enterprise Architect model with security enabled that

TION will provide the list of users for all models accessed by the connection. This is
helpful if you want to provide multiple models but only manage one list of users.
Passwords must be explicitly and individually assigned in the reference model
using the Maintain Users procedure; the default administrator password and any
passwords imported from Windows Active Directory do not work.

This option is mutually exclusive with MODEL AUTHENTICATION.

OSLC_SUPPORT Enabled by default. It allows models to be queried using the 'Open Services for
Lifecycle Collaboration' standard. This is discussed further in the OSLC
Requirements Management topic.

Set to 0 to disable.

Restarting the Sparx Cloud Server

If you make any changes to the configuration file you must restart the server for the changes to take effect. A server
restart is carried out in the Windows Services application.

Depending on the server operating system, there are two methods for restarting the Cloud Server:

1) Using Window Services. This is available in all versions of Windows (see 'Control Panel | Administrative Tools |
Services').

- Description Status

Sparx Systems Cloud Services Mame
., Software Protection Enables the ...

Stop the service #15panx Systems Cloud Services Sparx Syste..  Running

Restart the service -, Special Administration Con...  Allows adm...
Figure 8: Start and Stop options for Cloud Services in the Windows Services view

2) Using the Server Manager on Windows Server 2012.
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Notes

e Ifyou need to assign passwords to user IDs for a model or models that will be accessed via the Cloud, then:

1. Open the reference model using a direct connection or via a Cloud connection on a port that does not have either
MODEL AUTHENTICATION or GLOBAL AUTHENTICATION set.

2. Enable security and assign a new administrator password.

3. Open the Cloud Server Management Client for the new database and set the checkbox 'Require a secure and
authenticated connection'. (Now that you have a valid account, this model will no longer be accessible without https
and http level authentication.)

4. Connect to the model on a port that does have an AUTHENTICATION setting and use the Maintain Users
procedure to assign passwords to the user IDs in the model.
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Cloud Server Management Client

At any point after installation you can connect to the service using the Management Client
(SSCloudServicesClient.exe).

By default this is accessible from: '...\Program Files (x86)\Sparx Systems\Cloud Services\Client'.

The Management Client is used to configure various settings related to the cloud service and the repositories it connects
to. When the application first starts the user is prompted to log into a cloud services (see Logon screen for more details),
once this is done the Main screen is shown.

The Main screen

The main screen for the Cloud Management Client shows a list of all defined repositories for the Cloud Server and the
number of active and total user connections. It is also the entry point for all management functions, i.e. new repositories
can be created, existing ones edited and old ones removed.

@ Spary Systerns Cloud Services Configuration Client {1.0,11) El (=] @
Database Managers: Protocol wersion: 6
Database Manager Connections ‘ Refresh ‘
firebird: anonymous@myFirebird o1z}
msdasql. 1 eauser@mysgl_ga o1z} ‘ Add ‘
oraoledb.oracle, 1jeauser@orallg o1z}
sgloledb. 1:eauser@sgl-serverisql2012 . ea o1z}
Remaove
Configure

Server Options

Exit
Sparx Systems Cloud Services supports connections to the following list of DBMS products:
e  Firebird
o Microsoft SQL Server
e MySQL
e  Oracle
e  PostgreSQL
Item Description
Database Managers This list displays all defined repositories, each row represents an Enterprise

Architect repository and contains 2 columns of information: a summary to describe
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the repository and the number of active and available connections.

Refresh This button reloads the contents of the Database Managers list.

Add This button displays a screen that allows the user to define a new database.

Remove This button permanently deletes the selected Database.

Configure This button displays a screen that allows the currently selected database's settings to
be changed.

Server Options This button displays a screen that allows the Cloud Server options to be changed.
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Logon Screen

The Logon screen is the first to be shown when launching the Management Client and at a minimum requires the address
(and port) of the Cloud Server you wish to connect to.

-

B | Cloud Services Logon @

Server Address (eq localhost: 42432):
localhost: 303

Password:

Ok ] [ Cancel

The Management Client can be used from any machine on your local network, however communications between it and
the Cloud Service are not secure, so it should not be used from outside of a secure network.

Cloud Services Logon

Option Description
Server Address The Server Address format is:
<ServerURI>:<Port>

The server URI can be ‘localhost’, an IP address, a DNS name or a machine name;
for example, MyWebServer. If you are working on the web server, 'localhost’ will
be sufficient.

Password Enter the password you defined in Management Client Connection Settings, in the
Cloud Server Configuration topic. By default this password is blank; you can reset
it to a new value, as described in the later section Global Server Options.
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The Add Database Manager screen is shown whenever the Add button is pressed on the Main screen and helps the
user define a new database connection to either a local Firebird or DBMS repository (via ODBC or OLE/DB).

-

Add Database Manager

S

Add Database Manager:

those on the server.

Connection Sfring:

QODBC Data Sources

Mote: The Data Source Mames and network paths provided by the Data Link Properties and
QDEC Data Sources dialogs are relative to this machine and may need to be modified to match

o]

oK |[ Cancel ]

The following note is shown on the Add Database Manager screen:

"Note: The Data Source Names and network paths provided by the Data Link Properties and ODBC Data Sources
dialogs are relative to this machine and may need to be modified to match those on the server."

This means if the Management Client application is running from a remote machine (i.e. not the Cloud Server) the

screens that are shown by using the B and 'ODBC Data Source' buttons are relative to the current machine and not the
Cloud Server, so care should be taken.

By default whenever a new Database is defined as a safety precaution it is automatically configured to be disabled. This
can be changed by checking the 'Accept Queries' option on the Configure Database Manager screen.

-

Configure Database Manager

=)

Database Manager:

Database Alias:
Database Type:

Connection Sfring:

Accept Queries

firebird:anonymaus @myfirehird

MyFireBird
FIREEBIRD

MyFireBird —
DEType=9;Connect=Provider=MSDASCL. 1;Lazyload=1;Extended
Properties="DRIVER =EA Firebird ODBC driver;DATABASE=

Connection Options

-

Max Simultaneous Queries; 12

-

[ Read-only connection

["|Require a secure and authenticated connection;

[T Run Scheduled Tasks

Save ] [

Close
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Adding New Databases

It is important to note that the Cloud Server uniquely identifies Databases by a single identifying value, this value is
referred to as the 'Database Alias'":

- for Firebird definitions the 'Database Alias' is the filename minus the extension

- for ODBC based definitions the 'Database Alias' is the 'Data Source'

- for Oracle OLE DB based definitions the 'Database Alias' is the 'net service name'

- for SQLServer OLE DB based definitions the 'Database Alias' is the 'Initial Catalog'

Therefore careful consideration must be taken when defining database connections to ensure that duplicate 'Database
Alias's are avoided. However if more than one database definition share the same alias then all Enterprise Architect
clients will connect to the first database found with the requested alias.

Item Description

Firebird Database You can define a connection to a Firebird database by entering its filename (and
extension) only, i.e. 'MyFireBird.fdb'".

Add Database Manager [ﬁ

Add Database Manager:

Mote: The Data Source Mames and network paths provided by the Data Link Properties and
ODBC Data Sources dialogs are relative to this machine and may need to be modified to match
those on the server.,

Connection String:

MyFireBird. fdb D

ODBC Data Sources ok || cancel |

The Cloud Server assumes all Firebird databases physically reside under the
directory %SERVICE PATH%\Models\. Therefore, if the Cloud Server is installed
to the default folder of:

...\Program Files (x86)\Sparx Systems\Cloud Services\
then all Firebird models will be located at:

...\Program Files (x86)\Sparx Systems\Cloud Services\Models\

ODBC Database You can define a connection to a DBMS Database by specifying the connection
string to the database. If you are running the Management Client on the same
machine as the server you can

- click on the "..." button to open the 'Data Link Properties' dialog to build the
connection string

- select provider 'Microsoft OLE DB Provider for ODBC Drivers' and click Next
>>!

- select the pre-defined System DSN from the 'Use data source name'

- fill in the user name and password and check the 'Allow saving password'
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EF| Data Link Properties @

Provider | Connection |P~.d'~rar1ced I Al |

Specify the following to connect to QDBC data:
1. Specify the source of data:

@ Use data source name
MySQL_EA - | Refresh

(71 Use connection string

Build...
2. Enter information to log on to the server
|ser name: eauser
Password: sessssss
[] Blank password Allow saving password
3. Enter the initial catalog to use:
-
[ Test Connection ]

OK || Cancel || Help |

Note 1: All ODBC DSNs need to be defined as SYSTEM DSNs because the Cloud
Server runs as a Windows Service and User DSNs may not be available to the
Cloud Server.

Note 2: the step about filling in the user name and password may not be required if
the user name and password have been saved with the ODBC DSN.

You can define a connection to an Oracle Database (via OLE/DB) by specifying the
connection string to the database. If you are running the Management Client on the
same machine as the server you can

- click on the "..." button to open the 'Data Link Properties' dialog to build the
connection string

- select provider 'Oracle Provider for OLE DB' and click 'Next >>"'

- enter the name of the 'Data Source', this is the Oracle 'net service name' as defined
in the TNSNAMES.ORA

- fill in the user name and password and check the 'Allow saving password'
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Ef| Data Link Properties @

Provider | Connection Mvancedl.ﬂdl |

Specify the following to connect to this data:
1. Enter the data source and/or location of the data:
Data Source: orallg

2. Enter information to log on to the server:

Use Windows NT Integrated security

@ Use a specific user name and password:
Uszer name: eauser
Password: T

[ Blank password Allow saving password

[ Test Connection ]

OK || Cancel || Help |

Note: because the Cloud Server identifies databases by the 'Data Source' value and
Oracle OLE DB defines the 'Data Source' as the 'net service name' it is only
possible to access 1 Oracle repository per 'net service name'. The workaround to
this limitation is to define multiple 'net service name' in TNSNAMES.ORA that
differ only by name.

Microsoft SQL Server supports 2 different forms of database authentication:
1. Windows NT authentication or
2. SQL Server authentication,

The Cloud Service will work with either, but SQL Server authentication is easier to
configure.

Prior to defining the Cloud Service connection a SQL Server user should be defined
and granted the following roles to the database that will act as the Enterprise
Architect repository: db_datareader, db_datawriter

You can define a connection to a SQLServer Database by specifying the connection
string to the database. If you are running the Management Client on the same
machine as the server you can

- click on the "..." button to open the 'Data Link Properties' dialog to build the
connection string

- select provider 'Microsoft OLE DB Provider for SQL Server' and click 'Next >>'

- select/enter the instance of SQL Server
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- check 'Use a specific user name and password' and fill in the user name, password
and check the 'Allow saving password'

- select the database that is the Enterprise Architect repository in 'Select the
database on the server'

EF| Data Link Properties @

Provider | Connection Mvancedl.ﬂdl |

Specify the following to connect to 5QL Server data:
1. Select or erter a server name:

SQL-SERVERMWSGL2012 = | Befresh

2. Enter irformation to log an to the server:
(71 Use Windows NT Integrated security

@ Use a specific user name and password:
User name: eauser

Password: esssssss
[] Blank password Allow gaving password
3. @ Select the database on the server:
- -

(7 Mtach a database file as a database name:

[ Test Connection ]

| ok || cancel || Hep |

Microsoft SQL Server supports 2 different forms of database authentication:
1. Windows NT authentication or
2. SQL Server authentication,

The Cloud Service will work with either, but Windows authentication requires
some special consideration. The Cloud Server runs as a Windows Service, and by
default all Windows Services run as 'Local System Account' therefore if Windows
authentication is to be used the Sparx Systems Cloud Service should be configured
to run under predefined network user (configured with the Windows Services
console) and this network user will need to be granted access to the database
(configured with Microsoft SQL Server Management Studio or similar).

You can define a connection to a SQLServer Database by specifying the connection
string to the database. If you are running the Management Client on the same
machine as the server you can

- click on the "..." button to open the 'Data Link Properties' dialog to build the
connection string

- select provider 'Microsoft OLE DB Provider for SQL Server' and click 'Next >>'
- select/enter the instance of SQL Server

- check 'Use Windows NT Integrated security'

- select the database that is the Enterprise Architect repository in 'Select the
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database on the server'
o B
£ | Data Link Properties M

Provider | Connection | Advanced | Al |

Specify the following to connect to 5QL Server data:
1. Select or enter a server name:

SOL-SERVERNSQL2012 ~ | Befresh
2. Enter information to log an to the server:
@ Use Windows NT Integrated security

(") Use a specific user name and password:

Uzer name:
Pazzword:
Blank password Allow saving password
3. (@ Select the database on the server:
ea -

(71 Mtach a database file as a database name:

Ilzing the filename:

[ Test Connection ]

P oK J[ Cancel ][ Help ]

Note: Because the Cloud Service is run under a single account, all database access
will be performed under that account, so it will not be possible to keep track of
what records are updated in the database by individual users.
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Configure Database Manager

The Configure Database Manager screen is shown whenever the 'Configure' button is pressed on the Main screen. It
allows the user to modify the various options for a given Database.

-

Configure Database Manager

=)

Database Manager: firebird:anonymaus @myfirehird
Database Alias: MyFireBird

Database Type: FIREBIRD

Connection String: MyFireBird -—

DBEType=9;Connect=Provider=MSDASCL. 1;LazyLoad=1;Extended
Properties="DRIVER =EA Firebird ODBC driver;DATABASE=

Connection Options

Accept Queries Max Simultaneous Queries: 12 :
[] Read-only connection
[|Require a secure and authenticated connection;
[ Run Scheduled Tasks
Save ] [ Close
e
Options
Field/Option Description

Database Manager

Database Alias

Database Type

Connection String

Accept Queries

(c) Sparx Systems 2015 - 2016

Read-only display showing the description of the database as shown in the
Database Manager List. The description contains a number of values formatted to
help quickly describe the database. The description has the format:

{odbc provider}:{user} @ {datasource}

Read-only display showing the Database Alias, this is the value all Enterprise
Architect clients will need to use in the 'Model Name' field of the 'Cloud
Connection' screen.

Read-only display showing the DBMS of the database, i.e. Firebird, MySQL,
Postgres, SQLSvr or Oracle.

Read-only display showing the connection string used to connect to the database.

Select this checkbox to allow the Cloud service to respond to requests for the
connection.
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Max Simultaneous Queries Type in the maximum number of connections to open. You can use the up/down
arrows to adjust this figure to balance resource usage with concurrent user
performance.

Read-only connection Select this checkbox to prevent users from modifying the database referenced by

this connection.

Require a secure and Select this checkbox to ensure this database is only used by https connections using
authenticated connection http authentication.
Run Scheduled Tasks Select this checkbox to enable the service to update Time Series charts on a

schedule, or any other scheduled tasks that might be supported in the future.
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Global Server Options

The Configure Server screen displays when you click on the 'Server Options' button on the Main screen. It helps you
to configure the global options applied to the Cloud Server. Each of these options can also be set in the configuration
file; however, the service does not require a restart if the options are changed using this screen.

-

Configure Server

S5

Server Properties:
Protocol Version:
Audit Time Period:
Logging File Count:
Logging File Size:
Log Level:

Logaing Directory:

Temp Directory:

[ set New Password
Mew Password:

Confirm Password:

C:\EA\Sparx Cloud Services\Debua'Logs

C:\EASparx Cloud Services\DebugiTemp

Default Max Simultaneous Queries: 12

300
17

16777

\mFo -

LA
{w1)
m

Close

Options

Field/Option

Protocol Version

Audit Time Period

Logging File Count

Logging File Size

(c) Sparx Systems 2015 - 2016

Description

Read-only display showing the highest level protocol supported by this version of
the server.

Read-only display showing the number of seconds in-between each audit report.

Read-only display showing the number of log files that should be retained. All
logging is written to files named 'SparxCloudServicesLog-X.log' where X
represents the file number. File 'SparxCloudServicesLog-1.log' is always the
current file, when the maximum file size is reached all existing files are renamed by
incrementing their file number and a new 'SparxCloudServicesLog-1.log' created.

Read-only display showing the max file size of each log file before a new one is
created.
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Log Level Click on the drop-down arrow and select the level of information to be written to
the log file.

Logging Directory Read-only display showing the physical directory where the log files saved.

Temp Directory Read-only display showing physical path of the temp directory.

Default Max Simultaneous Set the value of 'Max Simultaneous Queries' for newly created database

Queries connections.

Set New Password Select this checkbox to change the password for using the admin client for this

server; type in and confirm the new password.
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Connecting Enterprise Architect to a Cloud Server

Once your server has been set up with at least one port listening for communication and at least one model you can
connect to, you can connect to the model in Enterprise Architect. When you first open Enterprise Architect, the "Manage
Projects' dialog displays. The Connect to Cloud button on the top right provides access to Cloud connections.

Manage Projects “

Erterprise | | ®)  Lodke = |[ fovesinfe -
Arghitect

Fazare Foast

'- Pl Mo P
&9 EAEsae -\ Termg [EA BT eag .
‘ Frsgresmian Rageassion — Lomert=Coasd=protscsthiipead.,

Frdiminn 17 e Teumen | Frdtmbnn 171 ame —

There is also a Cloud Connection link on the 'Start Page'.

(@)Start Page X

Enterprise Architect

Version 12

Start
Mew File
Open File

Server Connection

Cloud Connection

Cloud Connection Dialog

The 'Cloud Connection' dialog prompts you for the details of the model.
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Manage Projects

Enterprise [ 8] Local File |+ | | [l Connectto Server |+ | | &  Connectto Cloud |
Architec®

Ve rsion Cloud Connection

pad... -
ssil...
Protocal: Server: Port: S
ssil... =
http:// [+ | locahost 804 [+ o
s:lo...
Model Mame:
, s:lo...
Myfirebird 1M, p-
roject to Open
| QK—|| Cancel ||  Hebp |
Rr=onrg
SYSTEAES | Heln
Field/Option Action

Name Type the name by which to refer to this model. It does not have to match any values
on the server, and will appear in your recent models list.

Protocol Click on the drop-down arrow and select a secure (https) or insecure (http)
connection, as supported by the server you are connecting to. When you select the
protocol, the port will automatically be set to match the default for that protocol.

Server Type in the machine name (sparxcloud.com) or IP address (192.168.0.20) of your
server.

Port Define the port number the service is listening on. This should match the settings in
the configuration file on the server.

Note: For a server, the default settings will use port 804 for http and port 805 for
https.

Model Name Type in the name of the model available on the server.

Note: Generally a system administrator will provide you with a list of available
models. However, for those with permission to use the management client the next
table describes how to determine the model name for different connection types.

Determining the model name

DBMS Discussion

ASA/SQL Anywhere ASA/SQL Anywhere repositories are accessed using an ODBC connection, and the
model name will match the ODBC connection name.
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MySQL

Oracle

PostgreSQL

SQL Server
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The database manager might show:
msdasql.1:anonymous@my model

In this case users will enter 'my model' as the model name in the 'Connection'
dialog.

Firebird repositories are most often files in the Cloud Service directory. The model
name will match the file name.

The database manager might show:
firebird:anonymous@my model

In this case users will enter 'my model' as the model name in the 'Connection'
dialog.

MySQL repositories are accessed using an ODBC connection, and the model name
will match the ODBC connection name.

The database manager might show:
msdasql.1:anonymous@my model

In this case, users will enter 'my model' as the model name in the 'Connection’
dialog.

Oracle repositories can be accessed using an OLE DB connection or an ODBC
connection.

The database manager might show:
oraoledb.oracle.1:user@mymodel

In this case users will enter 'my model' as the model name in the 'Connection'
dialog. Note that this means a Cloud Server can't connect to multiple schemas on
the same database via OLEDB.

Alternatively, the database manager might show:
msdasql.1:anonymous@my model

In this case users will enter 'my model' as the model name in the 'Connection'
dialog. Note that this does allow connecting to multiple schemas within the same
database.

PostgreSQL repositories are accessed using an ODBC connection, and the model
name will match the ODBC connection name.

The database manager might show:
msdasql.1:anonymous@my model

In this case users will enter 'my model' as the model name in the 'Connection'
dialog.

SQL Server repositories can be accessed using an OLE DB connection or an ODBC
connection.

The database manager might show:
sqloledb.1:sa@server\instance.mymodel

In this case users will enter the database name 'my model' as the model name in the
'Connection' dialog.

Alternatively, the database manager might show:
msdasql.1:anonymous@my model

In this case users will enter the ODBC connection name, 'my model' as the model
name in the 'Connection' dialog.
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Cloud Server Troubleshooting

Browser Test

For a simple check that the service is operating on the specified ports defined in the configuration file, you can enter this
address into a web browser:

<protocol>://<machineName>:<port>
For example, on the Cloud Server:
http://localhost:804/
Or
https://sparxcloud.com
If the port is enabled this prompt displays:
Sparx Systems Cloud Server

Congratulations, your server is now ready to host your models. Connect through the configuration client to add or
remove models.

If this message is not displayed, confirm the server and port name, check for other services listening on the specified port
and check the server log file for error messages.

Errors shown in Enterprise Architect System Output

Error Message Meaning
HTTP Status 401 Access Indicates a failure to authenticate with the server.
Denied

With the built-in web server, this error will occur if an invalid username or
password was provided, or no username/password were provided.

HTTP Status 403 Indicates an attempt to access a model that is marked on the server as 'Require
authenticated and secure connection'.

This might indicate that you are connecting using an Attp protocol instead of Attps,
or that the port you are using is not providing authentication to the model you are
connecting to.

Check that you are using https.

Check with the system administrator that the security authentication option is
pointing to a model with security enabled.

HTTP Status 500 Unable to The connection is not being accepted.
connect to service e  Check the server name
e  Check the firewall settings on the client and server

e  Check the ports the server is listening on

The database manager for Enterprise Architect established a connection to a cloud service, and requested to
this database was shut connect to a known repository, but the repository is currently disabled.
down

Ask your system administrator to check the 'Accept Queries' option for the database
in question.

There is no database Enterprise Architect established a connection to a cloud service, but the model
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manager configured for the name requested does not match any defined database on the server.

requested repository

Unable to connect to Enterprise Architect established a connection to a cloud service and requested to
Database connect to a known repository; however, when the server attempted to open a

connection to the database using the supplied details, it failed. Note: Whenever this
error occurs, a Warning level message that contains more detailed information will
be written to the cloud server logs.

If the repository is:

e Using ODBC, ask your System Administrator to check that an ODBC
connection is defined as a System DSN (not a User DSN) on the server, that all
connection parameters are correct, and that the database username and
password have been saved into the ODBC DSN or the connection string

e Oracle, ask your System Administrator to verify that the user name and
password were saved with the connection string and that all other options in the
connection are correct

e  SQL Server connecting via OLE DB and Windows authentication, ask your
System Administrator to verify that the user name the Cloud Service is running
under has been granted permission to the SQL Server database (at a minimum
it will need roles db_datareader and db_datawriter) and that all other options in
the connection are correct

e  SQL Server connecting via OLE DB and SQLServer authentication, ask your
System Administrator to verify that the defined user name has been granted
permission to the SQL Server database (at a minimum it will need roles
db_datareader and db_datawriter), that the option to save the password with
connection string was enabled, and that all other options in the connection are
correct

Reading Server Logs

There are two key sources of troubleshooting information to determine the cause of connection errors. The first of these
is the server logs.

When troubleshooting, it is recommended that the Cloud Services LOG_LEVEL property be set to the highest level,
SYSTEM.
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File Edt Fornst Veew Help
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SYSTEM] ! SUCCESS Started database manager Firebird:anommao irebird.
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SYSTEM|: SUCCESS added Jdatabase manager firebird: anonymous@nawmode]

SYSTEM] ! SUCCESS STarted database manager f1irebird:anomymousEnesmodel.
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AupiT] firebird: anﬁ“..frlous@nyﬁrem d Free: O | Mmax active: 0 | acquisitions: Q
AUDIT] firebird:anomymous@myTirebird, Free; 0 | Max Active: o Acq||1_.1;1qms: o]
AUDIT] Firebird:anommous@newmade] Free: 0 | Max active: 0 | Acguisitians: [
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AUDIT,
AUDIT] Start. Period: 20014-04-04 10:51:10 To 20014-04-04 12:01:14 (0d, Lh 10w 45)
AUDIT] Firebird: anu‘}mnllsﬂnyf1reh1rd Free: 0 | Max active: 0 | Acguisitions: [
AUDIT] firebird: annryrlnu:ﬂnyﬁremrd Free: O | Max Active: 0 | Acguisitions: [
AUDIT] Firebird:anomymousdnesmade] Fres: 0 | max Aceive: ] Acguisitions: L]
AUDIT nsdasal 1:anonymousdregression est Free: O | max acrive: 0 | acguisitions: 1]
AUDLT| End
AUDIT] Start. Period: 2014-04-04 12:01:14 To 2014-04-04 13:01:15 (od, 1h Oom 15}
ALDIT, flrehlrd anonymous@my T irebird Free: O | Max Active: 0 | Acguisitions: [
AUDIT, rebird: Dua@nyfir:blrd Free: O | max aceive: 0 | acguisitions: Q
AUDIT rlreblrd auw‘ynousanenmde Free: 0 | max acrive: 0 | acguisitions: 1]
AUDIT nsdasq'l 1: anonymous@regression Test Free: 0 | max active: ] acguisitions: 0
AUDTT
AUDTT St:rt Period: 2004-08-04 13:001:1% to 2014-04-04 14:05:98 (0d, 1h 4m 41s)
AupIT] firebird: anommousdomyT irebird | Free: O | max aceive: 0 | Acguisitions: 4]
AUDIT] Firebird:anonymousdmyTirebird, | Free: @ | max Acrive: O | Acguisitions: 1]
HibH : [aupIT] Firebird:anooymous@newmodel | EFree: 0 | max actiwve: 0 | acguisitions: 4]
Z004-04-04 14:0%5:56 [Isr0]: [AUDIT] msdasql.l:anonymousBregression test | Free: @ | Max active: 0 | Acguisitions: [
20014-04-04 18:0%:56 [I8F0]: [AUDIT] End.
Log Message Explanation
Started database managers When a Cloud Server is initially started, it writes the list of available models to the

log file. For each model you have added, you should see a line such as:

[SYSTEM]: SUCCESS Added database manager
msdasql. 1 :anonymous@mymodel

If the log file is missing any lines, or if the message doesn't read 'SUCCESS' this
might indicate a problem with the model connection.

Open port list When a Cloud Server is initially started, it writes to the log file the status of all
ports on which it tries to listen. For each port, including the management port and
any http/https ports, you should see a line such as:

[SYSTEM] SUCCESS Bound and listening on port 803.

If the log file is missing any lines, or if the message doesn't read 'SUCCESS' this
might indicate a problem with the server port.

A common error here is:
Unable to create secure server on port 443.
Possible causes of this are:

e Keyfile not found at C:\Program Files (x86)\Sparx Systems\Cloud
Services\Service\server.pem

e The server.pem file is an invalid certificate (i.e. a private key is missing)

e Certificate Authority file not found or invalid at C:\Program Files (x86)\Sparx
Systems\Cloud Services\Service\cacert.pem

Unable to connect to During operation, the server will write to the log file any attempts to open a model
database that fail. This will generally not occur until a user attempts to connect to the
database. Errors that can occur here are:

REQUEST CONNECT FAIL. Error (5): Unable to connect to database

This means that the server attempted to open a connect but it failed. If you see this
message, review the list of potential reasons outlined in the earlier section Errors
shown in Enterprise Architect System Output.
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Cloud Server using IIS (Optional)

For most users, the built-in web server provided with the Cloud Server provides all the functionality they need. It is also
the easiest method to set up and use.

However, the Cloud Server also provides the option of integrating with Internet Information Services (IIS). This is only
recommended for users for whom the built-in authentication methods are insufficient, and who want to use Windows
Active Directory or certificate-based authentication.

To configure IIS to host the Cloud Service, you must first set the SparxCloudLink.sseap file to refer to the Cloud
Service, and then in Windows open the Internet Information Services (IIS) Manager and configure it to send requests
to the appropriate module. Depending on your preferences you can choose either an HTTP Module or an ISAPI module.

Prior to setting up HTTP or ISAPI, these settings must be made in IIS:
e Application Pool settings

e  Feature Settings

For a secure HTTPS setup (optional):

e  Setup a Certificate

e Setup HTTPS

Configuration Settings

Before setting up your HTTP module or ISAPI module, you must first check that the sscloudservices.config file for the
service is configured as required, and note the port used so that you can specify it when you go on to set the
SparxCloudLink.sseap file to refer to the Cloud Service.

The directory path containing the /SAPI dll also contains the SparxCloudLink.sseap configuration file.
The path should resemble this example:
“C:\Program Files (x86)\Sparx Systems\Cloud Services\ISAPI”.
Edit this file in a text editor running as an Administrator.
The default contents are:
[cloud]
server=localhost
port=803
The settings are explained further here:
server:

The address to look-up the machine running the Cloud Service. In most circumstances it is best to run the HTTP module
and the Cloud Service on the same machine. In this case, the default value of localhost can be used. If the Cloud Service
is running on a different machine, use the IP address or server name where the service is running.

port:

The port the Cloud Service is listening on for admin requests. By default this takes the value of 803, but this should be
cross-referenced against your service configuration, as explained earlier.

Optional settings

These points are optional. For testing purposes you might prefer to leave these changes until any issues with IIS are
resolved:

1. Clear the Sparx Services configuration file of reference to ports other than the admin port.
In the SSCloudServices.config file, remove all the references to ports other than the administration port (default
803). In other words, remove the bracketed entries ( ... ) from the config file.

2. Save the SSCloudService.Config file.

Restart the Service.
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Application Pool Settings

HTTP or ISAPI will require an Application pool that is 32-bit and not managed code. This illustration shows the settings
for 32 bit applications in the IIS Application Pools Advanced Settings view.

Application Pools

4 A (srRss
L{? Application Pools|
4.6 Sites

Advanced Settings

?

----- & Default Web Site d

Feature Permissions

< MNET CLR Wersion Mo Managed Cod
Enable 32-Bit Applica True
hanag et

Nome [

Queue Length 1000

A

Actions
& add Application Pool...
Set Application Pool Defaults...

Application Pool Tasks

Stop

Recydle...

Edit Application Pool
Basic Settings...

Becucling

e w

AT

Advanced Settings...

This illustration shows the access path and the 'Default Web Site | Handler' mappings to permit Script Execution.

Connections
7

0 Handler Mappings

P

« % I :FArRSYSTE

4 -[&] Sites

----- & Default Web Site

Setting up a Certificate

-2} Application PDDV

Edit Feature Permissions

Permissions:
Read
Script

Execute

oK

Cancel

In order to run the HTTPS service you must set up a security certificate in IIS.

In the IIS manager:

e Under 'Connections', select the root connection (machine name)

e  Double-click the 'Server Certificates' icon

e  Click on 'Create Self Signed Certificate'

e  Enter these details:

Actions
Add Managed Handler...
Add Script Map...
Add Wildcard Script Map..
Add Module Mapping...

Edit Feature Permissions...

”
‘ ReEVerl T Falefit

View Ordered List...

'@ Help
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Connections Actions

0§! Server Certificates

IE = A . - e
“ j  — (SPARXW Use this feature to request and manage certificates that the Web server Create Certificate Request...

Create Sehf_signed Certificate ? Complete Certificate Request...
Create Domain Certificate...

Import...

. Specify Friendly Name Create Self-Signed Certificate...

:r Enable Automatic Rebind of
Renewed Certificate

Help

Specify a file name for the certificate request. This information can be sent to a certificate
authority for signing:

Specify a friendly name for the certificate:

Sparx Cloud|

Select a certificate store for the new certificate:

Personal k4

Setting up HTTPS

To set the bindings through which HTTPS will operate, you need to set the site bindings to include a port and a
certificate.

In the IIS manager:
e  Under 'Connections', select the default web site
e Under 'Actions' click on the 'Bindings' option

e Click on 'Add' in the 'Site Bindings' window

Connections = Actions
- 0 Default Web Site Home :
Ll 2 Explore
= i .
443 _(SPARJ{SYS Filter: - Go - 'E';q Show All  Group by: _ ECW
|5} Application Poals - Edit Site
4-[a] Sites IS * Bindin
: _ [Bindings-]
'@ Default Web Site 93 éﬂ = A, E Basic settings
. Py it Guizicisn

Site Bindings 7 “_k’ View Application

View Virtual Dire

Dpe _Hosthame P [PAddress Sncn b Add... Manage Website
" ¥ . % Restart

Edit. L L

- ® sSiop

- Browse Website
. > m Browse *:80 (htt

Advanced Settin
This will open the Add Site Binding window.

Set the following:

e Type: HTTPS,

e  Port: 443

o SSL Certificate: select the certificate created in Setting up a Certificate.
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View..,

Add Site Binding
Type: IP address: Port:
https v | |All Unassigned v | 443
Host name:
] Require Server Name Indication
SSL certificate:
Sparx Cloud b Select..,
0K

Cancel

HTTP Module

1. In the 'Connections' panel, select the machine properties (top of the tree).

2. Double-click on the 'Modules' icon in the middle panel.
This returns the "Modules' list and the 'Actions' view.
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3. Inthe'Actions' list, click on the 'Configure Native Modules...' option.
 etinm
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This opens the 'Configure Native Modules' view.

4. Click on the Register button to open the 'Register Native Module' dialog.

To set up the HTTP module in the Internet Information Services (IIS) Manager:
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Type in the Name and the Path of the SSCSIISHttpLink.dll file.
5. Click on the OK button. The 'SSCloudServices' checkbox will now be selected.
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=
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6. Click on the OK button to close the 'Configure Native Modules' dialog.
7. In the 'Connections' panel (see Step 1), select your web site.

8. Double-click the Handler Mappings in the middle pane.
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9. Inthe 'Actions' list, click on the '"Add Module Mapping' option to open the 'Add Module Mapping' dialog.
10. In the 'Add Module Mapping' dialog (as illustrated), set the 'Request path', 'Module' and 'Name'.
11. From the '"Module' drop-down select the module added in step 4.
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Request path:

spanccloudlink.sseap
Exarmnple: *.bas, wsvc.axd

PModule:

55CloudServices -

Executable (optional):

Mame:
SSCIDudsewices|

Request Restrictions... ]

Ok ] I Cancel

b —— ]

12. Click on the Request Restrictions button and, on the 'Request Restrictions' dialog, select the 'Access' tab. Select
the 'Execute’ radio button to enable Execute permission.

Respuert Restrictiors:
Mepping | Vierkm | Accae

Spacify the szcen reguired by the handler:

_ Mane
" Resd

Wnbe

-

Note: The 'Mappings' tab should be left with the default settings, that is 'Invoke handler only if request is mapped to'
is not ticked.

13. Click on the OK button.
14. Close the '"Add Module Mapping' dialog by clicking on the OK button.

To complete this HTTP module set up see also Configuration Settings. You should then be able to connect to a model
using Enterprise Architect via your IIS server using the HTTP module.

ISAPI Module

To configure an ISAPI module instead of the HTTP module:

1. In the 'Connections' panel, select the machine properties:
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Double-click on the 'Handler Mappings' icon:

i
&1

Handler
Mappings

In the 'Actions' list, click on the 'Add Module Mapping' option.

In the '"Add Module Mapping' dialog, set 'Request path' to 'sparxCloudLink.sseap', Module' to 'IsapiModule’, and

'Executable' to 'SSCSIISIsapiLink.dll', as shown.

Request path:

spanccloudlink.sseap

Exarnple: *.bas, wsvec.axd

Module:
IsapiModule -

Executable (opticnal):
am Files (86)\Spanx Systems\Cloud Services\ISAPT\SSCSTISIsapiLink.dll E

Mame:
55CloudLink

I Request Restrictions...

Ok ] I Cancel

Add Module Mapping M

Click on the OK button to close the dialog. You should now be able to connect to a model using Enterprise Architect
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via your IIS server using ISAPI.
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Additional Functionality Using the Cloud

The Cloud Services provide the facility of connecting to and using models over a secure http connection. They also make
it possible to use three further facilities on or within your models:

e Open Services for Lifecycle Collaboration (OSLC)
e Reusable Asset Service (RAS)
e  Scheduled Tasks

OSLC

OSLC is an initiative to provide easier integration between Requirement Management tools. It uses HTTP to list, add,
modify and delete requirements. The service provider definition to direct any OSLC client to is:

<protocol>://<server>:<port>/<model_name>/oslc/sp/

For example, if you were connecting to a server running on your own machine using the default settings, the connection
would be:

http://localhost:804/model/oslc/sp/

Reusable Asset Service (RAS)

The RAS portion of the Cloud Server helps you to define Packages that can be used in any model. When a Package is
requested, Enterprise Architect and the Cloud Server will track cross-Package dependencies and make available
everything required by that Package.

Scheduled Tasks

The Cloud Server includes optional support for running time-based updates to data. Currently, this is applied to updating
a Time Series chart automatically to provide a dynamic view of how a model is changing over time. You can set different
time scales for these updates, such as daily, weekly or monthly.

Notes

e  This facility is available through the Corporate, Business and Software Engineering, Systems Engineering or
Ultimate editions
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OSLC Requirements Management

This text is derived from the OSLC Primer:

"Open Services for Lifecycle Collaboration (OSLC) is an open community creating specifications for integrating tools.
These specifications allow conforming independent software and product lifecycle tools to integrate their data and
workflows in support of end-to-end lifecycle processes."

"OSLC is based on the W3C Linked Data. One of the primary techniques for integrating tools using OSLC is Linking
data via HTTP, which specifies creating, retrieving, updating and deleting (CRUD) lifecycle artifacts based on internet
standards like HTTP and RDF using Linked Data model. Each artifact in the lifecycle, such as a requirement, is an HTTP
resource that is manipulated using the standard methods of the HTTP specification (like GET, POST)."

"Enterprise Architect acts as an OSLC Provider and supports the Requirements Management 2.0 specification of OSLC,
which allows for creating, retrieving and querying the Requirements in a model accessed via a Cloud connection. With
OSLC support, Requirements in an Enterprise Architect model can be identified and accessed using a unique URL that
can be linked to resources in other lifecycle products and tools."

Enterprise Architect complies with these Requirements Management 2.0 base requirements:
e  Resource Operations

e  Service Provider Resource

e Partial Resource Representations

e  Creation Factory

e  Query Capability

e  Query Syntax

e  Error Responses

e RDF/XML Representations

*Beta Implementation*

This is a BETA release of OSLC Requirements Management and associated tools. As such, it is supplied without
warranty of any kind and is subject to change without notice during the Beta period. Sparx Systems welcomes any
feedback, issues, suggestions and comments on this implementation. As with all Beta software, please take due care
when using OSLC Requirements Management in a production environment.

Notes

e  This facility is available through the Corporate, Business and Software Engineering, Systems Engineering or
Ultimate editions
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Service Provider and Service Provider Resource

Enterprise Architect acts as an OSLC Provider that other OSLC-compliant tools (OSLC Consumer/Clients) access to link
to its Resources. All OSLC Resources live in a Service Provider, which is a central organising concept of OSLC. In
Enterprise Architect, each model that can be accessed via the Cloud connection is treated as an OSLC Service Provider.
The Requirement elements in the model are the OSLC Resources.

The services offered by the Service Provider can be retrieved using the Service Provider Resource. A Service Provider
Resource specifies the:

e URL to which you can POST representations to create new resources

e URL you can use to GET a list of existing resources

To retrieve the Service Provider Resource from an Enterprise Architect model connected via the Cloud, use the URL:
http://<server>/<model name>/oslc/sp/

For example, the Service Provider Resource for a model called firebird model, connected via the Cloud, would be
accessed using the URL:

http://localhost:480/firebird_model/oslc/sp/

The retrieved resource might resemble this:
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<?xml version="1.0" encoding="UTF-8"?>
<rdf:ROF xmins:dcterms="http:/ /purl.org/dc/terms/" xmins:oslc="http:/ fopen-services.net/ns/core® " xmins:rdf="http:/ /www.w3.org/1999/02/22-rdf-syntax
ns#">
- <oslc: ServiceProvider rdf:zbout="http:/ /localhost:480/firebird_model/oslc/sp/">
=dcterms:title =firebird :anonymous@firebird_model < /dcterms:title>
- «dcterms:publisher>
- =oslc:Publisher=
<dcterms:title=Sparx Systems</dcterms:title=
<dcterms:identifier=http:/ f www.sparxsystems.com.au/ </dcterms:identifier=
</oslc:Publisher>
=/dcterms:publisher=
- <oslciservice>
- <osle:Services
=oslc:domain rdfiresource="http:/ f open-services.net/nsfrm#"/ =
<oslcicreationFactory >
- <oslo:CreationFactory >
<dcterms:title = Requirements Creation</dcterms:title=
<oslc:creation rdf:resource="http:/ flocalhost:480/firebird_model foslc/cf/"/ >
<oslc:resourceshape rdf:resource="http:/ flocalhost:480/firebird_model foslc/rs/"/ > by sending POST request to this URL
<Joslc:CreationFactory>
</oslc:creationFactory >
- <oslc:queryCapability >
- =oslc:QueryCapability =
<dcterms:title > Requirements Query < /dcterms:titla= . .
<oslc:queryBase ?n;lf:resource:"htlp?fIl:lcalhostﬂsl]!ﬂreblrd_modelfoslchl:.l".l‘} > Access the Requirements in the Model
<oslciresourcashape rdf:resource="http:/ flocalhost:480 /firebird_modelfoslc/rs/"/ > by sending GET request to this URL
</oslc:QueryCapability >
<[oslc:queryCapability =
</foslc:Service> Requirements representation is
=/oslciservice = . ' .
- <oslciprefixDefinition > avallable in this URL
- <oslc:PrefixDefinition >
<oslc:prefix=foaf</oslc: prefix>
<oslc:prefixBase rdf:resource="http:/ /xmins.comffoaf/0.1/"/>
< foslc: PreflxDefinition
=Joslc: prefixDefinition>
<oslc:prefixDefinition =
- <oslc:PrefixDefinition >
<osle: prefixsrdfs </osle: prefix=
<oslc:prefisBase rdfiresource="http:/ /www w3.org/ 2000/ 01 frdf-schema#"/ =
</oslc:PrefixDefinition>
=Joslc:prefixDefinition=
- =oslc:prefixDefinition >
- <oslc:PrefixDefinition =
<oslc: prefix>dcterms </oslc: prefix
<oslc:prefixBase rdf:resource="http:f fpurl.org/dc/terms "/ >
< joslc: PrefixDefinition
«foslc: prefixDefinition>
=oslc:prefixDefinition>
- <oslc:PrefixDefinition =
<oslc: prefix>oslc_rm </oslc: prefix>
=oslc:prefixBase rdf:resource="http:/ fopen-services.net/ns/rm#°/ >
< foslc: PrefixDefinition
< foslc:prefixDefinitions
- <oslc:prefixDefinitlon >
- =oslc:PrefixDefinition >
<oslc:prefix=ss</oslc: prefixs
=oslciprefixBase rdfiresource="http:/ /www.sparxsystems.com.au/"/>
= /oslc:PrefixDefinition>
< foslc:prefixDefinition
- «<oslc:prefixDefinition >
- <asle:PrefixDefinition >
<oslcprefixsoslc</oslcprefix s
<oslc:prefixBase rdfiresource="http:/ /open-services.net/ns/coree”/ =
< /osle:PrafixDefinition=
< foslc:prefixDefinitions
- «oslc:prefixDefinition
- =oslc:PrefixDefinition >
<oslc: prefix>rdf</oslc:prefix>
<oslc:prefixBase rdfiresource="http:/ /www.w3.org/1999/02/22-rdf-syntax-ns#" />
«foslc:PrefixDefinition>
=/foslc:prefixDefinition=
<foslc:ServiceProvider>
</rdf:RDF>

-, Create new Requirements in the Model

Elements of the Service Provider Resource

Element Description
oslc:Publisher Specifies the OSLC Provider.
oslc:Service Specifies the services offered by the OSLC Provider. Enterprise Architect supports

these OSLC Requirement Management services:

e  Creation Factory - Used to create new Requirements in the model, by passing
the Requirement's representation in RDF format using HTTP POST to the
URL:

http://<server>/<model name>/oslc/ct/

e Query Capability - Used to list/query the Requirements in the model, by
passing the query using HTTP GET to the URL:
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http://<server>/<model name>/oslc/qc/
oslc:resourceShape Specifies the Requirement's metadata; that is, its properties and constraints. These
are available in the URL:

http://<server>/<model name>/oslc/rs/

oslc:prefixDefinition Specifies the namespace prefixes and their namespace definitions.

Notes

e This facility is available through the Corporate, Business and Software Engineering, Systems Engineering or
Ultimate editions
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Resource Shape

'Resource Shape' specifies a Requirement's metadata; that is, the set of standard OSLC properties and custom Enterprise
Architect properties. 'Resource Shape' can be accessed using the URL:

http://<server>/<model name>/oslc/rs/

The properties of both types specified in the 'Resource Shape' map to specific fields in the Requirement's 'Properties'
dialog in Enterprise Architect. For each property, the 'Resource Shape' can also specify constraints.

OSLC Properties
(These are as defined in the Dublin Core Metadata Element Set.)
Property Name Requirement element Properties dialog field
title Short Description
description Notes
subject Key Words
creator Author
created Created
modified Last Updated

Custom Enterprise Architect properties

Property Name Requirement element Properties dialog field
alias Alias
status Status
difficulty Difficulty
priority Priority
type Type
phase Phase
version Version
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Constraints
Constraint Meaning
name The name of the property.
valueType The type of value the property can have, such as string, dateTime or integer.
occurs The cardinality of the property; that is, whether the property is optional or required.
maxSize The maximum number of characters for a string valueType.
allowedValue The list of values that can be assigned for the property.
readOnly Determines whether a value for the property can be set by the client.
Notes

e This facility is available through the Corporate, Business and Software Engineering, Systems Engineering or
Ultimate editions

e The property identifier refers to a Requirement's unique Enterprise Architect GUID
e The property packagelD refers to the ID of the Package under which the Requirement exists in the model
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Query Capability

Clients can query a model and retrieve the Requirements that match a specific criteria. In Enterprise Architect, the base
URI for accessing the Query Capability is:

http://<server>/<model name>/oslc/qc/

A query string expressing the specific criteria should be added to the base URI and addressed to the model using an
HTTP GET request. The response for this request will be in RDF/XML format. For example, all the Requirements in a
model called firebird model connected by the Cloud can be retrieved using the URL:

http://localhost:480/firebird model/oslc/qc/

The response for the request will resemble this:

<?xml version="1.0" encoding="UTF-8"?>
- <rdf:RDF xmlins:ss="http://www.sparxsystems.com.au/" xmlns:foaf="http:/ /xmiIns.com/foaf/0.1/" xmins:dcterms="http://purl.org/dc/terms/"
xmins:oslc_rm="http:/ fopen-services.net/ns/rm#" xmins:rdfs="http:/ /www.w3.0rg/2000/01/rdf-schema#" xmlns:rdf="http://www.w3.0rg/1999/02/ 22-rdf-
syntax-ns#">
- <rdf:Description rdf:about="http://localhost:480/firebird_model/oslc/qc/ "=
- «rdfs:member:
- <oslc_rm:Requirement rdf:about="http://localhost:480/firebird_model/oslc/re/{58089E4F-E705-46ae-992E-0D876D7F5DF5} /">
<rdf:type:=http:/ /open-services.net/ns/rm#Requirement</rdf:typa:
<dcterms:title:> Requirement2 </dcterms:title=
<dcterms:description> Requirement2 Notes</dcterms:description:
<dcterms:identifier>{58089E4F-E705-46ae-992E-0D876D7F5DF5} </dcterms:identifier>
<dcterms:subject=>risk, loading factor</dcterms:subject=
- <dcterms:creator>
- «foaf:Personz
<foaf:name=Userl < /foaf:name=
«</foaf:Personz
</dcterms:creator>
<dcterms:created>2014-01-06 11:29:23 < /dcterms:created >
<dcterms:modified>2014-01-06 13:20:05</dcterms: modified=
<ss:alias>Requirement2Alias</ss:alias>
<ss:status=Proposed</ss:status>
<ss:difficulty>Medium < /ss: difficulty =
<ss:priority>Medium</s5:priority =
<ssitype>Display</ss:type>
<ss:phase>1.0</ss:phase>
<ss:version>1.0</ss:version:»
<ss:packagelD>355</ss:packagelD>
<foslc_rm:Requirement:>
«</rdfs:member=
- «rdfs:memberzx
- <oslc_rm:Requirement rdf:about="http:/ /localhost:480/firebird_model/oslc/re/{7104C13D-841C-4068-B7EE-FB998C5BA4B7 } /">
<rdf:type>http:/ /open-services.net/ns/rm#Requirement</rdf:type>
<dcterms:title> Requirement1 < /dcterms:title>
<dcterms:description> Requirementl Notes</dcterms:description=
<dcterms:identifier>{7104C13D-841C-4063-B7EE-FB998C5BA4B 7} < /dcterms:identifiers
<dcterms:subject>risk, loading factor</dcterms:subject=
- <dcterms:creators>
- «foaf:Person=
<foafiname=Userl</foaf:name=
=< /foaf:Person=
</dcterms:creators>
<dcterms:created>2014-01-06 11:01:58</dcterms:created>
<dcterms:modified>2014-01-06 13:19:51</dcterms: modified>
«<ss:alias>RequirementlAlias </ss:alias>
«<ss:status=Proposed </ss:status>
«<ss:difficulty>Medium < /ss:difficulty >
<ss:priority>Medium </ss:priority >
«<ss:type>Functional </ss:type>
<ss:phase>1.0</ss:phase>
<ss:version>1.0</ss:version>
<ss:packagelD=>355</ss:packagelD>
<foslc_rm:Requirement >
«/rdfs:member=>
</rdf:Description=
</rdf:RDF>

Elements of the response

In Enterprise Architect, the Query Capability supports these parameters:
e oslc.where

e oslc.select

e oslc.properties

e osle.prefix

Element Description
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oslc_rm:Requirement A Requirement and its properties (as defined in the Resource Shape).

The attribute rdf:about on this element specifies the URL for accessing the
Requirement. The format for the URL is:
http://<server>/<model name>/oslc/re/<requirement GUID>/

Elements with namespace The standard properties from the Dublin Core Metadata Element Set.
prefix dcterms

Elements with namespace The custom Enterprise Architect properties.
prefix ss

Notes

e  This facility is available through the Corporate, Business and Software Engineering, Systems Engineering or
Ultimate editions
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WHERE Parameter

The oslc.where Query parameter specifies the conditions that the resources must satisfy; it is similar to the WHERE
clause of an SQL statement. This parameter must be appended to the base URI of the Query Capability in Enterprise

Architect:

http://<server>/<model name>/oslc/qc/

The syntax for the osle.where Query parameter (defined in BNF grammar and as specified in the OSLC Query Syntax

Specification) is:

oslc_where

compound_term ::

simple_term
space
boolean_op
term
scoped_term

identifier_wc ::

identifier
Prefixediame
wildcard

comparison_op ::

in_op
in_val
value
uri_ref_esc

literal_value ::

boolean
decimal
string_esc
LANGTAG

Examples

"oslc.where=" compound_term
simple_term (space? boolean_op space? simple_term)*
term | scoped_term

" /¥ a space character
"and”

:‘,I"I
identifier_wc comparison_op value

identifier_wc "{" compound_term "}"
identifier

identifier_wc space in_op space? in_wval

wildcard
Prefixediame
J..':’-

rp—_—

see "SPARQL Query Language for RDF", http://www.w3.org/TR/rdf-sparql-query/#rPrefixediame */
—== —0== met e —=" Tt

“inn

"[" value ("," wvalue)* "]"

uri_ref_esc literal wvalue

* an angle bracket-delimited URI reference in which > and % are ‘-escaped.

,I"I.
boolean string_esc (LANGTAG ("~" Prefixeddame))?

.‘J.;'
decimal
"true"” "false”
/* see "XML Schema Part 2: Datatypes Second Edition”, http://www.w3.org/TR/xmlschema-2/ */
:-J_.'
see "SPARQL Query Language for RDF", http://www.w3.org/TR/rdf-sparql-query/#rLANGTAG

J,.':-

/3

a string enclosed in double quotes, with certain characters escaped. See below.

/

These example queries act on a model called firebird_model connected by the Cloud.

Example
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Query

Query: http://localhost:480/firebird model/oslc/qc/?0slc.where=
dcterms:title="Requirement1"

Retrieves all the OSLC properties of all Requirements having the title
'Requirement]'.

Query: http://localhost:480/firebird model/oslc/qc/?oslc.where= dcterms:title in
["Requirement1","Requirement2"]

Retrieves all the OSLC properties of all Requirements having the title
'Requirement1' or 'Requirement?2’.

Query:
http://localhost:480/firebird model/oslc/qc/?0slc.where=dcterms:title="Requiremen
t1" and dcterms:creator {foaf:name}="User1"

Retrieves all the OSLC properties of all Requirements having the title
'Requirementl’, created by 'Userl'.

Query:
http://localhost:480/firebird_model/oslc/qc/?0slc.where=dcterms:creator { foaf:name
}="Userl" and dcterms:created<"2014-01-07"
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Retrieves all the OSLC properties of all Requirements created by 'User]' prior to
7th January 2014.

5 Query: http://localhost:480/firebird model/oslc/qc/?oslc.where=
name="Requirement1"

Returns an error response, as 'name' is not a valid property in Enterprise Architect.

6 Query:
http://localhost:480/firebird model/oslc/qc/?0slc.where=dcterms:created<"01-07-2
014"
Returns an error response as the value of the property created is not in a valid
format.
Notes

e  Dates must be specified in the format YYYY-MM-DD

e This facility is available through the Corporate, Business and Software Engineering, Systems Engineering or
Ultimate editions
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SELECT Parameter

The oslc.select Query parameter specifies the Requirement properties to be retrieved; it is similar to the SELECT clause
of an SQL statement. This parameter must be appended to the base URI of the Query Capability in Enterprise Architect:

http://<server>/<model name>/oslc/qc/

The syntax for the osle.select Query parameter (defined in BNF grammar and as specified in the OSLC Query Syntax
Specification) is:

oslc select ::= "oslc.select=" properties

properties ::= property ("," property)?®

property ::= identifier wildcard nested prop

nested prop ::= (identifier | wildcard) "{" properties "}"
Examples

These example queries act on a model called firebird model connected by the Cloud.

Example Query

1 Query: http://localhost:480/firebird_model/oslc/qc/?oslc.select= dcterms:title
Retrieves the OSLC property 'title' of all the Requirements in the model.

2 Query:
http://localhost:480/firebird model/oslc/qc/?0slc.select=dcterms:title,dcterms:creat
ed,dcterms:creator {foaf:name},ss:version

Retrieves the OSLC properties 'title', 'creator' and 'version' of all the Requirements
in the model.

3 Query: http://localhost:480/firebird_model/oslc/qc/?0slc.select=*
Retrieves all the OSLC properties of all the Requirements in the model.

4 Query: http://localhost:480/firebird_model/oslc/qc/?oslc.select=dcterms:name

Returns an error response, as 'name' is not a valid property in Enterprise Architect.

Notes

e  This facility is available through the Corporate, Business and Software Engineering, Systems Engineering and
Ultimate editions
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Combine WHERE and SELECT Parameters

The oslc.where and osle.select Query parameters can be combined in the base URI of the Query Capability to retrieve
the required properties of all those Requirements that satisfy the specified condition. This is similar to using WHERE
and SELECT clauses together in a SQL statement.

Examples

These example queries act on a model called firebird model connected by the Cloud.

Example Query

1 Query: http://localhost:480/firebird_model/oslc/qc/?oslc.where=
dcterms:title="Requirement1" & oslc.select=dcterms:title

Retrieves the OSLC property title of all Requirements that have the title
'Requirement1".

2 Query: http://localhost:480/firebird_model/oslc/qc/?o0slc.where= dcterms:title in
["Requirement1","Requirement2"] &
oslc.select=dcterms:title,dcterms:created,dcterms:creator {foaf:name}

Retrieves the OSLC properties 'title', 'created’ and 'creator' of all Requirements that
have the title 'Requirement1' or 'Requirement2'.

3 Query:
http://localhost:480/firebird model/oslc/qc/?oslc.where=dcterms:title="Requiremen
t1" and dcterms:creator{foafiname}="Userl" & oslc.select=*

Retrieves all the OSLC properties of all Requirements that have the title
'Requirementl’, created by 'Userl".

4 Query:
http://localhost:480/firebird model/oslc/qc/?0slc.where=dcterms:created<"01-07-2
014" oslc.select=dcterms:title

Returns an error response, as the value of the property 'created' is not in the valid
format.

Notes

e  This facility is available through the Corporate, Business and Software Engineering, Systems Engineering and
Ultimate editions

e Dates must be specified in the format YYYY-MM-DD
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PROPERTIES Parameter

Enterprise Architect supports a technique called Selective Properties, through which clients can retrieve selected OSLC
properties of a Requirement. This technique accepts a partial representation of the OSLC properties; that is, all properties
or only some of them. The base URI for accessing Selective Properties of a Requirement in Enterprise Architect is:

http://<server>/<model name>/oslc/re/<requirement GUID>/

The syntax for the osle.properties Query parameter (defined in BNF grammar and as specified in the OSLC Core
Specification) is:

oslc_properties ::= "oslc.properties=" properties

properties 1= property ("," property)*®

property ::= identifier | wildcard | nested_prop

nested_prop 1= (identifier | wildcard) "{" properties "}"

wildcard = E

identifier 1 1= Prefixediame

Prefixediame 1i1= /* see "SPARQL Query Lanaguage for RDF", http://www.w3.org/TR/rdf-spargl-query/#rPrefixediame */
Examples

These example queries act on a Requirement with the GUID {7104C13D-841C-4068-B7EE-FB998C5BA4B7} in a
model called firebird model connected by the Cloud.

Example Query

1 Query:
http://localhost:480/firebird model/oslc/re/{7104C13D-841C-4068-B7EE-FB998C
SBA4B7}/?0slc.properties=*

Retrieves all the OSLC properties of the specified Requirement.

2 Query:
http://localhost:480/firebird model/oslc/re/{7104C13D-841C-4068-B7EE-FB998C
5BA4B7}/?0slc.properties=dcterms:title,dcterms:creator { foaf:name}

Retrieves the OSLC properties 'title' and 'creator' of the specified Requirement.

3 Query:
http://localhost:480/firebird model/oslc/re/{7104C13D-841C-4068-B7EE-FB998C
5BA4B7}/?0sle.properties=dcterms:title,dcterms:creator { }

Returns an error response as the property 'creator' is incomplete; it should be:

dcterms:creator {foaf:name}

Notes

e  This facility is available through the Corporate, Business and Software Engineering, Systems Engineering and
Ultimate editions
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PREFIX Parameter

Clients can use the oslc.prefix parameter to specify URI prefixes as used in OSLC property names. This parameter is
appended to the base URI of the Selective Properties of a requirement:

http://<server>/<model name>/oslc/re/<requirement GUID>/

The syntax for the osle.prefix parameter (defined in BNF grammar and as specified in the OSLC Core Specification) is:

oslc_prefix ::= "oslc.prefix=" prefix defs

prefix_defs ::= prefix_def ("," prefix def)*®

prefix_def ::= prefix "=" uri_ref_esc

prefix 1= PN_PREFIX

PN_PREFIX  ::= /* see "SPARQL Query Lanaguage for RDF", http://www.w3.org/TR/rdf-sparql-query/#rPN_PREFIX */
uri_ref_esc ::= /* an angle bracket-delimited URI reference in which > and \ are ‘\-escaped. */

Example Queries

These example queries act on a Requirement with the GUID {7104C13D-841C-4068-B7EE-FB998C5BA4B7} in a
model called firebird_model connected by the Cloud.

Example Query

1 Query:
http://localhost:480/firebird model/oslc/re/{7104C13D-841C-4068-B7EE-FB998C
5BA4B7}/?0slc.prefix=otrm=<http://purl.org/dc/terms/\>&
oslc.properties=otrm:title

Retrieves the OSLC property title of the specified Requirement.

Note that the prefix for the namespace http://purl.org/dc/terms/ has been specified
as 'otrm' in the query.

2 Query:
http://localhost:480/firebird model/oslc/re/{7104C13D-841C-4068-B7EE-FB998C
5BA4B7}/?0sle.prefix=otrm=<http://purl.org/dc/terms/\>,spx=<http://www.sparxsy
stems.com.au/\>& oslc.properties=otrm:title,spx:alias

Retrieves the OSLC properties title and alias of the specified Requirement.

Note that the prefix for the namespace http://purl.org/dc/terms/ has been specified
as otrm and that of http://www.sparxsystems.com.au/ has been specified as spx in
the query.

3 Query:
http://localhost:480/firebird_model/oslc/re/{7104C13D-841C-4068-B7EE-FB998C
5SBA4B7}/?0slc.prefix=otrm=<http://purl.org/dc/terms/\>,spx=<http://www.sparxsy
stems.com.au/\>& oslc.properties=otrm:title,sx:alias

Returns an error response as the namespace prefix sx on the property alias is
undefined.

Notes

e  This facility is available through the Corporate, Business and Software Engineering, Systems Engineering and
Ultimate editions

(c) Sparx Systems 2015 - 2016 Page 137 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

(c) Sparx Systems 2015 - 2016 Page 138 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

Creation Factory

Enterprise Architect supports the Creation Factory OSLC service, through which clients can create new Requirements
via HTTP POST. To create a new Requirement, the client POSTs a representation of the Requirement in RDF format to
the Creation Factory URL. If the POST is successful, the HTTP location header of the response will contain the URL of
the created Requirement. An unsuccessful POST will generate an error response.

The Creation Factory URL has the format:

http://<server>/<model name>/oslc/ct/

Examples

These are some example representations of a Requirement in RDF format.

Example RDF Representation

1 <rdf:RDF xmlns:rdf="http://www.w3.0rg/1999/02/22-rdf-syntax-ns#"
xmlns:oslc_rm="http://open-services.net/ns/rm#"
xmlns:dcterms="http://purl.org/dc/terms/"
xmlns:foaf="http://xmlns.com/foaf/0.1/"
xmlns:ss="http://www.sparxsystems.com.au/">
<oslc_rm:requirement>

<dcterms:title>Requirement3</dcterms:title>
<dcterms:description>Requirement Notes
</dcterms:description>
<dcterms:creator>

<foaf:Person>
<foaf:name>Userl</foaf:name>
</foaf:Person>

</dcterms:creator>
<ss:type>Functional</ss:type>
<ss:packagelD>355</ss:packagel D>
</oslc_rm:requirement>

</rdf:RDF>

Result Description

Creates a new Requirement with the specified name, notes, author and stereotype.

2 <rdf:RDF xmlns:rdf="http://www.w3.0rg/1999/02/22-rdf-syntax-ns#"
xmlns:oslc_rm="http://open-services.net/ns/rm#"
xmlns:dct="http://purl.org/dc/terms/"
xmlns:foaf="http://xmlns.com/foat/0.1/"
xmlns:ss="http://www.sparxsystems.com.au/">
<oslc_rm:requirement>
<dct:title>Requirement4</dct:title>
<ss:packagelD>355</ss:packagelD>
<ss:difficulty>High</ss:difficulty>
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<ss:priority>High</ss:priority>
</oslc_rm:requirement>
</rdf:RDF>

Result Description

Creates a new Requirement with the specified name, difficulty and priority.

3 <rdf:RDF xmlns:rdf="http://www.w3.0rg/1999/02/22-rdf-syntax-ns#"
xmlns:oslc_rm="http://open-services.net/ns/rm#"
xmlns:det="http://purl.org/dc/terms/"
xmlns:foaf="http://xmlns.com/foaf/0.1/"
xmlns:ss="http://www.sparxsystems.com.au/">
<oslc_rm:requirement>
<dct:title>Requirement4</dct:title>
<ss:packagelD>355</ss:packagelD>
<ss:difficulty/>
</oslc_rm:requirement>
</rdf:RDF>

Result Description

Produces an error response, as the property 'difficult’ has an invalid (empty) value.

Notes

e  This facility is available through the Corporate, Business and Software Engineering, Systems Engineering or
Ultimate editions

e The OSLC properties 'title' and 'packageID' of the Requirement are mandatory and must be supplied in the RDF
representation

e The value of the OSLC property 'packagelD' should already exist in the model, so before creating a Requirement
using Creation Factory, use the Query Capability URL to determine the existing values of 'packagelD'

e The OSLC properties 'identifier', 'created' and 'modified' of the Requirement are read-only and cannot be set using
the Creation Factory service
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Reuseable Asset Service (RAS)

Within a large organization, groups of users can be separated by geographical distance be on different networks. This can
make it difficult to share common data, standards and modeling structures, without the complexity of using external
version control tools or manually distributing XMI files between projects. Enterprise Architect has a Reusable Asset
Service (RAS) that provides a simple and convenient mechanism for modelers to distribute or download reusable model
structures, information, corporate directives and standards. The shared repository is accessible via a Cloud Service
connection, making it accessible for distributed teams. The person who sets up the reusable data can retain governance of
the resource or asset, whilst users of the service can easily review the currency of the information and download the
latest versions into their models or file folders.

The RAS gives distributed teams convenient access to a single 'source of truth' for shared data, including project
milestones, architectural frameworks and industry standards.

Reusable Assets

Reusable Assets consist of:

e Packages containing elements, diagrams and structures (as drawn from any point within the Project Browser), and
e Files in a range of text, code and graphic formats, including .eap files

An asset can be, for example:

e A common Class library or framework

e A set of common Requirements or Use Cases

e A draft specification document

e Marketing collateral

Storage Structure and Use

Reusable Assets are held in a remote registry, accessed through a Cloud Service connection. The registry contains any
number of Storages, which can either be left unprotected for any user to create, or change-restricted by an Administrator
password. Each Storage can contain any number of Asset Packages holding modeling structures, and files containing
textual or graphical information and data. When a user creates a Storage, they can protect the contents from being
updated in the Registry or downloaded into a model, using password protection defined by that user.

For each Package, the RAS automatically identifies the:

e  Version of the Package held in the registry

e Diagrams and elements (including child Package elements) contained by the Asset Package
e Dependencies on parent Packages of any external elements that the Asset Package references
e Dependencies on MDG Technologies

Any user, regardless of password protection, can freely browse and identify the contents of a Package held in a Storage -
including displaying the diagrams - without importing the material into a model. A user that has imported an Asset
Package into their model can compare their model Package against any version of the Asset Package, to check for and
assess any differences between them.

Notes

e The Reusable Asset Service is available in the Corporate, Business and Software Engineering, System Engineering
and Ultimate editions of Enterprise Architect
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Connect to the Asset Service

The Reusable Asset Service provides model structures and documents to you from one or more registries on remote
systems. You access these registries through a Cloud connection to the appropriate server. The connection details should
be provided to you by your System Administrator or Reusable Asset Service Administrator.

Access
Ribbon Publish > Model Exchange > Reusable Assets
Menu Tools > Reusable Asset Service

Connect to Assets

Field/Option Detail

Registry This field normally defaults to the last-used registry name. If the field is empty, or
if you want to switch to a different registry, click on the E] button to the right of
the field.

The 'Cloud Connection' dialog displays.

Using the information provided by your administrator, type in the server name,
URL and the name of the model hosting the registry data. For example, if you
wanted to download the UBL Frameworks into your model, you would specify the
server 'sparxcloud.com' and the model name 'modelpatterns'.

If advised by your Administrator, type in the user name and password for the
server.

Click on the OK button; the 'Registry' field now shows the server name.

Storage If there is more than one Storage available in the Registry, this field defaults to the
first listed in the Registry.

To check for or select other Storages, click on the drop-down arrow at the right of
the field. Click on the Storage to review. For example, if you were downloading
UBL frameworks, you would select 'UBL' in the list.

The 'Registry Browser' tab displays the Packages registered in the selected Storage.

Notes

e The Reusable Asset Service is available in the Corporate, Business and Software Engineering, System Engineering
and Ultimate editions of Enterprise Architect
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Browse Assets

When you select a Storage in the Reusable Asset Service, the 'Registry Browser' tab immediately displays a list of the
Packages registered in that Storage. You can review and use these Packages using the context menu and buttons on the
tab.

You can review the properties and contents of the selected Package in the Storage, and access any files in the Storage,
using the tabs in the lower half of the Reusable Asset Service view, underneath the 'Registry Browser' tab.

If you have left the Registry Browser open for a while and there is a possibility that the Registry has been changed, you

Fod
can click on the ©¥ 1 icon in the Reusable Asset Service toolbar to refresh the Browser with the latest contents of the
Registry.

Access
Ribbon Publish > Model Exchange > Reusable Assets > Registry Browser
Menu Tools | Reusable Asset Service > Registry Browser

Review Assets

Field/Option Detail
Toggle Filter Bar Right-click on the column headings and select this option to show or hide the Filter
Bar on the display.
<filter bar fields> Type in the appropriate characters to list only Packages that have that string of

characters in the values in the corresponding column.
Package This column shows the name of the Packages held in the selected Storage.

Version This column defaults to the most recent version of each Package held in the
selected Storage.

You can click on the drop-down arrow at the end of a field and select a different
version of the corresponding Package, if any have been registered.

Last Registered This column shows the date and time at which the currently-listed version of each
Package was registered.

Registered By This column shows the user name of the person who registered the currently-listed
version of each Package.

Import Click on a Package name and click on this button to begin to import either the
Package alone or the Package and its dependent structures into your model.

You can perform the same action by right-clicking on the Package name and
selecting the 'Import from Registry' menu option.

If the Package from the Registry already exists in your model, it is deleted and
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replaced by this import.

On a 'Learning Center Library' Storage, click on this button to open the 'Download
Library' dialog.

On a 'Reference Data Library' Storage, click on this button to open the 'Import
Reference Data' dialog.

On a 'Source Code Library' Storage, click on this button to open the 'Save As'

dialog.
Compare with Package in If you have previously imported a Package from the Registry into your model, you
Model can right-click on the Package name in the Registry Browser and select this option
to compare the imported Package with the Registry version, and show any
differences.

The system automatically selects the model Package from the Project Browser.

Find in Project Browser If you have previously imported a Package from the Registry into your model, you
can right-click on the Package name in the Registry Browser and select this option
to highlight the corresponding Package in the Project Browser.

Notes

e  Some of the other options available on the Registry Browser are used to set up assets in the Registry

e If the Storage is password-protected, a prompt for you to enter a password displays when you select to perform an
operation on the data; in this situation, you need the 'Read-only' password to process the information from the
Storage, and the 'All-access' password to change the information in the Storage

e  The 'Registry Browser' tab will be empty for a '"Learning Center Library', 'Reference Data Library' or 'Source Code
Library' type Storage - the contents of these Storages will be available in the 'Storage Files' tab of the Reusable
Asset Service view
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Asset Properties

When you select a Storage and a Package in the Registry Browser, the first four tabs in the lower half of the Reusable
Asset Service view are updated with information from the Package. The 'Asset Properties' tab is a read-only view of the
properties of the selected Package itself.

Access

Open the 'Reusable Asset Service' window using one of the methods outlined below.

Select a package, then click on the 'Asset Properties' tab, to display properties for the selected package.
Ribbon Publish > Model Exchange > Reusable Assets

Menu Tools > Reusable Asset Service

Review Package Properties

Field Detail
Package Displays the name of the selected Package.
GUID Displays the Global Unique Identifier of the Package.
Version Displays the version reference (such as 1.1 or Beta) of the Package.
Author Displays the user ID of the person who created the Package (the Package Author).
Created Date Displays the date and time at which the selected version of the Package was created

(that is, registered) in the Registry.

Modified Date Displays the date and time at which the selected version of the Package was last
modified (that is, re -registered) in the Registry.

Comments Displays any comment recorded against the Package when it was registered in the
Storage.
Notes Displays the notes recorded against the Package when it was registered in the
Storage.
Notes

e The 'Asset Properties' tab will be empty for a 'Learning Center Library', 'Reference Data Library' and 'Source Code
Library' type Storage
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Package Contents

When you select a Storage and a Package in the 'Registry Browser', the first four tabs in the lower half of the Reusable
Asset Service view are updated with information from the Package. The 'Contents' tab lists the diagrams and elements
(including child Packages) held in the selected Package, listing the two types of object separately. You can organize the
information within a column into alphabetical or reverse-alphabetical order for ease of reference, and use the Filter bar
to filter the display to show only items with values containing specific characters or digits.

Access

Open the 'Reusable Asset Service' window using one of the methods outlined below.

Select a package, then click on the 'Contents' tab, to display the contents of the selected package.
Ribbon Publish > Model Exchange > Reusable Assets

Menu Tools > Reusable Asset Service

Review Package Contents

Field/Option Detail

Content Type Click on this button to toggle between listing the Package diagrams first and listing
the Package elements first.

Toggle Filter Bar Right-click on the column headings and select this option to show or hide the Filter
Bar on the display.
<filter bar fields> Type in the appropriate characters to list only elements and diagrams that have that

string of characters in the values in the corresponding column.

Content Type: Diagram These are the headers for the two types of object listed in this tab.

Content Type: Element Click on the appropriate expansion box to hide or show the list of diagrams or
elements under the heading.

Name Displays the name of the element or diagram available in the Package.

Type Displays the type of the element or diagram, such as UseCase or Use Case
Diagram.

GUID Displays the Global Unique Identifier of the element or diagram.

Content Type Displays the object type of the item - Element or Diagram.

Find in Project Browser Right-click on an element or diagram line and select this option to see if the

element or diagram also exists in your model and, if it does, to highlight it in the
Project Browser.

Right-click on a diagram name and select this option to display the diagram within
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View Diagram a labeled frame, as an image.

Alternatively, double-click on the diagram name.

Notes

e  The 'Contents' tab will be empty for a "Learning Center Library', 'Reference Data Library' and 'Source Code Library'
type Storage
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Package Dependencies

A Package held as an asset in the Reusable Asset Service registry might contain elements and diagrams that have
relationships with objects in other Packages. The Packages containing these 'external' objects will also have been added
to the Registry, to support the first Package, and will be listed in the 'Registry Browser' tab along with other, unrelated
Packages. You can establish whether the selected Package in the Registry Browser has links to other Packages in the
Registry, and which they are, by reviewing the 'Dependency’ tab.

Package A depends on Package B if any of these constructs (or their Tagged Values) in Package A references elements
in Package B:

e Elements

e Attributes

e  QOperations

e  Operation Parameters
e Diagrams

e  Connectors

Access

Open the 'Reusable Asset Service' window using one of the methods outlined below.

Select a package, then click on the 'Dependency’ tab, to display a list of Dependencies for that package.
Ribbon Publish > Model Exchange > Reusable Assets

Menu Tools > Reusable Asset Service

Check Package Dependencies

Field/Option Detail
Package Displays the name of the related Package.
Version Displays the latest registered version of the related Package that has links to the

selected Package.
GUID Displays the Global Unique Identifier of the related Package.

Find in Project Browser Right-click on the "Package' line and select this option to see if the Package also
exists in your model and, if it does, to highlight it in the Project Browser.

Notes

e If one Package depends on another, and that second Package itself depends on another Package, both the second and
third Packages are shown in the 'Dependency’ tab
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e The 'Dependency’ tab will be empty for a 'Learning Center Library', 'Reference Data Library' and 'Source Code
Library' type Storage
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Package Technologies

It is possible that the asset Package in the Registry is associated with one or more Technologies, especially if the Package
comes from a model developed as an extension or customization of the UML. You can check whether an asset Package
has any associated Technologies, and what they are, by viewing the 'Technology' tab of the Reusable Asset Service
view.

Access

Open the 'Reusable Asset Service' window using one of the methods outlined below.

Select a package, then click on the 'Technology' tab, to display a list of Technologies required to support the selected
package.

Ribbon Publish > Model Exchange > Reusable Assets

Menu Tools > Reusable Asset Service

Review Technologies

Field/Option Detail
Name Displays the name of the Technology as recorded in the Registry.
Version Displays the required version of the Technology to support the asset Package,

available through the Registry.
ID Displays the unique identifier of the Technology.

Type Identifies whether the Technology is system-supplied and built in to Enterprise
Architect (such as BPMN 2.0 or ArcGIS), or user-defined.

A user-defined technology can be introduced from an external source or developed
by a user within the system.

Registry Status Indicates whether the Technology file is:
e Available - the Technology file is registered in the current Storage, or

e Unavailable:
- The Technology file is not registered in the Storage, or
- The Technology is a built-in Technology and is already integrated with
your system, or must
be purchased under license, or
- The Technology is available from a URL and can be downloaded from that
URL

Import Technology If your local system does not have one of the Available Technologies, you can
quickly import it from the Registry.

1. Right-click on the Technology name and select Import Technology.

2. A prompt displays for you to confirm the import to your system; click on the
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Yes button.

3. A message displays to confirm that the Technology has been imported; click on
the OK button.

You might have to restart Enterprise Architect to activate the Technology.

Other than the remote Technologies, you cannot import a Technology flagged as
Unavailable. You can import a remote Technology from its URL site.

Notes

e  You can also import Available Technologies from the registry as part of the process of importing the asset Package

e Ifthe Storage is password protected, a prompt to enter your password displays (this can be a Read-Only or a
Complete Access password) after you confirm that you want to import the Technology; you cannot import the
Technology without this password

e The 'Technology' tab will be empty for a 'Learning Center Library', 'Reference Data Library' and 'Source Code
Library' type Storage
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Storage Files

The 'Storage Files' tab of the Reusable Asset Service view simply lists the files that have been uploaded to the specified
Storage. The files can be of any type, uploaded from any directory on any system connected to the registry. Typically
they would be document or graphics files that provide standards, guidelines or design information on a model structure.
The tab displays the file name and extension, and a comment on the nature or purpose of the file.

Files held in the Registry are compressed, so to view the contents you download them onto your local system.

Access

Open the 'Reusable Asset Service' window using one of the methods outlined below.

Select a package, then click on the 'Storage Files' tab, to display a list of files associated with the selected package, that
are available for download.

Ribbon Publish > Model Exchange > Reusable Assets

Menu Tools > Reusable Asset Service

Review files in Draft/Complete type Storage

On the 'Storage Files' tab, check the 'Comments' field against each file that interests you.

To view the contents of a file, right-click on the file name and select the 'Import From Registry' option. The 'Save As'
browser displays, through which you select the directory into which to copy the file.

Click on the Open button. The file is copied into the selected location, from which you can open it.

Review files in Learning Center/Reference Data/Source Code Library type Storage

On the 'Storage Files' tab, check the 'Comments' field against each file that interests you.

To import and install a Library file, right-click on the Library file and select the 'Tmport From Registry' option.
Depending on the Storage type, one of the following dialogs will appear :

e 'Download Libraries' dialog for a 'Learning Center' type Storage
e 'Tmport Reference Data' dialog for a 'Reference Data Library' type Storage
e 'Save As' dialog for a 'Source Code Library' type Storage

'Learning Center Library', 'Reference Data Library' and 'Source Code Library' type Storage will not contain any Assets.
So clicking :

e 'Tmport' button in the Registry Browser will import and install Library file from the Storage
e 'Delete’ button in the Registry Browser will delete all Library files in the Storage

Notes

e If the Storage is password-protected, the system prompts you to enter a password before you begin importing a file
from the Storage; in this case you require either a Read-Only or Complete Access password
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Compare an Asset to the Model

If you are developing a Package in your model against a standard structure, or using common elements from the
Reusable Asset Service, you can check that your model conforms to the standard or incorporates any changes to the
common elements, by performing a comparison between the asset Package and your model.

Access

Open the 'Reusable Asset Service' window using one of the methods outlined below.

Select a package, then right-click on the package and choose 'Compare with Package in Model'.
Ribbon Publish > Model Exchange > Reusable Assets

Menu Tools > Reusable Asset Service

Compare Asset Package and Model

A prompt displays for you to confirm the comparison. Click on the Yes button.

The Baseline Comparison view displays, showing the element hierarchy in which differences have been detected
between the Package in the model and the asset Package in the Registry (as the Baseline).

All facilities of the standard Baseline Comparison are available, including the ability to 'roll back' differences so that the
element or Package in the model matches the Registry.

Notes

e If the Storage is password-protected, the system prompts you to enter a password before you begin comparing
information in the Storage and in the model; in this case you require either a Read-Only or a Complete Access
password
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Import an Asset into the Model

The Reusable Asset Service provides common or standard information and data that you can import into your local
model. The unit that you import is a selected version of the Asset Package; you can also, optionally, import:

e Other Packages on which the selected Asset Package depends, and/or
e Available Technologies that support full use of the model structures in the Asset Package

The Asset Package (with, if selected, any needed Packages) is imported into the currently-selected model Package in the
Project Browser, unless the Asset Package already exists anywhere else in the Project. In this case, the system locates
the existing Package and overwrites it with the imported Asset Package.

Access

Open the 'Reusable Asset Service' window, using one of the methods outlined below.
On the 'Registry Browser' tab, either;
e select an Asset Package and click on the Tmport' button, or

e right-click on an Asset package and choose 'Import from Registry'
Ribbon Publish > Model Exchange > Reusable Assets

Menu Tools > Reusable Asset Service

Import Asset Package

Before selecting an Asset Package to import into your model, click on the 'Version' drop-down arrow and select the
appropriate version of the Package to import.

When you select to import an Asset Package into your model, a short menu displays from which you select to import:
e  The Package alone or
e The Package with the Packages on which it is dependent

A prompt then displays for you to confirm the import, and to warn you that if the Package already exists in the model, it
will be overwritten by the import. Click on the Yes button to continue, or the No button to cancel the import.

If the Storage is password protected, after you confirm the import a prompt displays for your Read-Only or
Complete-Access password; enter this and click on the OK button.

The 'Import from Registry' dialog displays, followed by confirmation that the import of the Package or Packages is
complete. Click on the OK button.

If the Package depends on Technologies

If the Technologies associated with an Asset Package are not already on your system and/or enabled in your model,
during the display of the Tmport from Registry' dialog the Tmport Technology From Registry' dialog also displays.
Process this dialog as described.

Field/Option Detail

Name Displays the name of the Technology as recorded in the Registry.

The check box against each name is selected by default. If you want to import one
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technology but not another, de select the checkbox of the technology to ignore.

Version Displays the required version of the Technology to support the Asset Package,
available through the Registry.

Registry Status Indicates whether the Technology file is:
e  Available - the Technology file is registered in the current Storage, or

e Unavailable - for one of these reasons:
- The Technology file is not registered in the Storage, or
- The Technology is a built-in Technology and is already integrated with
your system, or must be purchased under license, or
- The Technology is available from a URL and can be downloaded from that
URL

Model Status Indicates whether the Technology is already in your model and disabled.

(If the Technology is in your model and enabled, there is no need to import it and it
is not listed in the dialog.)

OK Click on this button to import and/or enable the selected Technology or
Technologies in your system.

A status message displays to indicate that the Package and Technologies have been
imported and the Technologies enabled. You might have to restart Enterprise
Architect for the Technologies to take full effect.

Click on the OK button to clear the message.

In the Project Browser, the Package has been added to the model with (if selected)
the Packages on which it is dependent.

Import Library

The Reusable Asset Service provides ability to store Library files, that you can import into your local model. The type
of Library file available in a Storage will depend on the Storage type. When a Library from Learning Center Library
storage is imported and installed, it will be available for use on all Enterprise Models in this system. When a Library
from Reference Data Library storage is imported, it will be installed into the current model. When a Library from Source
Code Library storage is imported, it will be saved in the specified location in the file system.

Library from Learning Center Library storage :

e click on the Tmport' button to open the 'Download Libraries' dialog, with all the Library files in this storage checked
in the 'Download Libraries' dialog, or

e  right-click on a Library file in the 'Storage Files' tab and choose Tmport from Registry' option to open the 'Download
Libraries' dialog with that particular Library file checked in the 'Download Libraries' dialog

Library from Reference Data Library storage :

e click on the 'Tmport' button to open the Tmport Reference Data' dialog, with all the reference data in that particular
Library file selected in the 'Import Reference Data' dialog, or

e right-click on a Library file in the 'Storage Files' tab and choose Tmport from Registry' option to open the 'Tmport
Reference Data' dialog, with all the reference data in that particular Library file selected in the 'Import Reference
Data' dialog

Library from Source Code Library storage :

e click on the 'Tmport' button to open the 'Save As' dialog to select a location in the file system to save the imported
Library to, or

e right-click on a Library file in the 'Storage Files' tab and choose 'Tmport from Registry' option to open the 'Save As'
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dialog to select a location in the file system to save the imported Library to

If the Storage is password protected, a prompt for you to enter a password displays for your Read-Only or
Complete-Access password; enter this and click on the OK button.

Notes
e You can also import Technologies separately from the Package that is dependent on them, using the Technology Tab

of the Reusable Asset Service view

e 'Learning Center Library', 'Reference Data Library' and 'Source Code Library' type Storage will not contain any
Asset Packages
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Set Up Registry Password

As a System Administrator, you can password-protect the Registry server to prevent users from modifying the Registry;
that is, restrict users from creating, modifying and deleting Storages. Once you have set password protection, only those
users who have a valid Administrator password can modify the Registry.

You can also change the password at regular intervals, for added security.

Access
Ribbon Publish > Model Exchange > Reusable Assets : Set Administrator Password
Menu Tools | Reusable Asset Service : Set Administrator Password

Set the Administrator Password

Field/Option Detail

Enter old password Disabled if no password exists for the Registry server.

If the server has a current password, type it in to this field.

New password Type in the new Administrator password.

Retype new Type in the new Administrator password, for confirmation.

OK Click on this button to set the password and close the dialog.

Cancel Click on this button to abort the changes and close the dialog.
Notes

e To remove password protection from the Registry server, complete the 'Enter old password' field but leave the 'New
password' and 'Retype new' fields blank

e [fa Storage has a Complete Access password, then you can use either the Administrator password or the Complete
Access password to modify the Storage
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Set Up the Asset Service

The process of setting up assets and files in the Reusable Asset Service has a number of simple stages, typically:
e Identify the Registry

e  Create the Storages, including copying an existing Storage as template for a new one

e  Set password protection on each Storage

e Register the Asset Packages and Storage Files, and update them as necessary

Access
Ribbon Publish > Model Exchange > Reusable Assets
Menu Tools | Reusable Asset Service

Identify Registry

The Registry server holds the Storages of the Reusable Asset Service. It will have been previously configured by your
system administrator, to be accessed through a Cloud Connection. Your system administrator will provide the connection
details for you to use.

In the Reusable Asset Service view, click on the D button to the right of the 'Registry' field. The 'Cloud Connection'
dialog displays.

Using the information provided by your administrator, type in the server name, URL and the name of the model hosting
the registry data. If advised by your administrator, also type in the user name and password for the server.

Click on the OK button; the 'Registry' field now shows the server name.

Create Storages

A Storage is a container within the Registry, holding related assets and files. There can be several Storages in the
Registry, to support the different areas of work or purposes that your organization might define.

Step Action

1 o
Click on the ﬁ icon in the Reusable Asset Service toolbar.

2 If necessary, enter the Administration password that prevents update access to the Registry. Click on the
OK button.
The 'New Storage' dialog displays.

3 In the 'Name' field, type a name that indicates the purpose or content of the Storage.

4 In the 'Type' field, select:

e 'Draft' if you intend to make significant changes to the content of the Storage, such as populating it
with assets and/or files; you can overwrite existing Packages or files in a Draft Storage
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e 'Complete' if the Storage is ready for use; you cannot overwrite any Packages or files in a Complete
Storage, although you can delete Packages and files and add new ones

e 'Learning Center Library' if the Storage should contain only Enterprise Architect Learning Center
Library files; this Storage type can be populated only with Library files and not with Asset Packages;
you can overwrite existing Library files in a Learning Center Library storage

e 'Reference Data Library' if the Storage should contain only Enterprise Architect Reference Data
Library files; this Storage type can be populated only with Library files and not with Asset Packages;
you can overwrite existing Library files in a Reference Data Library storage

e 'Source Code Library' if the Storage should contain only Source Code Library files; this Storage type
can be populated only with Library files and not with Asset Packages; you can overwrite existing
Library files in a Source Code Library storage

You can modify a Storage at a later time, and change this setting.

5 If you want to set Storage Access Passwords on this Storage, click on the check box against one or both
password types, and provide and confirm the Complete Access and/or Read-Only Access passwords.

6 Click on the OK button.

A prompt displays for you to confirm the creation of the Storage, with the type of access you have set on
the Storage.

7 Click on the Yes button.
A confirmation message displays; click on the OK button.

The name of the new Storage displays in the 'Storage' field.

Password Protection

The Registry can be protected by a Registry password, so that only the Administrator can create and modify storages. If
no Registry password is set, a second level of password protection can be applied.

The owner of a Storage can apply password protection to restrict users in processing and modifying the contents of the
Storage either intentionally or unintentionally. Password protection can be applied at two levels:

e Complete Access - users enter their password and can modify or delete the Storage itself, and within the Storage can
register, update and delete Packages and files in the Registry, view Packages and import assets into their models

e Read-Only Access - users enter their password and can import assets into their models
You set the Complete Access password before you set the Read-Only Access password.

If password protection is set and a user has no password, they can only view the contents of the Storage. If no password
protection is set, all users can freely access and modify the Storage and its contents.

You set the passwords on each Storage as you create that Storage, using the 'New Storage' dialog. Once the Storage has
been created, you can change or remove an existing password using the 'Modify Storage Access' dialog, but you cannot
add a password.

If a Storage is password protected, the system displays a prompt for the password when the user begins to:
e  Change or delete a password on the Storage

o Copy the Storage to create a new Storage

e Delete the Storage

e Register a Package or file in the Storage

e Import a Package, file or Technology from the Storage

e Delete a Package or file from the Storage

e Compare an Asset Package with a Package in the model

(c) Sparx Systems 2015 - 2016 Page 161 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

The system displays the password prompt when any of those operations is performed for the first time after the user:
e  Connects to a Registry

e Reloads the Registry Browser

e Selects a Storage in the 'Storage' field in the Reusable Asset Services view

If the user enters the correct password and therefore establishes their credentials, the system does not display a password
prompt again for any valid operation that user performs until they:

e Select a different Storage in the 'Storage' field in the Reusable Asset Services view or

e Reload the Registry Browser from the Registry

Register Assets and Files

Whilst a Storage exists and, if the Storage is under password protection, you have the Complete Access password, you
can register Packages from a model and files from your system as assets in that Storage. If the Asset Package was
developed using one or more MDG Technologies, you can optionally register those technologies in the Storage as well.

See the Register New Assets Help topic.

Copy Storages

It is possible to copy a Storage as the basis for creating another Storage, for example if you want to use the same set of
assets in the context of larger set for a different department, work area or development phase.

Note: It is not possible to change the Type of a 'Learning Center Library', 'Reference Data Library' and 'Source Code
Library' type Storage, nor is it possible to change a Draft or Complete type Storage into a 'Learning Center Library',
'Reference Data Library' or 'Source Code Library' type Storage

Step Action

1 In the 'Storage' field, select the Storage to be copied.

Click on the & icon in the Reusable Asset Service toolbar.

3 If necessary, enter the Administrator password or your Complete Access password and click on the OK
button.

The 'Save Storage As' dialog displays.
4 In the 'Name' field, type a name that indicates the purpose or content of the new Storage.

5 In the Type field, select:

e Draft if you intend to make significant changes to the content of the Storage, such as populating it
with assets and/or files; you can overwrite existing Packages or files in a Draft Storage

e Complete if the Storage is ready for use; you cannot overwrite any Packages or files in a Complete
Storage, although you can delete Packages and files and add new ones

You can modify a Storage at a later time, and change this setting.

6 If you want to set Storage Access Passwords on this Storage, click on the check box against one or both
password types, and provide and confirm the Complete Access and/or Read-Only Access passwords.

7 Click on the OK button.

A prompt displays for you to confirm the creation of the Storage, with the type of access you have set on
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the Storage.

8 Click on the Yes button.
A confirmation message displays; click on the OK button.

The name of the new Storage displays in the 'Storage' field.

Change Storage Details

After you have set up a Storage, you can update it at a later stage to:

e  Change the status, or Type,

e  Change one or both of the existing Complete Access and Read-Only Access passwords

e Delete one or both of the passwords

It is not possible to add a password where one has not previously been set.

You cannot change or delete passwords unless you have the Complete Access password yourself.

Note: It is not possible to change the Type of a 'Learning Center Library', 'Reference Data Library' and 'Source Code
Library' type Storage, nor is it possible to change a Draft or Complete type Storage into a 'Learning Center Library',
'Reference Data Library' or 'Source Code Library' type Storage

Step Action

1 On the Reusable Asset Service view, in the 'Storage' field click on the drop-down arrow and select the
Storage to update.
2 Et

Click on the L= icon in the Reusable Asset Service view toolbar.

3 If necessary, enter the Administrator password or your Complete Access password and click on the OK
button.

The '"Modify Storage Access' dialog displays.

4 In the 'Type' field, click on the drop-down arrow and select:

e 'Complete' if the Storage has now been set up and is ready for use; you cannot overwrite any
Packages or files in the Storage, although you can delete them and add new Packages and files

e 'Draft' if you intend to make significant changes to the content of the Storage; you can overwrite
existing Packages or files

5 The 'Action’ field defaults to 'None', to indicate no changes to the passwords. If you are changing or
deleting the passwords, click on the drop-down field and select:

e Change Password to enable both password type fields ready for editing
e Remove Storage Access Password to simply delete the Complete Access password altogether

e Remove Read-Only Access Password to simply delete the Read-Only Access password altogether

6 If you have selected the 'Change Password' option, select the appropriate password checkbox or both
checkboxes, and type in the new password(s). Re-type the password(s) in the 'Confirm Password' field(s).

7 Click on the OK button to save your changes and close the 'Modify Storage Access' dialog.
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Delete a Storage

If a Storage has been created by mistake, or is no longer necessary in the Registry, you can delete it and its entire
contents of Package and files in one action.

Step Action

1 On the Reusable Asset Service view, in the 'Storage' field click on the drop-down arrow and select the
Storage to delete.

2
Click on the X

A prompt displays to confirm the deletion.

icon in the Reusable Asset Service view toolbar.

3 Click on the Yes button.

If necessary, enter the Adminstrator password or your Complete Access password and click on the OK
button.

A message displays to confirm that the Storage has been deleted.

4 Click on the OK button to clear the message.

The Storage and its contents have been cleared from the Registry.
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Register New Assets

After you have set up your Draft/Complete Storages in the Reusable Asset Service Registry, you can register assets in
them. The assets include:

e Packages of modeling structures, held in the Project Browser of your model; these Packages can include diagrams
and subordinate Packages

e Any Packages containing model components on which the primary Asset Packages depend

e Any MDG Technologies that you used in developing the Asset Packages, and that you decide to register with the
Packages

e Any text or graphics files you want to make available to your corporate community; these files are compressed
before being added to the Storage

You register the first three items together. You can register files in the Storage during that same process, or separately.

You can register separate versions of the same Package. If you register a Package that already exists in the Registry
under the same version reference, and the Storage has Draft status, the existing version is overwritten. If you register the
same Package with a different version number or reference, it is registered separately and users can access both versions
of the Package from the Registry.

'Learning Center Library', 'Reference Data Library' and 'Source Code Library' type Storages cannot contain packages of
modeling structures - they can contain only Library files, which will appear in the 'Storage Files' tab. A Library file is :

e aZipped file containing Enterprise Architect specific Learning Center files for 'Learning Center Library' Storage
type

e an XML file containing Enterprise Architect specific reference data XML file for 'Reference Data Library' Storage
type

e aZipped file containing source code files for 'Source Code Library' Storage type

Once registered, the Library file will be available in the 'Storage Files' tab of the Reusable Asset Service view.

Access
Ribbon Publish > Model Exchange > Reusable Assets
Menu Tools | Reusable Asset Service

Register Package as Asset

Step Action

1 In the Reusable Asset Service view, select the appropriate Registry and Storage.
2 In the Project Browser for your model, click on the Package to register as an Asset.
3 On the 'Registry Browser' tab, click on the Register button.

If the Storage is password protected, a prompt displays for your Complete Access password. Enter this
and click on the OK button.

4 The 'Register Package(s)' dialog displays, showing the:
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e Name and type of the Storage
e Name and status of the selected Package (the status at this point being 'Pending')

e The name, GUID and current version of the selected Package; you can type a different version
number or text string if necessary

If there is a version of the Package already in the Registry, and the Storage has 'Draft' status, you can
either:

e  Overwrite the registered Package with an update of that version, or

e  Add the updated Package as another Asset under a different version number; in this case, the
'Packages to Register' panel shows the version number, registration date and comments on the latest
version of the Asset Package

You cannot overwrite an existing Package if the Storage has 'Complete' status. In this case, add the
Package under a different version number.

5 In the 'Comments' field type a short comment and, in the 'Notes' field, a longer explanation of the Package
being registered.

6 Click on the Check Dependency button and resolve the dependencies of the Package.
At the end of this process, the selected Package has the status Ready (for registration).

7 You can, at this point, also register files as assets of the Storage. See Step 4 of the Register File as Asset
procedure.

However, if you prefer you can follow the complete procedure separate from registering Packages.

8 Click on the Register button.
A prompt displays to confirm registering the Package. Click on the Yes button.

If the same version of the selected Package already exists in the Registry (if the Storage is a Draft) a
prompt displays to confirm overwriting it. Click on the Yes button.

A progress dialog displays. If the Package does not have any associated MDG Technologies, a message
displays confirming that Package registration is complete. Go to step 10.

9 If the Package has one or more associated MDG Technologies, the 'Register MDG Technology' dialog
displays, listing the Technologies and prompting you to register (OK) or ignore all of them.

If you want to register some Technologies but not others, click on those you do not want to register, and
click on the Remove button for each one in turn.

Click on the OK button or Ignore button.
A message displays confirming that Package and Technology registration is complete.
Notes:

e Ifaremote Technology is removed from registration (that is, the Technology is not registered along
with the Package), the registered Package will refer to this Technology at its URL
When importing the Package from Registry, the system will import this remote Technology from its
URL (if the remote Technology is not already available in the importing model)

e [faremote Technology is registered with the Package being registered, the system will store a copy
of the Technology file in the Registry
When importing the Package from Registry, the system will import the Technology stored in the
Registry and will not import it from its URL (if the remote Technology is not already available in the
importing model)

10 Click on the OK button.

The 'Registry Browser' tab is updated with the newly-added details of the Package and any dependent
Packages. You can review the details on the tabs on the lower half of the Reusable Asset Server view.
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Register File as Asset

Step Action

1 In the Reusable Asset Service view, select the appropriate Registry and Storage.

2 On the 'Registry Browser' tab, click on the Register button.

If the Storage is password-protected, a prompt displays for your Complete Access password. Enter this
and click on the OK button.

The 'Register Package(s)' dialog displays.

3 If any Packages are listed in the 'Packages to Register' panel, and you do not want to re-register them,
clear the checkbox against each Package name.

4 Click on the Additional Files button.
The 'Select Additional Files' dialog displays.

5 Click on the Add button.

A 'Select' screen displays, on which you browse for and click on the required file. You can only select one
file at a time on this browser.

6 Click on the Open button.
The 'Add Comment' dialog displays.

7 Type a brief comment on the nature or purpose of the file in the Registry, and click on the OK button.

Focus returns to the 'Select Additional Files' dialog, which now lists the selected file.

8 Repeat steps 5-7 for each Asset file to register.
When you have finished, click on the OK button.
The 'Register Package(s)' dialog redisplays.

9 Click on the Register button.

A prompt displays to confirm that you want to register the files.
10 Click on the Yes button.
A 'Progress' dialog displays while the files are registered, followed by a message confirming that the

(Package and) File registration is complete.

11 Click on the OK button to clear the message, and to return focus to the Reusable Asset Service view.

You can review the files on the 'Storage Files' tab in the lower half of the view.

Register Learning Center Library

Step Action
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1 In the Reusable Asset Service view, select the appropriate Registry and 'Learning Center Library'
Storage.
2 On the 'Registry Browser' tab, click on the Register button.

If the Storage is password protected, a prompt displays for your Complete Access password. Enter this
and click on the OK button.

3 The 'Register Learning Center Library' dialog displays.

Select the Library file by pressing the E] button next to the 'File' field.

Type in a short comment for the Library being registered in the 'Comments' field.

4 Click on the Register button.
A prompt displays to confirm registering the Library file. Click on the Yes button.

If the same Library file already exists in the Registry a prompt displays to confirm overwriting it. Click on
the Yes button.

A progress dialog displays and a message displays confirming that Library registration is complete.

5 Click on the OK button.

The 'Storage Files' tab in the lower half of the Reusable Asset Server view is updated with the
newly-added Library file.

Register Reference Data Library

Step Action

1 In the Reusable Asset Service view, select the appropriate Registry and 'Reference Data Library' Storage.

2 On the 'Registry Browser' tab, click on the Register button.

If the Storage is password protected, a prompt displays for your Complete Access password. Enter this
and click on the OK button.

3 The 'Register Reference Data Library' dialog displays.

Press the D button next to the 'File' field and select :
e From File System — to select an existing Reference Data XML file from file system

e From Model — to open the 'Export Reference Data' dialog for selecting categories that will be
registered as Reference Data Library once the Register button is clicked and a name is entered in the
Enter Reference Data File Name dialog.

Type in a short comment for the Library being registered in the 'Comments' field.

4 Click on the Register button.
A prompt displays to confirm registering the Library file. Click on the Yes button.

If the same Library file already exists in the Registry a prompt displays to confirm overwriting it. Click on
the Yes button.
A progress dialog displays and a message displays confirming that Library registration is complete.

5 Click on the OK button.
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The 'Storage Files' tab in the lower half of the Reusable Asset Server view is updated with the
newly-added Library file.

Register Source Code Library

Step Action

1 In the Reusable Asset Service view, select the appropriate Registry and 'Source Code Library' Storage.

2 On the 'Registry Browser' tab, click on the Register button.

If the Storage is password protected, a prompt displays for your Complete Access password. Enter this
and click on the OK button.

3 The 'Register Source Code Library' dialog displays.

Select the Library file by pressing the E] button next to the 'File' field.

Type in a short comment for the Library being registered in the 'Comments' field.

4 Click on the Register button.
A prompt displays to confirm registering the Library file. Click on the Yes button.

If the same Library file already exists in the Registry a prompt displays to confirm overwriting it. Click on
the Yes button.

A progress dialog displays and a message displays confirming that Library registration is complete.
5 Click on the OK button.

The 'Storage Files' tab in the lower half of the Reusable Asset Server view is updated with the
newly-added Library file.
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Check Package Dependencies

As you register a Package in the Reusable Asset Service, the system provides a check on whether that Package is
dependent on any external content; that is, whether it links to any modeling component held in Packages other than its
own child Packages. You can perform three types of dependency check:

e Complete, which will consider Package A to be dependent on Package B if Package A contains any element,
attribute, operation, operation parameter, diagram or connector (or their Tagged Values) that references elements in
Package B.

e Normative, which is the same as a Complete Dependency Check except that it will not treat as a dependency for
Package A any element from Package B that is added as a link on a diagram in Package A

e Package Dependency/Import, where only those Packages that are target of a Dependency/Package Import connector
from Package A will be treated as dependent Packages for Package A.

You perform this dependency check as an integral part of the Asset Registration process (specifically, at step 6 of the
Register Package as Asset process). The check automatically identifies, firstly, the Packages directly needed by the Asset
Package, and then any Packages needed by those initial Packages, and so on until the needed Packages are not dependent
on any other.

In practice, such dependency chains are likely to be quite short. If you know that the original Asset Package is dependent
on two other Packages, one of which is subordinate to the other, you can simplify the process further by selecting the
Parent or Ancestor Package first and thus avoiding the extra steps of selecting the two Packages separately.

Access

Open the 'Reusable Asset Service' window, using one of the methods outlined below.

e In the 'Reusable Asset Service' window, click on the 'Register' button.
Ribbon Publish > Model Exchange > Reusable Assets

Menu Tools > Reusable Asset Service

Check Package Dependencies

Step Action

1 Select the appropriate Registry, Storage and version of the model Package to register, and provide any
appropriate comments or notes.

2 Click on the Check Dependency button.

If there are no Packages on which the Asset Package depends, the system sets that Package to 'Ready'. Go
to step 6.

The 'Select Needed Package: <dependent package name>' dialog displays, showing the model hierarchy
containing the Packages needed by the Asset Package. Each needed Package has a selected checkbox
against it.

If you know that a needed Package is a child or grandchild of another needed Package, click on the
checkbox next to the 'higher' Package name so that the child is validated as part of the parent. In this
example, if the Asset Package has dependencies on both External factors and Location, click on the
'External factors' check box to register both dependencies as External factors.
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If the needed Package is already registered in the Registry, it is indicated by a globe icon:

=l Maodel
L @ Internal Factors

In this case, select the 'Use latest version of selected package in Registry (if available)' checkbox to link to
the registered version. For such Packages, no further dependency check is performed and, on the 'Register
Package(s)' dialog, the Package's Status is set to 'Ready’.

3 Click on the OK button.

The 'Register Package(s)' dialog updates to show the initial 'Asset Package status' as 'Ready’, and to list
the needed Packages each with the status of 'Pending'.

4 Click on the Check Dependency button again.

If there are no Packages on which the needed Package depends, the system sets that Package to 'Ready’
and sets the focus on the next Pending Package. If there are no more Pending Packages, go to step 6.

If the needed Package is dependent on other Packages, the 'Select Needed Package: <dependent package
name>' dialog displays again, showing the model hierarchy containing those Packages, each with a
selected checkbox next to it. As in step 2, you can select a 'higher' Package if appropriate.

5 Click on the OK button.

The 'Register Package(s)' dialog updates to show the first needed Package status as 'Ready’, and to list any
further needed Packages with the status of 'Pending.

6 If there are further needed Packages in the chain, repeat step 4. The system automatically identifies them
and lists them for validation as in step 5.

Otherwise the system sets the final needed Package status to Ready and you can continue to register files
and MDG Technologies.

Notes

e A Package with status Pending cannot be registered; only Packages with status Ready can be registered

e Ifyou are certain that there are no parent-child relationships between the needed Packages, you can work through
these steps quickly by just clicking on the Check Dependency and OK buttons alternately until all Packages in the
Package to Register list have the status Ready

e The system does not allow you to register an Asset Package that has dependencies on its own parent or grandparent
Package; such dependencies would cause the Asset Package to be registered twice - by itself and as part of the
parent Package - creating the risk of differences developing between the two instances
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Update an Asset

Over time, you might need to revise the contents of the Registry. Such updates can include:

e Registering additional Asset Packages and files

e Registering a new version of an Asset Package

e Registering a new edition of a Storage file

e Registering new Libraries
e Deleting an Asset Package
e Deleting a Storage file

e Deleting a Library

e  Changing the details of a Storage

e Deleting an entire Storage and the assets and files within it

Access

Ribbon

Menu

Update Tasks

Task

Register new Asset
Packages and Storage files

Register a new version of
an Asset Package

Delete Asset Package from
Storage

(c) Sparx Systems 2015 - 2016

Publish > Model Exchange > Reusable Assets > Registry Browser

Tools | Reusable Asset Service > Registry Browser

Detail

You can add further Asset Packages and files to a Storage at any time.

You register a new version of an Asset Package as if it were a new Asset. In the
'Current Version' field on the 'Register Package(s)' dialog, you enter a different
number or reference to that assigned to the currently-registered asset.

You can overwrite an existing Asset Package under the same version number only
if the Storage has 'Draft' status. If the Storage has 'Complete’ status, you cannot
overwrite the existing Asset Package under the same version number. To replace
the current version, you must delete the Asset from the Storage and register the
Package again.

Click on the Package name in the 'Registry Browser' tab and either:

e  C(Click on the Delete button or

e Right-click and select the 'Delete From Registry' menu option

In either case a short submenu displays, prompting you to select to delete:
e The Asset Package only, or

e The Asset Package and the Packages on which it is directly or indirectly
dependant

When you select the appropriate option, a prompt displays for you to confirm the
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Register a new version of a
Storage File.

Delete Storage Files from
Storage

Register a new Library File

Delete Library Files from
Storage

Change Storage Details

Delete a Storage and its

contents

Refresh Registry Browser
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deletion.

Click on the Yes button. A message displays to confirm that the Package has been
deleted from the Registry, and the name of the Package is removed from the
'Registry Browser' tab.

If the Storage is password-protected, the system prompts you to enter a Complete
Access password before it begins deleting the Package(s).

If any of the registered Packages depend on the Package being deleted, the system
displays the names of these Packages and prompts for confirmation before deleting
each Package.

You register a new version of a Storage file as if it were a new file under a different
file name.

You can overwrite an existing file under the same file name only if the Storage has
'Draft' status. If the Storage has 'Complete' status, you cannot overwrite the existing
file. To replace the current version, you must delete the file from the Storage and
register the file again.

On the 'Storage Files' tab, right-click on the file name and select the 'Delete From
Registry' option. A prompt displays for you to confirm the deletion.

Click on the Yes button. A status message confirms the deletion, the file is
removed from the Registry and the file name is removed from the 'Storage Files'
tab.

If the Storage is password-protected, the system prompts you to enter a Complete
Access password before it begins deleting the file.

You can add further Library files to a Storage at any time.

When you register a Library file, the file name and location will be used as the
unique identifier for the file. You can overwrite this Library file in Registry by
registering a file with the same name and from the same file system location.

To delete all Library files in Storage, click on the Delete button in the 'Registry
Browser' tab.

To delete a particular Library file, right-click on the Library file name in the
'Storage Files' tab and select the 'Delete From Registry' option.

A prompt displays for you to confirm the deletion. Click on the Yes button. A
status message confirms the deletion, the Library file(s) is removed from the
Registry and the Library file(s) name is removed from the 'Storage Files' tab.

If the Storage is password-protected, the system prompts you to enter a Complete
Access password before it begins deleting the Library file.

This task is as documented for setting up the Registry. Note that whilst you can
copy a Storage as a new Storage, you cannot transfer assets directly between
existing Storages.

This task is as documented for setting up the Registry. Note that whilst you can
copy a Storage as a new Storage, you cannot transfer assets directly between
existing Storages.

If there is a possibility that another user has updated the Registry while you have

-
had it open, click on the E¥ icon in the Reusable Asset Service toolbar to refresh
your display from the latest updates to the Registry.
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Change Management

SHE
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As a repository is developed it will become the data store for valuable organizational information assets, and it is
imperative that this data is protected and maintained. Enterprise Architect has sophisticated tools to ensure the
information is protected, including full integration with all the leading Version Control Systems, Baselines that are
snapshots of your model that can be taken at important milestones, and Auditing that can track the finest changes to a
model. A Project Transfer function helps you to make backups of models without involving information technology
personnel. There are also Model Validation and Project Integrity Checkers to ensure the repository is maintained with
a clean bill of health, and a powerful role based Security System to ensure users can collaborate easily.

Facilities
Facility Detail

Version Control of Enterprise Architect Model Version Control helps you to:

Packages e Coordinate sharing of Packages between users, with either read-only access or
update access, ensuring that work on different areas of the model is
coordinated and synchronous rather than conflicting

e Save and retrieve a history of changes to Packages
To use version control in Enterprise Architect, you require a third-party
source-code control application such as:
e Subversion
e CVS
e MS Team Foundation Server (TFS), or
e  Any other version control product that complies with the Microsoft Common
Source Code Control standard
Tracking Changes Enterprise Architect provides two separate but complementary facilities for
tracking changes to data across the project:
e Auditing of model changes
e Baselining and differencing to capture and roll back changes
Project Data Transfer Enterprise Architect enables you to transfer project data between project data

repositories either for:
e Sections of the project (XMI and CSV) or

e The whole project, row by row, table by table (in the Corporate, Business and
Software Engineering, Systems Engineering and Ultimate editions of
Enterprise Architect)
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Version Control

Within Enterprise Architect, you can manage changes to and revisions of your projects by placing individual model
Packages, view nodes or root nodes under version control. Version control provides numerous key facilities, including:

e Saving a history of changes to Packages

e The ability to retrieve previous revisions of Packages

e  Propagating model updates between team members

e Coordinating the sharing of Packages between team members

You apply version control through a third-party source-code control application that manages access to and stores
revisions of the controlled Packages. Once the version control software has been installed and configured, you must
define a Version Control Configuration within your project. You can then use version control to manage changes to the
Packages of your model.

Notes

e  Sparx Systems strongly urge you not to manipulate version controlled Package files outside of Enterprise Architect;
it is possible to leave the Package files in a state that Enterprise Architect cannot recognize

e Database replication should not be combined with version controlled Packages

e If the Packages under version control contain any alternative images and those images are subject to frequent
change, you can set the "Export alternate images' option on the 'Options' dialog to export the images to the version
control repository when you check in the Packages; if the images are not subject to frequent change, do not select
this option and instead use 'Export/Import Reference Data' to manage alternative images
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Introduction

Enterprise Architect's version control integration provides several key facilities, including:
e Saving a history of changes made to your model's Packages

e Retrieving previous revisions of Packages

e  Propagating model updates between team members

e Coordinating the sharing of Packages between team members

There are a number of factors to consider when setting up and using version control in your model development.

Factors to consider

Factor Detail
System Requirements and You apply version control through a third-party source-code control application
Configuration that manages access to and stores revisions of the controlled Packages.

Typically the configuration consists of:
e A server component that manages a version control repository, and

e Client components on the workstations, that manage local working copies of
controlled files

Enterprise Architect uses the client component to communicate with the server. A
version control client must be installed on every machine where you run Enterprise
Architect and want to access your version control system.

Version Control Usage There are two main ways in which projects can be deployed:
e  Centralized Shared Model
e Distributed Private Models

Version control is employed in the same way for both scenarios; however, when
using Private Model deployment you have the additional facility of propagating
model updates throughout the team.

Version Control can also be used to share standard Packages between different
projects.

Team Deployment Consider the process of setting up a version control environment and applying
version control to a project to be accessed by a number of users.

Version Control Basics Enterprise Architect enforces serialized editing of version controlled Packages,
using the lock-modify-unlock mode of operation.

Applying Version Control Using version control consists of placing individual model Packages under version
to Models control, rather than version controlling the project as a whole.

Version Control and To share changes in reference data between users in a version-controlled project
Project Reference Data deployed as multiple private models, you periodically export the reference data

from the model where the changes were made, and import it into the other models
maintained by the team.

Offline Version Control You can prevent the system from attempting to make any version control

connections by choosing to Work Offline before loading a model.

If Enterprise Architect is unable to connect a Version Control Configuration for

(c) Sparx Systems 2015 - 2016 Page 177 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

any reason, it displays warning messages to notify you and provides 'offline'
version control functionality for all Packages associated with the failed connection.

Notes

e  Packages under version control are identified in the Project Browser by icons that indicate the current status of the
Package
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Version Control Usage

The version control facility can be used in many different ways, although these roughly fall into one of four types of use
as discussed here.

Usage

Type Details

Single Shared model Users share a model stored in a central project file or DBMS repository. In this
configuration you can view changes to other users' Packages without explicitly
having to check them out, by simply refreshing your view of the model.

Version control is used to:
e Archive successive versions of your work to date
e  Maintain Package revision history

e Recover from unwanted changes or accidental deletions, through an 'undo’
facility

e Regulate access to Packages

Multiple Private models One model is created by a single user who configures it for version control. The
model file is then distributed to other users, with each user storing their own private
copy of the model.

Version control is used to:

e  Propagate changes to the model, throughout the team
e Archive successive versions of your work to date

e Maintain Package revision history

e Recover from unwanted changes or accidental deletions, through an 'undo’
facility

e Regulate access to Packages

Shared Packages Individual users create separate models but share one or more Packages:

e  Users share Packages through version control
Standard Packages A company might have a standard set of read-only Packages that are broadly

shared:

e Individual users retrieve Packages with the Get Package menu option
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Version Control of Model Data

When applying version control in Enterprise Architect, you place individual model Packages under version control, and
not the project as a whole.

All Enterprise Architect models are stored in databases - even the .eap file is an MS Jet database. In simple terms, the
project file is a single entity of binary data. Being binary data, the project file would require the use of the
lock-modify-unlock model of version control, which would mean that only a single user at a time could work on any
given (version controlled) model. Therefore, it is not practical to apply version control to the database (.eap file) as a
whole; this can also create problems for you:

e Most version control systems mark their controlled files as read only, unless they are specifically checked-out to you

e The .cap file is an MS Jet database, and Enterprise Architect must be able to open this file for read/write access
when you load your model; the system displays an error message and fails to load the model if it is read-only

Version Controlling Packages in your Model

To overcome the limitations described above, Enterprise Architect exports discrete units of the model - the Packages - as
XMI Package files, and it is these XMI files, not the project file, that are placed under version control. The XMI file
format used by Enterprise Architect dictates that they too be treated as binary files - therefore it is not possible to merge
the XMI files either; however, by splitting the model into much smaller parts, many users can work on separate parts of
the model simultaneously.

Version Controlled Nested Packages

Version controlled nested Packages result in much smaller XMI files being exported, as the parent Packages' XMI files
do not contain any content for the version controlled child Packages.

Version control of nested Packages, together with a model structure of small individual Packages, provides greater scope
for multiple users to work concurrently, as individual users are locking much smaller parts of the model.
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Version Control and Reference Data

Reference data is data that is used across a model or project; it is not Package-specific. Version control operates at
Package level, and therefore does not capture changes in reference data. Where version control is used in a multiple
private model set up, changes in reference data are not brought into the model when Packages are updated from version
control.

In a Shared Model environment, all users are accessing the same project reference data. Changes in reference data can be
shared between users in a version-controlled project deployed as multiple private models, by periodically exporting the
reference data from the model where the changes were made, and importing it into the other models maintained by the
team.

Reference data is exported and imported as an XMI file, which contains whatever types of reference data you want to
transfer. You can place your project reference data under version control by exporting the data as an XMI file and apply
version control to that file using your version control software external to Enterprise Architect.
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Version Control Basics

Enterprise Architect implements version control of your model by exporting Package data from the project database to
XMI Package files, which are placed under version control in the source-code control application. The XMI file format
cannot be merged in the same way as ordinary text files can be merged, which is why Enterprise Architect must enforce
serialized editing of version controlled Packages, as discussed here.

The Lock-Modify-Unlock Solution

Many version control systems use a lock-modify-unlock model to address the problem of different authors in a shared
source overwriting each other's work. In this model, the version control repository allows only one person to change a
file at a time, and access is managed using locks.

Harry must lock a file before he can begin making changes to it. If Harry has locked a file, Sally cannot also lock it, and
therefore cannot make any changes to that file. All she can do is read the file, and wait for Harry to finish his changes
and release the lock. After Harry unlocks the file, Sally can take her turn in locking and editing the file.

The Copy-Modify-Merge Solution

Subversion, CVS and a number of other version control systems use a copy-modify-merge model as an alternative to
locking. In this model, each user's client contacts the project repository and creates a personal working copy - a local
reflection of the repository's files and directories. Users then work simultaneously and independently, modifying their
private copies. In due course, the private copies are merged together into a new, final version. The version control system
often assists with the merging, but ultimately a person is responsible for making it happen correctly.

When Locking is Necessary

While the lock-modify-unlock model is generally considered a hindrance to collaboration, there are still times when
locking is necessary.

The copy-modify-merge model is based on the assumption that files are contextually merge-able: that is, that the files in
the repository are line-based text files (such as program source code). However, for files with binary formats, such as
artwork or sound, it is often impossible to merge conflicting changes. In these situations, it really is necessary for users to
take strict turns in changing the file. Without serialized access, some users end up wasting time on changes that are
ultimately overwritten.
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Add Connectors To Locked Elements

Generally, when working in a diagram containing locked elements, you cannot add a connector to a locked element.
However, this depends on the lock status of the source and target elements (or more precisely, the lock status of the
parent Packages of the source and target elements, when the source and target element are held in different Packages).
There are scenarios in which a connector can be created on a locked element.

Lock Scenarios

Element Status Add Connectors

Source unlocked, target Yes, any kind of connector can be added
unlocked
Source unlocked, target Yes, except for Composition connectors
locked
Source locked, target No, except for Composition connectors
unlocked
Source locked, target No, prohibited for all connectors
locked

Notes

e A connector can be added if its source is unlocked - you are modifying what the source can see

e The exception is Composition connectors, where the target (the parent) must be unlocked - you are modifying the
parent by adding children
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Applying Version Control in a Team Environment

The process of setting up a version control environment and applying version control to a project to be accessed by a
number of users is summarized here.

Version Control - Process Overview

Step Action

1 Install your version control product.

2 Create a version control repository.

3 Create a version control project to be used with your Enterprise Architect project.

4 Check-out a working copy of the version control project (a module, project or folder within the version

control system) into a local folder.

You must do this for every team member that is accessing the version controlled Packages, whether you
are using a single shared model or each team member stores his own private copy of the model.

5 Within Enterprise Architect, define a version control configuration to provide access to the working copy
files.

The name of the version control configuration must be the same across all machines throughout a team.
That is, all version control access to a given Package must be through version control configurations with
the same name, across all models and all users.

The easiest way to perform this step, (throughout the team), is to have one user set up version control on
the model and then share that model with the rest of the team.

e In Shared Model deployment, all users connect to a single instance of the model database, so the
model is shared automatically

e In Private Model deployment, it is easiest to distribute copies of the original model (after version
control has been set up) to all other members of the team

Whenever you open a model (Private or Shared) that uses a version control configuration that is not yet
defined on your workstation, a prompt displays to complete the definition for that configuration. This
typically means specifying the local working copy directory and maybe choosing the version control
project associated with this Enterprise Architect project.

Once this has been done, the version controlled Packages that already exist in the model are ready for use.

6 Configure Packages within the Enterprise Architect model for version control. That is, apply version
control to individual Packages.

7 Check-out and check-in Packages as required.

Notes

e [tis possible to use multiple version control configurations within the same model; different Packages can still use
different version control configurations within the model, as long as any given Package is always accessed via the
same version control configuration
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Version Control Nested Packages

When you save a Package to the version control system, only stub information is exported for any nested Packages. This
protects information in a nested Package from being inadvertently over-written by a top level Package.

Operations on Nested Packages

Operation Detail

Checking Out When you check out a Package, you do not modify or delete nested Packages; only
the top level Package is modified.

As a consequence of this behavior, if you check out or get a version controlled
Package with nested Packages that are not already in your model, you see stubs in
the model for the nested Packages only.

Get All Latest If you select the 'Get All Latest' option from the version control menu, any new
stubs are populated from the version control system.

Importing Models You can populate a large and complex model, by 'getting' only the root Packages,
then using 'Get All Latest' to recursively iterate through the attached and nested
Packages.

This is a powerful and efficient means of managing your project and simplifies
handling very large models, even in a distributed environment.

The 'Import a Model Branch' option combines the steps described above into a
single operation.

Notes

e Itis recommended that, when sharing a version controlled model, you do not mix versions of Enterprise Architect
later than version 4.5 with earlier versions; if this is necessary it is best to go to the 'Version Control Settings'
dialog and deselect the 'Save nested version controlled packages to stubs only' checkbox, setting Enterprise
Architect to the pre-version 4.5 behavior (for the current model only)

(c) Sparx Systems 2015 - 2016 Page 186 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

Project Browser Indicators

Packages under version control are identified in the Project Browser by icons that indicate the current status of the
Package.

Indicators

Icon Indicates that

=] This Package is version controlled and not checked out to you.

You cannot edit the Package (until you check out the Package yourself).

o This Package is version controlled and checked out to you.

You can edit the Package.

i This Package is version controlled, but you checked it out whilst not connected to
the version control server.

You can edit the Package but there could be version conflicts when you check the
Package in again.

i1 This Package is controlled and is represented by an XMI file on disk, but it is not

under version control.

You can edit this Package.

(c) Sparx Systems 2015 - 2016 Page 187 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

Offline Version Control

When loading a model that uses version control, Enterprise Architect normally initializes a connection to the version
control system for each version control configuration defined in the model. If Enterprise Architect is unable to connect a
version control configuration for any reason, it displays warning messages to notify you and provides offline version
control functionality for all Packages associated with the failed connection.

You can prevent Enterprise Architect from starting to make any version control connections, by selecting to work offline
menu before loading your model.

Access
Ribbon Configure > Version Control > Work Offline
Menu Project | Version Control | Work Offline
Working Offline
Concept Discussion

Choosing to Work Offline Selecting to work offline is useful if you know beforehand that Enterprise Architect
cannot connect to your version control system. For example: If you are working on
a laptop computer that is disconnected from your network, on an Enterprise
Architect model that uses a large number of version control configurations, you can
select to work offline before you load the model to avoid all the error messages that
the system would normally display as each version control connection attempt
failed.
You can switch between working offline and working online at any time, either
before or after a model is loaded, by toggling the "Work Offline' menu option.
Enterprise Architect disconnects or reconnects version control (depending on the
connection availability) according to your selection.

Using Version Control Enterprise Architect 'remembers' the status of a model’s version controlled

Whilst Disconnected From Packages. Packages that were checked out to you prior to disconnecting from the

the Version Control Server server are still shown as checked out to you, even though you are no longer
connected to the server. You can still edit these Packages as you normally would.
Packages that were not checked out to you prior to disconnecting from the server
are shown as version controlled and locked. You cannot edit these Packages until
you check them out.

Offline Check Out You can 'check-out' and edit a version controlled Package even when your machine

is disconnected from the version control server. In this example, the colored 'figure
8'icon for DFD indicates that you have checked it out whilst off line.

+ =] MindMapping
+- 48] DFD
+ %8| Logical View
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(The gray 'figure 8' icon shown against Logical View indicates that you have
checked out a version-controlled Package on line.)

You should be aware that the version control system, and therefore other users,
have no way of knowing that you have 'checked-out' a Package whilst offline. It is
not possible to merge changes to an XMI file that result from two users editing the
same Package at the same time. If an offline checkout leads to two people editing
the same Package at the same time, when the changes are brought back online the
first-saved set of changes is lost.

Checking In a Package Once you reconnect your system to the version control server, if the Package you
That Was Checked Out checked out offline is not currently checked out by another user, you can check in
Offline that Package. However, before Enterprise Architect checks in the Package, it

compares the local working copy of the Package file with the latest revision in the
repository. (These Package files remain unchanged in your work area until
Enterprise Architect exports the Package again before checking in.) If the
repository version remains unchanged from when you last updated your local copy,
Enterprise Architect exports and checks in your Package without further prompting.

On the other hand, if the repository now contains a file that has changed since you
last updated your local copy, checking in your Package would overwrite those
changes. Enterprise Architect displays a message warning you of the pending data
loss and giving you the opportunity to abort the check in. At this point, you must
decide whether to discard your own changes, using the Undo Check Out command,
or continue with your check in and overwrite the changes that have been committed
to the repository since you last updated your local copy from the repository.

You can use the File Properties command to determine who checked in the last
changes to this Package. This might help you to discover what changes have been
uploaded and decide whose changes take precedence.

Update Before You Whenever you are connected to the version control server, you are always working

Disconnect with the latest version of a Package. This is because you cannot modify a Package
until you check it out from version control, and checking it out loads the latest
revision from the repository into your model.

This cannot happen when you are disconnected from the version control server.
You are working on whatever versions you have on your machine, dating back to
the last time you updated your local copy of each version controlled Package. So, if
you are planning to work on a model whilst disconnected from version control, it is
a very good idea to make sure that you have the latest versions of all Packages
before you disconnect. The 'Get All Latest' option makes this a simple task.
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Version Control Branching

Currently, Enterprise Architect does not support Version Control Branching.

Work-arounds to achieve similar results might be possible for certain version-control products; contact Sparx Support for
advice.

Contacts
User Type Contact via
Registered users http://www.sparxsystems.com/registered/reg_support.html
Trial users support@sparxsystems.com
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Version Control Product Setup

To control and maintain the different revisions of your project Packages, Enterprise Architect uses third-party version
control products. Once your version control product is installed and a suitable environment has been created, Enterprise
Architect can use that environment to control your project's Packages.

Typically, version control products consist of:
e A server component
e A client component

Enterprise Architect integrates with the version control client components for Subversion, CVS and MS Team
Foundation Server command line clients, as well as for products having API clients that comply with the MS SCCI
specification.

Version Control System Components

Component Detail

Version Control Server The server component maintains the controlled files in their many revisions, in a
central repository.

The server component is usually located on a server machine that is accessible to all
team members who are using version control.

Server Configuration The steps for configuring a version control server are, broadly:
e Install the software
e (Create a repository

e C(Create version control projects (or modules or folders for use with specific
projects)

e  Configure user IDs and passwords

For details on configuring any particular version control server, consult the
appropriate documentation provided with the version control product.

Version Control Client The client component manages the working copies of the controlled files,
submitting files to or retrieving files from the server as required.

A version control client must be installed on every machine on which you run
Enterprise Architect and want to access your version control system.

Client Configuration The steps for configuring a version control client are, broadly:
e Install the software
e (Create a new directory for use as a local working copy folder
e Login to the version control server

e  Associate the working copy folder with its corresponding server repository
folder

For details on setting up a product-specific version control environment for use
with Enterprise Architect, click on the appropriate link in the next column.
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System Requirements

Enterprise Architect is a Windows-based application and requires a Windows-based version control client for integration.
It is independent of the version control server component and the platform on which that runs.

Version Control Product Requirements

Product Detail

Subversion Subversion is free, open source software.

Subversion server components are available to run on a wide range of different
hardware and operating systems.

Enterprise Architect is not affected by your choice of server components, but
requires Subversion's Windows-based command line client for integration.

There are many graphical user interface clients available for use with Subversion,
such as TortoiseSVN; this type of client cannot be used directly for integration with
Enterprise Architect, but can be very useful in preparing a working Subversion
environment for use by Enterprise Architect.

Binary Packages are available for download from:

e  http://subversion.apache.org/packages.html

Subversion documentation is available from:

e  http://svnbook.red-bean.com/nightly/en/index.html

Concurrent Versions CVS is free, open source software.

System (CV8) CVS server components are available to run on a wide range of different hardware

and operating systems.

Enterprise Architect is not affected by your choice of server components, but
requires CVS's Windows-based command line client for integration.

There are many graphical user interface clients available for use with CVS, such as
TortoiseCVS; this type of client cannot be used directly for integration with
Enterprise Architect, but can be very useful in preparing a working CVS
environment for use by Enterprise Architect.

The software is available for download from:

e  http://www.nongnu.org/cvs/

CVS documentation is available from:
e  http://cvsbook.red-bean.com/cvsbook.html

Microsoft Team Enterprise Architect is able to use either the:
Foundation Server e Command line client for TFS, or

e  MS TFS-SCC client

Your choice of client affects how you specify your Version Control Configuration.
MS TFS-SCC clients are available for download from Microsoft's web pages:

e  Visual Studio 2005 Team Foundation Server MSSCCI Provider

e Visual Studio Team System 2008 Team Foundation Server MSSCCI Provider

Common Source Code Any version control product that provides a client that complies with the Microsoft
Control (SCC)-compatible Common Source Code Control standard, version 1.1 or higher, can be integrated
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These products are SCC-compatible and are known to successfully integrate with
Enterprise Architect:

Accurev

ClearCase

MS Visual Source Safe
MS TFS-SCC

MKS Source Integrity
Perforce

Source Offsite
Snapshot CM

Products that do not appear in this list should still integrate successfully with
Enterprise Architect, if there is a client available for that product that complies with

the MS SCC API specification.
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Create a Subversion Environment

You can use Subversion as a version control provider for Enterprise Architect. The first step in doing this is for a
Subversion administrator to install and configure the appropriate software. A number of basic tasks are performed in
creating an operational Subversion environment, and useful tools are available for performing some of these tasks.

Tasks in Creating a Subversion Environment

Task Detail
Install server components Executable files for Subversion can be obtained from the Apache Software
Foundation.

Subversion server components are available to run on a wide range of different
hardware and operating systems; Enterprise Architect is not affected by your choice
of server components.

VisualSVN is a package that can greatly simplify the installation, configuration and
management of your Subversion server.

Create a repository Please consult the official Subversion documentation.

Create Subversion users Please consult the official Subversion documentation.

Create a new repository It is good practice to create a new repository sub-tree in Subversion for each new

sub-tree Enterprise Architect model being added to version control with Subversion. Users
should create a new local working copy from the sub-tree to be used with that
model

TortoiseSVN can greatly simplify the process of creating new repository sub-trees.

Install client components Executable files for Subversion can be obtained from the Apache Software
Foundation.

Create a working copy A working copy folder must exist on each users' machine, for Enterprise Architect

folder to use when exporting and importing the version controlled Package files. It is this

folder that is specified as the Local Project Path, when defining your Version
Control Configurations.

The working copy folder is the 'sandbox' where you modify the controlled files. The
working copy folder is usually associated with a folder that exists within the
version control repository. In Subversion, to create a local working copy you
perform an initial check-out of a folder from the Subversion repository; this
downloads a copy of the folder and its contents, to create your local working copy.

TortoiseSVN can greatly simplify the initial check out of a working copy folder.

Setting up Subversion The process of setting up and using Subversion with Enterprise Architect under

under Wine/CrossOver Wine is almost identical to the process when running natively under Windows,
apart from minor differences in installing the Subversion client and performing the
initial check out of the working copy folder.

Notes
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e  Enterprise Architect relies on exclusive file locking when applying version control to its Packages; file locking was
not introduced into Subversion until version 1.2, therefore Enterprise Architect does not work with Subversion
releases earlier than Subversion 1.2

e  Enterprise Architect can only communicate with the Subversion server using the Subversion command line client
svn.exe
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Create a new Repository Sub-tree

When you set up Subversion as your version control tool, it is good practice to create a new repository sub-tree in
Subversion for each new Enterprise Architect model. The sub-tree can be used to control the Package files for your
model.

Create a new sub-tree in the Subversion Repository

Step Action

1 Use Windows Explorer to create a temporary directory on your PC file system, to be imported into the
Subversion repository as a new repository sub-tree. The directory would have this structure:

2 Open a Windows command prompt, navigate to tempDir and issue the Subversion command import.
For example:
C:\Documents and Settings\user> cd \tempDir
C:\tempDir> svn import . https://host.example.com:8443/repos/

--message "Repository Initialization"

3 On your PC, delete the temporary directory structure (tempDir) and all its contents.

Notes

e  After the import is finished, the original tree is not converted into a Subversion working copy; you should delete the
temporary structure and check out a fresh working copy of the tree

e The process described above can also be performed using TortoiseSVN's Repository Browser, which provides
commands for simply creating new folders directly in the repository

(c) Sparx Systems 2015 - 2016 Page 196 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

Create a Local Working Copy

In order to use Subversion to provide version control of the Packages in a model, you need to prepare a functional SVN
working copy folder that can be accessed through an Enterprise Architect version control configuration within that
model.

Create a Subversion working copy folder

Step Action

1 Choose or create a suitable directory on your system in which to create your Subversion working copy.

2 Open a command prompt window and navigate to the directory you have selected. For example:
C:\> mkdir mySVNWorkSpace
C:\> mkdir mySVNWorkSpace/myEAModelName
C:\> cd mySVNWorkSpace/myEAModelName

3 Perform the initial check out from the Subversion repository, specifying the repository folder and local
working copy folder, as well as your user name and password. For example:

C:\> svn checkout "https://myserver:8443/svn/repos_folder
"C:\mySVNWorkSpace/myEAModelName"

--username myUserName

--password myPassword

(By specifying your Subversion username and password, you ensure that they are correctly cached by
Subversion and available for use by Enterprise Architect.)

If you specify the HTTPS protocol when performing the initial Subversion check out, a prompt displays to
accept a security certificate; in this instance, press the P key to permanently accept the certificate.

The nominated local folder is configured as a Subversion working copy folder.

Any files already existing in the repository folder are downloaded to the working copy folder as working
copy files.

4 Verify that your Subversion environment functions correctly.

Notes

e [tis important that Subversion caches your username and password, so that it never has to prompt for user input; a
check-out operation might not request authentication, and if it does not you should perform an action that does
request authentication, such as adding and committing a dummy test file

e The process described above can also be performed using TortoiseSVN's Checkout command (which provides
options to browse when specifying both your repository folder and your local folder); when prompted for
authentication details by TortoiseSVN, make sure you place a check against the 'Save Authentication Data' option
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Verify the SVN Workspace

After creating the Subversion local working copy to hold the working copies of your Package files, you can verify that it
functions correctly before attempting to use it with Enterprise Architect. You need to be able to add files to Subversion,
lock the files and commit changes to those files.

Verify correct operation of a Subversion working copy folder

Step Action

1 Use Windows to open a command prompt window.
2 Select the directory you specified as the working copy, in the Subversion checkout command when
preparing the SVN workspace. For example:
C:\> cd mySVNWorkSpace
3 Create a test file, such as Test.txt, containing the text Subversion Test. For example:

C:\> echo Subversion Test > Test.txt

4 Execute each of these Subversion commands:

svn add Test.txt

svn commit -m"Commit comment" Test.txt

svn update Test.txt

svn lock Test.txt

Use your preferred editor to modify the file and save the changes

svn commit -m"Second commit comment" Test.txt

The commands should execute without any errors and without prompting the user for any extra input.

Notes

e  Your environment must be set up such that you can perform these operations without ever being prompted for user
ID or password; for further information, please see the Caching Client Credentials topic in the official Subversion
documentation
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Subversion Under Wine-Crossover

If you want to set up and use Subversion with Enterprise Architect under Wine, the process is almost identical to the
process for setting up and using the systems under Windows. When running Enterprise Architect under Wine or
CrossOver, you still use a Windows-based Subversion command line client.

There are some minor differences in the way you prepare the Subversion working environment, specifically in the way
you install your Subversion client and the way you check out a working copy folder from the Subversion repository.

System Requirements

Sparx Systems has tested the use of Enterprise Architect with Subversion under Wine 1.2, on Mac OS 10.4 and 10.6.2,
and on Ubuntu 10.04. All tests were passed.

When using Wine 1.2 on the Ubuntu 9.10 platform, Sparx Systems was able to use the svn: and file: protocols to
communicate with the SVN server; but not the https: protocol.

Installing a Subversion Client

Wine is able to install applications from either a Windows .exe file, or a .msi installer file.

Place the installer for your Windows Subversion client in a convenient location on the native file system, then open a
Wine console window from within Enterprise Architect and run the installer from within the Wine console. Your
Subversion installation can then access the same C: drive and folders that Enterprise Architect is accessing.
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Preparing a Subversion Environment Under Wine

Under Wine, you can install Subversion from either a Windows .exe file, or a .msi file. By performing your Subversion
installation and initial check out from a Wine console window opened from within Enterprise Architect, you have access
to the same C: drive and folders that Enterprise Architect is accessing.

Set up Subversion for use with Enterprise Architect, running under Wine

Step Action

1 Start Enterprise Architect.

You do not have to load a project at this point.

2 Select '"Tools | Customize > Tools: —''
A new, blank entry is opened on the 'Tools' tab of the 'Customize' dialog.
3 Define the new menu item entry:
¢ In the newly-opened 'Menu contents' field, type the name "Wine Console'
¢ In the 'Command field, type 'wineconsole'
e In the 'Arguments' field, type 'cmd'
e Leave the 'Initial directory' field blank
4 Click on the Close button.
The 'Customize' dialog closes.
5 Select 'Tools | Wine Console'.
A Wine console window opens.
6 Type 'C:' and press the Enter key.
The Wine console switches to the C: drive.
7 Issue the command to install your Subversion client. For example:
C:\>/Installers/Subversion-client-1.6.12-1.win32.exe
To install from a .msi file, use Wine's msiexec utility. For example:
C:\>msiexec /i "Slik-Subversion-1.6.9-win32.msi"
Installation of the Subversion command line client begins.
8 Create a folder to serve as the working copy folder to be used by Enterprise Architect. For example:
C:\>mkdir C:\VC_workspaces\SVN_workcopy
9 Issue the command to perform the initial checkout from the Subversion repository, specifying the

repository folder, working copy folder, username and password. For example:
C:\>svn checkout "https://myServer:8443/svn/repos_folder"
"C:\VC_workspaces\SVN_workcopy "
"--username myUserName"

"--password myPassword"
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(After specifying your Subversion username and password, they are correctly cached by Subversion and
are available for use by Enterprise Architect.)

If the HTTPS protocol is specified when performing the initial Subversion check out, you are prompted to
accept a security certificate; in this instance, press the P key to permanently accept the certificate.

The nominated local folder is configured as a Subversion working copy folder. Any files already existing
in the repository folder are downloaded to the working copy folder as working copy files.

10 Type 'Exit' and press the Enter key.
The 'Wine console' window closes.

You are now ready to load a project in Enterprise Architect and apply version control to it, following the
normal Windows-based procedures.

Notes

e You should copy the installer for your Windows Subversion client to a convenient location on the native file system,
so that you can easily refer to it from within the Wine console window in step 7 above
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TortoiseSVN

TortoiseSVN is a Windows shell extension for Subversion; it provides icon overlays in Windows Explorer that are useful
as a tool for observing the status of your Subversion controlled files. You can also use it to create your repository
sub-trees and check out local working copies from within Windows Explorer, using simple menu commands.

You can download TortoiseSVN from http://tortoisesvn.net/downloads.html.

Notes

e  Enterprise Architect can only communicate with the Subversion server using the Subversion command line client
svn.exe
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Create a CVS Environment

You can use Concurrent Versions System (CVS) as a version control provider for Enterprise Architect. The first step in
doing this is for a CVS administrator to install and configure the appropriate software. A number of basic tasks are
performed in creating an operational CVS environment, and useful tools are available for performing some of these
tasks.

Tasks in Creating a CVS Environment

Task Detail

Install server components Executable files for CVS can be obtained from March Hare Software.

CVS server components are available to run on a wide range of different hardware
and operating systems; Enterprise Architect is not affected by your choice of server

components.

Create a repository Please consult the official CVS documentation.

Create CVS users Please consult the official CVS documentation.

Create a new repository It is recommended good practice to create a new repository module in CVS for each

module new Enterprise Architect model being added to version control with CVS. Users
should create a new local working copy folder from the module to be used with that
model.

A repository module represents a project, or a set of related files in the repository.

TortoiseCVS can greatly simplify the process of creating new repository sub-trees.

Install client components Executable files for CVS can be obtained from March Hare Software.

Enterprise Architect is a Windows based application - it requires a Windows based
CVS command line client for integration.

Create a working copy A working copy folder must exist on each users' machine, for Enterprise Architect

folder to use when exporting and importing the version controlled Package files. It is this
folder that is specified as the Local Project Path, when defining your Version
Control Configurations.

The working copy folder is the 'sandbox' where you modify the controlled files. The
working copy folder is usually associated with a folder that exists within the
version control repository. In CVS, to create a local working copy you perform an
initial check-out of a folder from the CVS repository; this downloads a copy of the
folder and its contents, to create your local working copy.

TortoiseCVS can greatly simplify the initial check out of a working copy folder.

Setting up CV'S under The process of setting up and using CVS with Enterprise Architect under Wine is
Wine/CrossOver almost identical to the process when running natively under Windows, apart from
minor differences in installing the CVS client and performing the initial checkout of
the working copy folder.
Notes
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e Ifyou do not already use CVS for version control, you should consider using Subversion instead; Subversion's
client-server protocols provide a broader range of possibilities for connecting to remote servers, with easier set up of
secure connections

e TortoiseCVS is a Windows shell extension; Enterprise Architect cannot use TortoiseCVS as its client, it must use
the CVS command line client
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Prepare a CVS Local Workspace

In order to use CVS to provide version control of the Packages in a model, you need to prepare a functional CVS
working copy folder that can be accessed through an Enterprise Architect version control configuration within that
model.

Prepare a CVS Working Copy Folder

Step Action

1 Ask your System Administrator to install CVS and create a remote repository, with a module that you can
use to control your Enterprise Architect Package files.

Your administrator must create a username and password for you before you can make a connection.

2 Select or create a suitable directory to use as your CVS working copy directory.

3 Open a command prompt window and navigate to your CVS working copy directory. For example:
C:\> mkdir myCVSWorkSpace
C:\> c¢d myCVSWorkSpace

4 Log in to the remote CVS repository. For example:

C:\myCVSWorkSpace> cvs -d:pserver:myUserID@ServerName:/reposPath login

Replace myUserID with your CVS username, replace ServerName with the name of your CVS server and
replace reposPath with the path to the repository on the server.

A prompt for a password displays.

5 Enter your password.

You are logged in to the CVS server.

6 Perform the initial checkout of the CVS repository module, into the local working copy directory. For
example:

C:\myCVSWorkSpace> cvs -d:pserver:myUserID@ServerName:/reposPath checkout moduleName
(Replace moduleName with the name of the repository module that you want to check out.)

A subdirectory is created in your current working directory, with the same name as the module being
checked out.

Any files already existing in the repository module are downloaded to the working copy folder as working
copy files.

7 Verify that your CVS environment functions correctly.

Notes

e Much of the process described above can also be performed (more simply) using the TortoiseCVS command Make
New Module
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Verify the CVS Workspace

After creating the CVS local working copy to hold the working copies of your Package files, you can verify that it
functions correctly before attempting to use it with Enterprise Architect. You need to be able to add files to CVS, and

commit changes to those files. You also need to be able to register as an editor of the file and retrieve the list of currently

registered editors.

Verify correct operation of a CVS working copy folder

Step

1

Notes
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Action

Use Windows to open a command prompt window.

Select the directory you specified as the working copy in the cvs checkout command, when preparing the
CVS workspace. For example:

C:\> ¢d myCVSWorkSpace

Create a test file, such as Test.txt, containing the text CVS Test. For example:
C:\> echo CVS Test > Test.txt

Execute these CVS commands:

e cvsadd Test.txt

e cvs commit -m"Commit comment" Test.txt

e cvs update Test.txt

e cvsedit Test.txt

e cvs editors Test.txt

The commands should execute without any errors and without prompting the user for any extra input.

The editors command should produce output that resembles this:
Testl.txt myUserID Tue Aug 9 10:08:43 2009 GMT myComputer
C:\myCVSWorkSpace\moduleName

Take note of the userID that follows the filename.

Enterprise Architect must find and use this user ID when you create your version control configuration.

Your environment must be set up such that you can perform these operations without ever being prompted for input,
such as user ID or password
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TortoiseCVS

TortoiseCVS is a Windows shell extension for CVS; it provides icon overlays in Windows Explorer that are useful as a
tool for observing the status of your CVS controlled files. You can also use it to create your repository modules and
check out local working copies from within Windows Explorer using simple menu commands.

You can download TortoiseCVS from: http://www.tortoisecvs.org.

Notes

e  Enterprise Architect must use the CVS command line client to communicate with the CVS server; it cannot use
TortoiseCVS
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Create a TFS Environment

You can use Microsoft Team Foundation Server (TFS) as a version control provider for Enterprise Architect. The first
step in doing this is for a TFS administrator to install and configure the TFS server and client applications. A number of
basic tasks are performed in creating an operational TFS environment.

Tasks in Creating a TFS Environment

Task Detail
Obtain and install TFS Enterprise Architect uses the TFS command line client to integrate TFS version
control.

The TFS command line client is normally available as part of your Visual Studio
installation.

Choose a TFS project It is good practice to create a new TFS project, or least a new Source Control
Folder within a project, for each Enterprise Architect project being added to version
control with TFS.

If you have a single Enterprise Architect project that contains many different
models (for example, a DBMS hosted project with multiple model root nodes), you
might choose to create a new TFS project for each separate model.

For further information, please consult your TFS product documentation.

Create a TFS workspace A working copy folder must exist on each users' machine, for Enterprise Architect
to use when exporting and importing the version controlled Package files. It is this
folder that is specified as the Local Project Path, when defining your Version
Control Configurations.

The working copy folder is the 'sandbox' where you modify the controlled files. The
working copy folder is usually associated with a folder that exists within the
version control repository. In TFS, the TFS workspace is used to map a local
working folder on your PC to a Source Control Folder within a TFS project.

TFS 2012 and VS 2012 (and later versions) feature a new type of workspace called
'l ocal ' workspaces. Do not attempt to use TFS 'local' workspaces with Enterprise
Architect. You must use only ' server ' workspaces for Enterprise Architect version
control, as 'local' workspaces do not support the application of checkout locks to
files. Enterprise Architect relies on the presence of checkout locks to ensure that
Packages can only be checked out exclusively and that a given Package is not
already checked-out in some other project (for instance, in a Private Model
deployment). This is necessary because it is not practical to merge the XMI
Package files that Enterprise Architect uses for version control.

A single TFS workspace can map many different local folders, each one to a
separate Source Control Folder. In this case, TFS can take a long time to work
through and update the files in all of those folders, and the system might appear to
'freeze' whilst it waits for TFS to hand back program control.

You can avoid this if you keep your version controlled Package files in a folder that
is separate from other artifacts, such as source code files, creating a separate work
space to use just for your Package files, or creating and mapping a separate folder
for Package files within an existing workspace.

Configure exclusive The XMI format files used for the version control of Enterprise Architect's
check-outs Packages can not be merged like ordinary text files. Therefore, Enterprise Architect
must enforce serialized editing of its version controlled Packages. As a
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consequence, it is important that TFS is configured to use 'exclusive checkouts' for
XML files.

Notes

e TFS can also be used with an SCC client; the MS TFS-SCC client is available for download from Microsoft's web
site

e  MDG Integration for Visual Studio 2005 or 2008 enhances TFS support by providing access to, for example, work
items and bugs within both Enterprise Architect and the MDG Integration product
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TFS Workspaces

In order to use TFS to provide version control of the Packages in a model, you prepare a functional TFS workspace that
can be accessed through an Enterprise Architect version control configuration within that model. You use the TFS
workspace to map a local working folder on your PC to a Source Control Folder within a TFS project repository.

It is assumed that have TFS 2013 open and a TFS Team Project already exists for you to use in version controlling the
Packages of your Enterprise Architect project. You can create the TFS workspace through MS Visual Studio.

TFS 2013 and later versions support the use of Local workspaces. However, Local workspaces do not support the
application of checkout locks. For this reason, Sparx Systems strongly advises against the use of Local workspaces when
version controlling your Enterprise Architect Package files. Using Local workspaces carries a high risk of merge
conflicts when checking in, which would almost certainly result in loss of data or a corrupted model database.

Map a local folder to a TFS Source Control Folder

Step Action

1 Connect to your TFS server.
From the TFS main menu, choose View | Team Explorer.

In the Team Explorer toolbar, click on the Connect to Team Projects button (fourth from left, with a
power plug icon).

The Team Explorer Connect page displays.

2 Click on the link 'Select Team Projects...'

The 'Connect to Team Foundation Server' dialog displays.

3 Click on the appropriate Team Foundation Server, Team Project Collection and Team Project, then click
on the Connect button.

4 Click on the Home page of the Team Explorer, and then on the Source Control Explorer button.

The Source Control Explorer view displays.
5 In the Source Control Explorer, click on the drop-down arrow in the 'Workspace' field in the toolbar,
then click on 'Workspaces' at the bottom of the list.

The "Manage Workspaces' dialog displays.

6 Click on the Add button.
The 'Add Workspace' dialog displays.

7 Click on the Advanced button.
A number of new fields display on the dialog.

8 Type in an appropriate name for the new workspace and, if required, type in a comment.

9 Set the 'Location' field to 'Server'. This setting is important.

This setting is not available in TFS 2010 and earlier releases, where all workspaces are Server based.
10 Click in the Source Control Folder column, then click on the Browse button to select a Source Control

Folder.

Select the Source Control folder (in the Team Project) to use for controlling Enterprise Architect
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Packages.

11 Click on the Browse button in the Local Folder column and create a new local folder.

This is the working copy folder into which Enterprise Architect exports the Package files.

12 Click on the OK button.
The new workspace is created and saved.
The 'Add Workspace' dialog closes.

13 Click on the OK button.

The '"Manage Workspaces' dialog closes.

Notes

e  The local folder referenced in step 11 is the Working Copy Path that should be specified when defining an
Enterprise Architect Version Control Configuration to use this TFS workspace
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TFS Exclusive Check Outs

The XMI format files used for the version control of Enterprise Architect's Packages can not be merged as ordinary text
files can. Therefore Enterprise Architect must enforce serialized editing of its version controlled Packages, and it is
important that Team Foundation Server is configured to use 'exclusive checkouts' for XML files. Otherwise, TFS can
return file statuses that make it look as if the Package file is not checked-out by another user when indeed it is.

You set exclusive checkouts in the TFS workspace through MS Visual Studio.

Configure TFS to enforce exclusive check outs for XML files

Step Action

1 Using Visual Studio, from the main menu select View | Team Explorer.

2 In the 'Team Explorer' pane, right-click on the TFS Server name that is controlling the Enterprise
Architect Package files, then from the context menu select 'Team Foundation Server Settings | Source
Control File Types'.

3 Select the entry for XML files (or create an entry if necessary) then click on the Edit button.

4 Deselect the 'Enable file merging and multiple check out' checkbox.
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Create an SCC Environment

You can use a Microsoft Common Source Code Control (SCC) compatible product as a version control provider for
Enterprise Architect. The first step in doing this is for an administrator to install and configure the server and client
applications. A number of basic tasks are performed in creating an operational SCC-based environment.

Tasks in Creating an SCC Environment

Task Detail
Install and configure your A version control server component is typically installed on a dedicated server
chosen version control machine. All Enterprise Architect users who require access to version control must
product be able to connect to the server machine.

After installing the version control software, the administrator should also create
version control user IDs for all users who require access to version control.

For further information, consult the product documentation for your particular
version control product.

Create a new SCC project It is good practice to create a new SCC version control project, or least a new folder
within a project, for each Enterprise Architect project being added to version
control with SCC.

If you have a single Enterprise Architect project that contains many different
models (for example, a DBMS hosted project with multiple model root nodes), you
might choose to create a new SCC version control project for each separate model.

For further information, consult the product documentation for your particular
version control product.

Configure your SCC The XMI-format files used for the version control of Enterprise Architect Packages
project to support exclusive can not be merged in the same way as ordinary text files can. Therefore, Enterprise
check-outs for XML files Architect must enforce serialized editing of its version controlled Packages. As a

consequence, it is important that your version control application is configured to
use 'exclusive checkouts' for XML files.

Create a local working A working copy folder must exist on each users' machine, for Enterprise Architect

copy folder to use when exporting and importing the version controlled Package files. It is this
folder that is specified as the Local Project Path, when defining your Version
Control Configurations.

The working copy folder is the 'sandbox' where you modify the controlled files.
The working copy folder is usually associated with a folder that exists within the
version control repository. Your version control product provides some means by

which you associate a working copy folder with a repository folder.

For further information, consult the documentation for your particular version
control product.

Notes

e When installing the client component software on users' PCs, check that the SCC client is also installed, as it might
not be a part of the default installation
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Upgrade at Enterprise Architect Version 4.5, Under SCC
Version Control

If you are working in Enterprise Architect release 4.5 or later and you open an SCC version-controlled project that was
created under a release earlier than 4.5, you must identify the SCC connection with a new unique ID. You can assign a
name to the existing SCC configuration or associate the project with another configuration that has previously been
assigned a unique ID.

By having a unique ID for each version control configuration, you can assign a configuration quickly and efficiently
using configurations that have been created previously for other version controlled repositories. This enables you to
configure the many Packages to use an existing version control repository; this can apply to Packages created for more
than just one model enabling a great deal of flexibility.

Upgrade an existing SCC version controlled project created before release 4.5, in
Enterprise Architect release 4.5 or later

Step Action

1 Open the project that has an SCC version control configuration created in Enterprise Architect earlier than
version 4.5.
The 'Select or Create Unique ID for Version Control' dialog automatically displays.

2 On the dialog, either create an ID for an existing configuration or choose a previously created one from
the 'Unique ID' drop-down list.

3 The existing SCC configuration is the initial value, represented by SCC-XXXXX; this number is not
especially meaningful, therefore it is recommended that the configuration be given a meaningful name.

4 You can associate the version controlled Package with a previously-defined configuration by selecting an
existing configuration from the Unique ID drop-down list (if one exists).

5 After you have assigned the unique ID, click on the OK button to load the model.
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Version Control Setup

Once you or an Administrator have installed and configured the version control product software, to start using version
control you must first define a version control configuration within your project in Enterprise Architect, to be used to
control the Packages in the project. You can define any number of version control configurations in a single model, but
any given Package is associated with only one configuration.

Access
Ribbon Configure > Version Control > Settings
Menu Project > Version Control > Version Control Settings
Context Menu Right-click on Package > Package Control > Version Control Settings

Define Version Control Configuration

Step Action

1 On the 'Version Control Settings' dialog, click on the New button.

2 In the 'Unique ID' field, type a suitable configuration name.

3 Select the Type of version control product you are connecting to, by clicking on the corresponding radio
button.

4 At this point, the middle section of the dialog changes to display a collection of fields specific to the type
of version control configuration you are defining.
Enter details relating to the version control workspace that this configuration is to use.

5 Click on the Save button. The new configuration is added to the Defined Configurations list.

6 If you want to create another version control configuration, return to step 1.
When you have finished defining your version control configurations, click on the Close button.

Notes

Version control configuration details are stored in the user's Windows Registry settings, but each project stores a list
of the configurations it uses, so that version control connections can be initialized as the project is being loaded

If you are using the Corporate or extended editions of Enterprise Architect with security enabled, the administrator
must also set up access permissions to configure and use version control
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Re-use an Existing Configuration

Once a version control configuration has been defined for use in one project, it is possible to re-use that configuration in
other projects to provide access to:

e An already existing version control environment (a working copy directory and its associated repository that is
already in use)

e Version controlled Packages that were created (and version controlled) in another project

Access
Ribbon Configure > Version Control > Settings
Menu Project | Version Control | Version Control Settings
Context Menu Project Browser | right-click on Package | Package Control | Version Control

Settings

Select existing configuration

Step Action

1 On the 'Version Control Settings' dialog, click on the New button.

The various fields on the dialog are cleared, ready for data entry.
2 In the "Unique ID' field, click on the drop-down arrow and select one of the previously-defined version
control configurations.

The details of the selected configuration are displayed in the dialog.

3 Click on the Save button.

The configuration details are saved and are ready for use in the current project.
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Version Control Settings

As part of the process of setting up a version control configuration on your model, or updating an existing version control
configuration, you define a number of settings that control how the status of your model is communicated to your version
control system. You define these settings using the 'Version Control Settings' dialog.

Access
Ribbon Configure > Version Control > Settings
Menu Project > Version Control > Version Control Settings
Context Menu Right-click on Package > Package Control > Version Control Settings

Configuration Options

Field/Button Action
This model is private Select to specify that this model database is to be accessed by just a single user
(Private Model).

Leave unselected (the default) or deselect to specify that the database is to be
accessed by multiple concurrent users (Shared Model).

If in doubt, use the default setting.

Save nested version Select to specify that the exported XMI file for a version controlled Package will
controlled packages to contain Package stubs (place holders) for nested version controlled child Packages
stubs only (recommended).

Deselect to specify that the exported XMI file will contain the full content of nested
version controlled child Packages.

For all packages, create Select to force all XMI 1.1 imports across the model to exclude incoming
placeholders for external relationships and instead create external references.
references

If the 'Create placeholders for missing External References during XMI 1.1/2.1
Import' checkbox is not selected in the XML Specifications options for a user, this
field overrides that setting.

Unique ID Specify a name that uniquely identifies the configuration. Either:
e Type a name to identify a new configuration, or

e  Click on the drop-down arrow and select the name of a configuration
previously defined in a different project (if any exist)

Type Click on the appropriate radio button for the type of version control system you are
associating with this configuration.

The middle section of the dialog changes to display a collection of fields relating to
the type of version control configuration you are defining.
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Set the type to SCC for:

e  MS Visual Source Safe

e Rational Clear Case

e Perforce

e AccuRev

e Any other SCC-compatible clients

For any other product that you are using, select the type that matches the product -
CVS, Subversion or TFS.

New Click on this button to clear the fields and create a new version control
configuration.

Save Click on this button to save the details of a new or updated configuration.

Delete Click on an entry in the Defined Configurations list and click this button to remove

the definition of the selected configuration from this model.

Defined Configurations Review a list of configurations that are in use in the current model.
In future, do not prompt for Select to specify that the user is not prompted to complete the definition of
incomplete configurations configurations that are not fully specified (the default).

Deselect to prompt the user to complete configurations that are not fully defined.

Close Close the 'Version Control Settings' dialog.
Help Display this Help topic.
Notes

e [tis important that, for any given version controlled Package file, any user accessing that file from any model uses
version control configurations having the same Unique ID

e When you first open a model that was created by another user and that uses version control, the version control
configuration(s) used by that model do not yet exist in your Windows registry settings; you need to complete the
definitions of those configurations before you can use version control in that project

e If User Security is enabled, you must have 'Configure Version Control' permission to set up version control options
for the current model

e [t is possible to use multiple version control configurations in the same model

(c) Sparx Systems 2015 - 2016 Page 219 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

SCC Settings

When you are setting up your version control configurations on the 'Version Control Settings' dialog, and you set the
configuration type to 'SCC', the dialog presents a set of fields specific to SCC-based configurations. You can then define
details such as:

e The working copy folder to be used with the configuration

e  The details necessary to connect to the SCC version control system

You set the version-control configuration type to SCC for version control providers such as:
e  MS Visual Source Safe

e Rational Clear Case

e Perforce

e AccuRev

e  Any other SCC-compatible clients

Access
Ribbon Configure > Version Control > Settings: Type: SCC
Menu Project > Version Control > Version Control Settings: Type: SCC
Context Menu Right-click on Package > Package Control > Version Control Settings: Type:
SCC
Settings
Field/Button Action
Local Project Path Displays the full path of the folder that contains the local (working) copies of the
XMI Package files.
This field is read-only; its value can only be set through use of the Select Path
button.
Select Path Click on this button to choose the Local Project Path, by opening a file browser

dialog and navigating through the file system to the appropriate folder.

e After you choose the appropriate folder path, the 'Select SCC Provider' dialog
displays, listing all SCC providers that are installed on the current workstation;
choose the SCC provider to use and click on the OK button

e At this point, the SCC client opens its own dialog to prompt you for
information; SCC products implement this functionality in varied ways, but
typically you are prompted to log in to the version control system, then
prompted to choose the SCC project to use and possibly a (server) folder
contained within that project

e At the conclusion of this process, all of the SCC details should be filled in; you
can then save the definition by clicking on the Save button on the 'Version
Control Settings' dialog
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Current User Displays the user name used to log on to the version control system that is accessed
through this configuration.
This field is read-only; the value it displays is retrieved from the SCC client.

SCC Provider Displays the name of the SCC provider.
This field is read-only; the value it displays is retrieved from the SCC client.

SCC Project Displays the name of the SCC Project that this configuration attaches to.
This field is read-only; the value it displays is retrieved from the SCC client.

Notes

®  You define the SCC-specific details as part of the broader process of setting up a version control configuration on
the 'Version Control Settings' dialog
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CVS Settings

When you are setting up your version control configurations on the 'Version Control Settings' dialog, and you set the
configuration type to CVS, the dialog presents a set of fields specific to CVS-based configurations. You can then define
details such as:

e The working copy folder to be used with the configuration

e The path to the CVS command line client

Access

Ribbon Configure > Version Control > Settings: Type: CVS

Menu Project > Version Control > Version Control Settings: Type: CVS

Context Menu Right-click on Package > Package Control > Version Control Settings: Type:
CVS

Settings
Field/Button Action

Working Copy Path Displays the full path of the folder that contains the local (working) copies of the
XMI Package files.

This field is read-only; its value can only be set through use of the Select Path
button.

Select Path Click on this button to choose the working copy path, by opening a file browser
dialog and navigating through the file system to the appropriate folder.

Current User This field is read-only; its value is retrieved from a file named CVS\Root, located
in the folder selected using the Select Path button.

CVS Exe Path Displays the full path of the CVS command line client executable file.

This field is read-only; its value can only be set through use of the Select Path
button.

Select Path Click on this button to specify the path to the CVS command line client, by opening
a file browser dialog and navigating through the file system to locate the
appropriate file.

VC Time-Out Value Specify the amount of time that Enterprise Architect waits for a CVS command to

complete; if the command does not complete within the allowed time, the system
displays a Time-out error message, detailing the command that failed to complete.

This single time-out value is applied to all Version Control Configurations (of
types SVN, TFS and CVS) that the user accesses from this workstation.
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Notes

e  When connecting to a remote CVS repository, the 'Current User' field should display the user name used to log into
that repository; if this does not happen, it indicates that Enterprise Architect cannot extract the user name from the
file ...\WorkingCopyPath\CVS\Root and the configuration does not work correctly

®  You define the CVS-specific details as part of the broader process of setting up a version control configuration on
the 'Version Control Settings' dialog
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SVN Settings

When you are setting up your version control configurations on the 'Version Control Settings' dialog, and you set the
configuration type to 'Subversion', the dialog presents a set of fields specific to Subversion-based configurations. You
can then define details such as:

e The working copy folder to be used with the configuration

e The path to the Subversion command line client

Access

Ribbon Configure > Version Control > Settings: Type: Subversion

Menu Project > Version Control > Version Control Settings: Type: Subversion

Context Menu Right-click on Package > Package Control > Version Control Settings: Type:
Subversion

Settings
Field/Button Action

Working Copy Path Displays the full path of the folder that contains the local (working) copies of the
XMI Package files.

This field is read-only; its value can only be set through use of the Select Path
button.

Select Path Click on this button to choose the Working Copy Path, by opening a file browser
dialog and navigating through the file system to the appropriate folder.

Subversion Exe Path Displays the full path of the Subversion command line client executable file.

This field is read-only; its value can only be set through use of the associated Select
Path button.

Select Path Click on this button to specify the path to the Subversion command line client, by
opening a file browser dialog and navigating through the file system to locate the
appropriate file.

VC Time-Out Value Specify the amount of time that Enterprise Architect should wait for a Subversion

command to complete; if the command does not complete within the allowed time,
the system displays a Time-out error message, detailing the command that failed to
complete.

This single time-out value is applied to all Version Control Configurations (of
types SVN, TFS and CVS) that the user accesses from this workstation.
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Notes

e  You define the Subversion-specific details as part of the broader process of setting up a version control
configuration on the 'Version Control Settings' dialog
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TFS Settings

When you are setting up your version control configurations on the 'Version Control Settings' dialog, and you set the
configuration type to "TFS', the dialog presents a set of fields specific to TFS-based configurations. You can then define
details such as:

e The working copy folder to be used with the configuration
e The user name and password to log in to the TFS server

e  The path to the TFS command line client

Access

Ribbon Configure > Version Control > Settings: Type: TFS

Menu Project > Version Control > Version Control Settings: Type: TFS

Context Menu Right-click on Package > Package Control > Version Control Settings: Type:
TFS

Settings
Field/Option/Button Action

Working Copy Path Displays the full path of the folder that contains the local (working) copies of the
XMI Package files.
This field is read-only; its value can only be set through use of the associated Select
Path button.

Select Path Click on this button to choose the Working Copy Path. The file browser dialog
opens, through which you navigate through the file system to the appropriate folder.

Server Name Displays the name of the TFS Server that is associated with the working copy
folder specified in the "Working Copy Path' field.
This field is read-only; Enterprise Architect retrieves the value it displays by
querying the TFS client.

Workspace Name Displays the name of the TFS Workspace that is associated with the working copy
folder specified in the "Working Copy Path' field.
This field is read-only; Enterprise Architect retrieves the value it displays by
querying the TFS client.

User Name Type in the user name with which to log into the TFS Server.

Password Type in the password with which to log into the TFS Server.

Display Name TFS 2013 and later releases use a Display Name to report on who owns a checkout

lock on a file. TFS 2010 uses AccountID when reporting lock owners and so does
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not require a Display Name.

If using TFS 2013, type in your TFS Display Name as shown in the User column of
the Visual Studio Source Control Explorer when you checkout a file.

Checkout Locks Required This checkbox defaults to selected.

TFS 2013 supports the use of Local workspaces, but these do not support checkout
locks. If you want to use TFS Local workspaces (not recommended), you must
deselect this checkbox. Otherwise, leave the checkbox selected.

It is recommended that all workspaces used for version controlling Enterprise
Architect Package files are set as 'Server' workspaces.

TFS Exe Path Displays the full path of the TFS command line client executable file.

This field is read-only; its value can only be set through use of the associated Select
Path button.

Select Path Click on this button to specify the path to the TFS command line client.

The file browser dialog opens, through which you navigate through the file system
to the appropriate folder.

VC Time-Out Value Type in the number of seconds that Enterprise Architect should wait for a TFS
command to complete; if a command does not complete within this allowed time,
the system displays a Time-out error message, detailing the command that failed to
complete.

This single time-out value is applied to all version control configurations (of types
SVN, TFS and CVS) that the user accesses from this workstation.

Notes

e If you automatically log in to TFS through a path external to Enterprise Architect (for example, through MS
Integrated Security), you can leave the 'User Name' and 'Password' fields blank

e [fthe 'Password' field is blank, Enterprise Architect retrieves your Windows username and uses that value when
determining whether a Package file is checked out to you or to another user

e TFS version control can also be accessed using the TFS MSSCCI client; to make use of the TFS MSSCCI client,
please define an SCC based version control configuration

e You define the TFS-specific details as part of the broader process of setting up a version control configuration on the
'Version Control Settings' dialog
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Use Version Control

Once your version control product is installed and you have created a suitable environment, Enterprise Architect can
make use of that environment to control the Packages in your project. Version control provides a range of facilities, as

outlined in this table.

Facilities

Facility

Define Version Control
Settings

Configure a Package

Check In a Model Branch

Check Out a Model Branch

Check In a Package

Check Out a Package

Undo Check Out of a
Package

Import a Package From
Version Control

Apply Version Control to a
Model Branch

Export a Version
Controlled Model Branch

Import a Model Branch
From Version Control

(c) Sparx Systems 2015 - 2016

Detail

Version control configurations are used by Enterprise Architect to communicate
with your version control system.

You define one or more version control configurations in your project and then use
those configurations to control the Packages in your project.

To put a Package under version control you mark the Package as a controlled
Package, specify the version control configuration to control it, and associate an
XMI file with the Package.

Checks in all Packages involved in a particular unit of work, as a single operation.

Checking-in updates the reference version of a Package or group of Packages in the
model.

Checks out all Packages within a selected model branch as a single operation, so
that you can update modeling objects within them.

Checks in the Package currently selected in the Project Browser.

Checking-in updates the reference version of a Package or group of Packages in the
model.

Checks out the version controlled Package currently selected in the Project
Browser, so that you can update modeling objects within it.

Reverses the check-out of a Package, discarding any modifications that have been
made by restoring the Package content to the latest revision held in version control.

Retrieves Packages from version control that have been created by other users, or
by you in another model, and imports them into your current model.

Applies version control to all Packages within the selected model branch, in a
single operation.

In this context, a model branch is a Package in the Project Browser, and all of the
Packages contained within it.

Exports version control information about the root Package of a model branch, that
is used to simplify the process of exporting and importing a hierarchy of Packages
from one model to another.

Uses Enterprise Architect's Model Branch files, of which there are few, to retrieve
information about the root Package file and to import the model branch.

Model branch files can simplify the process of exporting and importing a hierarchy
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of Packages from one model to another.

View Package Revision Displays the change history of version controlled Packages.

History You can also check out a prior revision of the Package for editing, effectively

rolling-back to a prior revision of the Package.

Validate Package You can test the validity of the version control settings associated with each version
Configurations controlled Package within your current model.
Resynchronize the Status Re-synchronizes the version control status of Packages within your project with the
of Version Controlled status reported by your version control provider.
Packages

Notes

e Database replication should not be combined with version controlled Packages

e If the Packages under version control contain any alternative images, you can export the images to the version
control repository when you check in the Packages, by setting the 'Export alternate images' option on the 'Options'
dialog
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Configure Controlled Package

Once your version control application is set up and you have version control configurations in place, you can place the
individual Packages in your model under version control. To put a Package under version control, you:

e Flag the Package as a controlled Package
e Specify the version control configuration to control it and
e Associate an XMI file with the Package

You can then export and import the Package data to and from the file and issue commands to the version control system.

Access
Ribbon Configure > Version Control > Configure Package
Context Menu Right-click on Package > Package Control > Configure
Keyboard Shortcuts Ctrl + Alt+P

Apply version control to a single Package

Step Action

1 Click on the 'Control Package' checkbox to select it, indicating that this Package is to be controlled.

2 Click on the Version Control drop-down arrow and select the version control configuration to be used to
control this Package.

3 The 'XMI Filename' field displays a default filename for the Package export file, based on the Package
name.

Optionally, modify the filename. Either:

e Type a new name, or

e (Click on the B button to open a file selection dialog

The target file must be located within the working copy folder of the selected version control
configuration, or one of its sub-folders.

4 The 'Version ID' field defaults to '1.0'.

Optionally, change this to a different version number.

5 The 'Owner’ field defaults to your user name.

Optionally, type or select the name of the user who actually owns the Package.

6 Click on the OK button.
The 'Add Package to Version Control' dialog displays.
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7 Optionally, clear the 'Keep checked out' checkbox.

After applying version control, the Package either remains checked-out for editing, or is checked-in and
locked against editing, depending on this setting.

8 Click on the OK button.
The 'Add Comment' dialog displays.

9 Optionally, add any further comments to the default comment.

Enterprise Architect provides a default comment that includes the current date & time.
10 Click on the OK button.

The current Package is exported to the nominated XMI file, which is then committed to version control.
The Package icon in the Project Browser is updated to reflect the Package's version control status.

Notes

e Ifyou are using the Corporate or extended editions of Enterprise Architect with security enabled, these features are
only available to users who have been granted permission to configure and use version control
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Apply Version Control To Branches

It is possible to apply version control to all Packages within a selected model branch, in a single operation. In this
context, a model branch is a Package that is currently selected in the Project Browser, and all of the Packages contained
within it.

Access

Context Menu Project Browser | right-click on Package | Package Control | Add Branch to
Version Control

Apply version control to all Packages within a selected model branch

Step Action

1 On the 'Apply VC to Branch' dialog, click on the drop-down arrow in the 'Version Control Configuration'
field and select the configuration to use.

2 Optionally, tick the checkbox 'Export as Model Branch'.

Once the version control operation is complete a Model Branch file (.(EAB file) is created for this branch.

3 Click on the OK button.

The system creates a number of sub-folders within the version control working copy folder, then exports
all of the Packages within the selected model branch. The system generates filenames for the XMI files,
based on the Package GUIDs.

Notes
e  The version control configuration to be used in this operation must be defined within the model before selecting this

command

e When invoked on the model root node, this command applies version control to every Package within the model
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Package Version Control Options

When you have set up a Package for version control, you gain access to a range of version control operations that can be
performed on that Package, such as:

e Open the dialog for working with baselines of the Package

e  Check-in and check-out single Packages or a selected hierarchy of Packages

e  Update Packages to the latest revision from the version control repository

e Inspect the revision history or properties of the XMI file associated with a Package

e Revert a Package to a previous revision

e  Compare the current model content of a Package, against the latest revision of the Package in version control

e Import and export hierarchies of Packages (model branches) to and from the model, through the version control
system

e Synchronize the status of a Package, with the version control system

Access
Context Menu Right-click on version controlled Package > Package Control
Options
Option Action

Configure Apply or remove version control for the selected Package (specify version control
settings) or specify a file for use in XMI Package Control.
Shortcut: Ctrl+Alt+P

Package Baselines Create a Baseline of the current Package, or compare the current Package with a
previous Baseline.
Shortcut: Ctrl+Alt+B

Check In Branch Check-in Packages contained in the currently selected model branch (that is, the
selected Package and all of its child Packages).

The 'Select Packages to Check In' dialog lists all version controlled Packages within
that branch that are checked out to you; you can then select Packages in the
displayed list, to be submitted for check-in.

You can also choose to keep the Packages checked-out after committing a new
revision to version control.

Check Out Branch Recursively check out all Packages contained within the currently selected model
branch (that is, the selected Package and all of its child Packages) that are version
controlled and checked-in.

Check In Commit a new revision of the currently selected Package to the version control

repository and lock the Package against further editing.
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Only available for Packages that you have checked-out yourself.

Check Out Synchronize the currently selected Package with the latest revision from the version
control repository and unlock the Package to allow editing.

Only available for Packages that are not already checked-out (and whose associated
Package file is not checked-out).

Undo Check Out Restore the selected Package to the latest revision in the version control repository
and lock the Package against further editing.

Put Latest Commit a new revision of the currently selected Package to the version control
system, while keeping the Package checked-out.

This is equivalent to checking a Package in and immediately checking it back out
again.

Only available for Packages that you have checked-out yourself.

Get Latest Synchronize the currently selected Package with the latest revision from the version
control repository.

Available only for Packages that are checked in.

Get All Latest Update all of the version controlled Packages in the project, to the latest revision
retrieved from version control.

Only updates Packages that are currently checked in.

Once the latest revisions are retrieved, the system scans all the controlled Packages
and fixes any missing cross-references by comparing the Package with its XMI 1.1
file.

If the cross-reference information in the XMI does not match the model, the system
updates the model with the information from the XMI and records this update in the
System Output window.

You can roll back such updates by selecting the entry in the System Output window
and using the context menu option 'Rollback Update' (or 'Rollback Selected
Updates' if multiple entries are selected).

e C(Closing the model clears the entries in the System Output window

e An entry in the System Output window is also cleared as and when you
roll-back the update for it

Scan XMI and Reconcile Scan the Package XMI files associated with each of the project's controlled
Model Packages and restore any diagram objects or cross-references that are detected as
missing from the project.

This function is useful in team environments where each user maintains their own
private copy of the model database (that is, multiple private project files) and model
updates are propagated through the use of controlled Packages. It provides no
benefit when the model is hosted in a single shared database that is accessed by all
team members.

Each controlled Package is compared with its associated XMI file and, if the
cross-reference information in the model does not match the XMI, the system
updates the model with the information from the XMI and records the update in the
System Output window.

You can roll back such updates by right-clicking on the entry in the System Output
window and selecting the 'Rollback Update' option (or 'Rollback Selected Updates'
if multiple entries are selected).

Closing the model clears the entries in the System Output window; an entry in the
window is also cleared as and when you roll-back the update for it.
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File Properties

File History

Compare with Controlled
Version

Add Branch to Version
Control

Export as Model Branch

Import a Model Branch

Get Package

Re-synch Status With VC
Provider

Version Control Settings

15 July, 2016

This functionality is invoked automatically as part of the 'Get All Latest' operation.

When working in an environment that uses a Private Model deployment and your
model contains a significant number of cross-Package references, it is
recommended that you invoke 'Scan XMI and Reconcile Model' from time to time,
following the re-importation of controlled Packages - for example, after using 'Get
Latest' to update a number of Packages - or after performing a number of Package
check-outs.

e Asageneral rule, avoid running 'Scan XMI and Reconcile Model' while you

have uncommitted changes in your model; generally, you:

- Check-out a number of Packages

- Invoke 'Scan XMI and Reconcile Model'

- Make your modifications

- Commit any outstanding changes before you check-out more Packages and
run 'Scan XMI and

Reconcile Model' again

Display version control properties pertaining to the XMI export file associated with
the currently selected Package; this also identifies who has checked out the
Package.

Display change history information for the currently selected Package.

Revert to or check-out a prior revision of the Package.

Compare the currently selected Package with the latest revision of its associated
XMI file retrieved from version control.

Apply version control to all Packages within a selected model branch, in a single
operation.

In this context, a model branch is a Package that is currently selected in the Project
Browser, and all of the Packages contained within it.

Export a newly created model branch from your own private copy of a model.

Retrieve a model branch and import it into either the source model or another
model.

Access Packages in the version control repository that are not currently available in
your model.

Update the version control status value recorded for the selected Package in the
project to match the value reported by the version control provider, without
performing an XMI import or export.

Use this function when the Package's version control status recorded in your project
is out of synchrony with the version control status reported by your version control
provider.

Display the 'Version Control Settings' dialog.

Notes

®  You set up version control using options from the project 'Version Control' submenu
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e If'the selected Package is not under version control, a different set of options is available

e Ifaversion control configuration has not been defined for the model, no options for using version control are
available, only the options for configuring version control
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Check Out a Package

When you need to work on a version controlled Package, you check it out. The local XMI file associated with the
Package is then checked-out from version control. No other user can check out the Package to make changes to it until it
has been checked in again.

Access
Context Menu Right-click on Package > Package Control > Check Out
Keyboard Shortcuts Ctrl + Alt + L

Check out a single Package

The Package file is imported into your model, and the 'Package' icon is updated to reflect the change in the Package's
version control status.

When working in a Private Model, if the system detects that the Package content in the model is already up to date with
the latest revision of the Package file retrieved from version control, then the 'Tmport Package' dialog displays first. This
dialog is not displayed for a Shared Model.

These options are available:
e Force Reload From XMI - reload the Package from XMI regardless of whether it is up to date or not
e Accept current package - select to skip the process of re-importing the Package from XMI

e Refresh model view - select to refresh the Project Browser and diagrams, by reloading the Package content from
the project database

e Always use these settings - when selected, if you subsequently check out a Package that is found to be up to date, the
same settings are applied again without displaying the dialog

Notes

e If you check out a version controlled Package whilst offline, the 'Package' icon has a red figure 8 in front of it

e Ifyou have selected the 'Always use these settings' checkbox and you want to reconfigure the 'Tmport Package'
dialog, press the Ctrl key whilst you select the 'Package Control | Check Out' menu option; the dialog displays and
you can change the settings
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Undo Check Out of a Package

If you check out a Package and then decide not to proceed, you can undo the check-out and discard any modifications
that have been made, by restoring the Package content to the latest revision held in version control. The Package returns
to a checked-in state and subsequently can be checked out by any user, including yourself if, for example, you need to
reverse incorrect changes before checking the Package out and starting again.

Access

Context Menu Right-click on Package > Package Control > Undo Check Out

Undo check out of a selected Package

A confirmation dialog displays; click on the OK button.

The latest revision of the Package is retrieved from version control and re-imported into your model. The icon against the
Package in the Project Browser is updated to reflect the change in the Package's version control status.
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Check In a Package

When you have finished working on the contents of a Package under version control, and you want to return it to the
model for other users to see, you check it in.

Access
Context Menu Right-click on Package > Package Control > Check In
Keyboard Shortcuts Ctrl + Alt+ S

Check in a single Package

Step Action

1 The selected Package is exported and the 'Add Comment' dialog displays. A default comment is provided
that contains the current date and time.

Optionally, modify the default check-in comment
2 Click OK.

The Package file is checked-in to version control and the Package icon is updated to reflect the change in
version control status.
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Check Out a Model Branch

If you need to check out a number of related Packages involved in a particular unit of work, to update the contents, you
can do so in a single operation by checking out the whole model branch that contains them.

Access

Context Menu Right-click on Package > Package Control > Check Out Branch

Check out a sub-tree of model Packages

Step Action

1 The selected root-node Package and all of its contained sub-Packages are recursively checked out.

Any Packages that cannot be checked-out are listed in a message box, with a brief description of the
problem; for example: The Package is already checked out by user 'Fred'.

2 When Project Security is enabled in Lock to Edit mode, Enterprise Architect prompts you to apply a User
Lock throughout the selected model branch before proceeding.
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Check In a Model Branch

If you need to check in a number of related Packages involved in a particular unit of work, and that you have updated,
you can do so in a single operation by checking in the whole model branch that contains them. You can also commit new
revisions of the affected Packages as you complete milestones, whilst keeping the Packages checked-out for further
editing.

Access

Context Menu Right-click on Package > Package Control > Check In Branch

Check in Packages from within a model branch

Step Action

1 The 'Select Packages to Check-in' dialog lists all version controlled and checked-out Packages within the
selected model branch. By default, the entire list is selected.

Optionally:

e  Click an individual Package to select just that Package

e  Ctrl+click on an individual Package to add or remove it from the selection
e  Shift+click on a range of Packages to select them

e  Click on the All button to select all listed Packages

e  (lick on the None button to clear the selection

2 Optionally, you can commit into version control a new revision of all selected Packages, while keeping
those Packages checked out for further editing. To do this, select the 'Keep packages checked-out after
committing new revision' checkbox.

3 Click on the OK button.

The 'Add Comment' dialog displays. A default comment is provided that contains the current date and
time. This comment is applied to all Packages that are checked in.

4 Optionally, modify the default check-in comment.
5 Click on the OK button.

The selected Packages are exported and checked-in. The Package icons are updated to reflect any change
in version control status. If you opted to keep Packages checked out, there is no change in status.
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Update to the Latest Revision of Selected Package

When you are part of a team working in a Distributed Model environment, you will want to periodically update your
model with the changes that other team members have committed into version control. You can transfer the other users'
updates from version control into the selected Package in the Project Browser.

Access

Context Menu Right-click on Package > Package Control > Get Latest

Update Package to latest revision

The local XMI file associated with the Package is updated to the latest revision from version control. The XMI file is
imported into your model database, updating the Package in your model.

When working in a Private Model, if the system detects that the Package content in the model is already up to date with
the latest revision of the Package file retrieved from version control, then the 'Import Package' dialog displays first. This
dialog is not displayed for a Shared Model.

These options are available:
e 'Force Reload From XMI' - reload the Package from XMI regardless of whether it is up to date or not
e 'Accept current package' - select to skip the process of re-importing the Package from XMI

e 'Refresh model view' - select to refresh the Project Browser and diagrams, by reloading the Package content from
the project database

e 'Always use these settings' - when selected, if you subsequently check out a Package that is found to be up to date,
the same settings are applied again without displaying the dialog

Notes

e  The 'Get Latest' command is disabled for any Package that is checked-out (to anybody) in the currently loaded
project

e  When using a Shared Model environment, where all users are connected to a single model database, you should
reload the Package from the database, rather than using the 'Get Latest' command

e Ifyou have selected the 'Always use these settings' checkbox and you want to reconfigure the 'Tmport Package'
dialog, press the Ctrl key whilst you select the 'Package Control | Get Latest' menu option; the dialog displays and
you can change the settings
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Update to the Latest Revision of All Packages

When you are part of a team working in a Distributed Model environment, you will want to periodically update your
model with the changes that other team members have committed into version control. You can transfer the other users'
updates to all version controlled Packages into the currently loaded project.

Access

Context Menu Right-click on Package > Package Control > Get All Latest

Update all Packages in project to latest revision retrieved from version control

All the local XMI files for all the version control configurations used in the project are updated to the latest revision from
version control. The system then scans the Packages in the model, to determine which ones are up to date and which are
not, compared to the latest revisions of the associated Package files.

A prompt displays, providing these import options for Packages that are up to date:
e Import changed files only

e  Always import

e  Prompt for each file

Click on the OK button. The version controlled Packages in your project are updated according to the option you
selected; if you chose the 'Prompt for each file' option, a prompt displays to confirm import of each file.

Notes

e There is no need to re-import Packages that are already up to date - re-importing Packages first deletes them from
the project and then re-imports them from the XMI file, which is time consuming as well as unnecessary; we
strongly recommend using the default option 'Import changed files only'

e  The 'Get All Latest' command does not update any Package that is checked-out (to anybody) in the currently loaded
project; otherwise, any changes not yet committed to version control would be discarded

e  When using a Shared Model environment, where all users are connected to a single model database, the information
in the model database is always the same as, or ahead of, what is committed into version control; in this situation,
the Get All Latest command will simply refresh your view of the model database, by reloading diagrams or
reloading Package content in the Project Browser
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Include Other Users' Packages

Other users might be developing Packages in their own models that you could use in your model, or you might have
other models containing Packages that you want to use in the current model. Unless you are sharing an SQL database or
project file, those Packages are not automatically available to you. However, if the Packages have been placed into
version control, you can import them into your model as children of one of your model's Packages.

Access

Context Menu Right-click on Package > Package Control > Get Package

Import Packages from version control into current model

Step Action

1 On the 'Get Shared File' dialog, click on the drop-down arrow of the 'Version Control Configuration'
field and select the version control configuration associated with the Package to retrieve.

The file list is populated with the names of files available through that configuration, for retrieval and
import into your model.

2 Click on the Package file to import into your model and click on the OK button.

The Package file is imported as a new child Package, under the parent Package you selected.

Notes

e  You must have access to the Package files through the version control system and you must define a version control
configuration through which to access those files

e  The version control configuration must use the same unique ID that was originally used to add the Package to
version control

e XMI Package files associated with Packages that are already part of your project, are NOT included in the list of
files available for import
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Export Controlled Model Branch

Applying version control to a model can result in many XMI files placed under version control. It might then be hard to
locate and import the file corresponding to the root of a particular model branch. Using Model Branch Files (.eab files)
overcomes this problem by making it easier to export and import Package hierarchies from one model to another.

You could export a newly created model branch from your own private copy of a model so that, for example:
e Another user can import that branch into their own private copy of the same model

e It can be imported for inclusion as a common branch in a number of different models

Access

Context Menu Right-click on Package > Package Control > Export as Model Branch

Create a Model Branch File to represent a Package hierarchy stored in version
control

Step Action

1 On the 'Export as Model Branch' dialog, in the 'EAB Filename' field, type a name for your Model Branch
File.

Alternatively, click the B button and browse for the file location.
Note that the Package name is supplied as a default.

2 Click on the OK button.

A branch file is created to represent the selected Package. The branch file is committed to version control
using the same version control configuration that controls the Package you selected.

Notes

®  You can specify any file name, including sub-folder names, as long as the file is contained in or below the working
folder of your version control configuration

e The facility is only enabled for Packages that are already under version control
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Import Controlled Model Branch

Applying version control to a model can result in many XMI files placed under version control. It could then be hard to
locate and import the file corresponding to the root of a particular model branch, if you want to:

e Retrieve a model branch created by another user in a private copy of a model, to import it into your own private
copy of the same model

e Retrieve a model branch that is common in many models, for inclusion in a new model

Model Branch Files overcome this problem by simplifying the retrieval of Package hierarchies for use in other models.
You use Enterprise Architect's Model Branch Files, of which there are few, to retrieve information about the root
Package file such as the name and type of the version control configuration for the selected Package, and the relative
filename of the version controlled XMI file associated with the Package. The system then uses this information to import
the branch into your model.

Prerequisites

Before you begin, you must have:
e An operational version control environment that can be accessed by Enterprise Architect, and

e All of the version controlled Package files and the model branch file associated with the model branch to import, in a
valid and accessible working copy folder

Access

Context Menu Right-click on target Package for import > Package Control > Import a Model
Branch

Import a Model Branch

Step Action

1 On the 'Import VC Model Branch' dialog, either:

e  Use the lower portion of the dialog to select a model branch file (this is the simpler option if the
associated version control configuration has already been saved in the current model; continue to step
2)
OR

e  C(Click on the Find a Model Branch (.EAB) file button (this option is useful when you have not yet
defined the version control configuration that is associated with the model branch to be imported; see
the Manually Locating Model Branch Files topic)

2 Click on the drop-down arrow in the 'Select a Version Control Configuration' field and select a
configuration.
A list of .eab files controlled by that configuration is displayed in the 'Select a Model Branch (.EAB) file'
list.

3 Select the Model Branch File you need, then click on the OK button.
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The system imports the root Package specified in the Model Branch File and recursively imports and
populates all the sub-Packages contained in the root Package.

Notes

e The Import a Model Branch command is only enabled for Packages that you (the current user) are able to edit, as the
imported model branch is inserted into the model under your selected Package
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Manually Locating Model Branch Files

When importing a Model Branch File from version control, you might not have the associated version control
configuration saved in the model that is receiving the import. In this situation, it is simpler to manually browse the file
system to locate the Model Branch File (.eab) and let Enterprise Architect derive the details of the configuration from the
branch file you select.

Prerequisites

Before you begin, you must have:
e An operational version control environment that can be accessed by Enterprise Architect, and

e All of the version controlled Package files and the model branch file associated with the model branch to import, in a
valid and accessible working copy folder

Access

Context Menu Right-click on target Package for import > Package Control > Import a Model
Branch : Find a Model Branch (.EAB) file

Locate the Model Branch File

Step Action

1 Access the Tmport VC Model Branch' dialog, then browse for and select the Model Branch File that
represents the model branch to import.

2 Click on the Open button.

If the version control configuration referenced by the file is fully defined within the current model, the
import commences at this point.

Otherwise, Enterprise Architect displays a dialog prompting you to complete the required configuration.

3 Click "Yes' to proceed with completing the definition of the version control configuration.

The 'Version Control Settings' dialog is displayed.

4 Complete the definition of the configuration.

(Typically this involves simply specifying the working copy folder.)

5 Click on the Save button.
The configuration details are saved.

The import of the model branch proceeds.
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Notes

e The Import a Model Branch command is only enabled for Packages that you (the current user) are able to edit, as the
imported model branch is inserted into the model under your selected Package
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Review Package History

It is possible to review the change history of version controlled Packages by examining previous revisions. If necessary,
you can check out one of these earlier revisions of a Package for editing, effectively rolling-back to that prior revision of
the Package.

Access

Context Menu Right-click on Package > Package Control > File History

Review change history of a version-controlled Package

Step Action

1 For version control environments using Subversion, CVS or TFS command line clients, the 'File Version
History' dialog displays.

Click on a revision number in the 'Revisions' field, to select that revision and view its log entry.

For version control environments using SCC based clients, your particular product opens its own 'File
Version History' dialog.

2 On the 'File Version History' dialog, you can optionally click on either:

e  Check Out - the selected revision of the Package file is retrieved from version control and imported
into your model as a Package that is checked out for editing; you can subsequently check in this
revision as a new HEAD revision, effectively allowing you to revert the Package to a prior revision
or

e Retrieve - the selected revision of the Package file is retrieved from version control and imported into
your model, but the Package remains flagged as checked-in and cannot be modified; subsequently
checking out the Package updates it to the latest revision before it is unlocked for editing

Notes

e Ifthe selected Package was already checked out in the current model, the Retrieve and Check Out buttons are
disabled

e Ifthe selected Package contains any sub-Package that is already checked-out in the current model, a warning will be
displayed and the retrieval or check-out will not go ahead

e Ifyou check out a prior revision of a Package, but do not want to commit it as a new revision, right-click on the
Package and select Package Control | Undo Check Out
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Review Package History - SCC Client

It is possible to review the change history of version controlled Packages by examining previous revisions. If necessary,
you can check out one of these earlier revisions of a Package for editing, effectively rolling-back to that prior revision of
the Package. The process for reviewing the change history of Packages configured for version control with an SCC client
(including products such as Visual Source Safe, TFS-SCC, ClearCase, Perforce, AccuRev and MKS Source Integrity)
differs from that for Subversion, CVS or TFS command line clients.

Access

Context Menu Right-click on Package > Package Control > File History

Review change history of a version-controlled Package (SCC client)

Step Action

1 The change history mechanism offered by the third party SCC provider displays.

To import a prior revision of the Package into your model, use the 'SCC History' dialog to retrieve the
revision, then close the dialog.

2 The SCC client notifies Enterprise Architect that a different revision has been retrieved. A prompt then
displays, asking whether you want to check-out the prior revision.

3 Optionally, click on either:

®  Yes, to check out the prior revision - the selected revision of the Package file is retrieved from
version control and imported into your model as a Package that is checked out for editing; you can
subsequently check in this revision as a new HEAD revision, effectively reverting the Package to the
prior revision
OR

e No, to import the prior revision as read-only - the selected revision of the Package file is retrieved
from version control and imported into your model, but the Package remains flagged as checked-in
and cannot be modified; subsequently checking out the Package updates it to the latest revision before
it is unlocked for editing

Notes

e Ifthe selected Package was already checked out in the current model, the system does not proceed with retrieving a
prior revision

e Ifyou check out a prior revision of the Package, but do not want to commit it as a new revision, right-click on the
Package and select Package Control | Undo Check Out
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Retrieve Prior Revision - SCC Client

Depending on your version control product, retrieving a prior revision of a controlled Package can involve a number of
prompts regarding overwriting the current local copy.

This example details retrieval of a prior revision from a TFS-SCC version control configuration.

Access

Context Menu Right-click on Package > Package Control > File History

Example Procedure - retrieve prior revision, TFS-SCC client

Step

1

Action

Display the 'TFS File History' dialog.

Click on the Get button.

The TFS-SCC client displays the '"Resolve Conflicts' dialog.

This dialog offers the 'Automerge All XML Package files' option. DO NOT select this option.
It is important to prevent any merging of Enterprise Architect's XML Package files.

Click on the Resolve button.
The TFS-SCC client displays the 'Resolve writable file conflict' dialog.

Select the 'Overwrite local file/folder' option.

The existing working copy of the Package file is overwritten by the prior revision retrieved from version
control.

Click the OK button.
The TFS-SCC client redisplays the 'Resolve writable file conflict' dialog; it should now show no conflicts.

Click on the Close button.
The TFS-SCC client redisplays the 'File History' dialog.

Click on the Close button.

Enterprise Architect displays a prompt, asking whether to check-out the prior revision.

Click on the:
e  Yes button to check-out the prior revision

e No button to retrieve a read-only version of the Package, that is NOT checked-out and is NOT
editable
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Validate Package Configurations

Having defined the version control settings for your current model, you can test the validity of those settings associated
with each version controlled Package within the model.

Access
Ribbon Configure > Version Control > Check Configuration
Menu Project > Version Control > Validate Package Configurations

Validate version control settings

Step Action

1 The validation process scans the model database and verifies that the version control configuration
associated with each version controlled Package is fully specified in the current model. It also queries the
corresponding version control provider to find the status of the Package file associated with each version
controlled Package.

The results of the validation process are sent to the System Output window.

2 Open the 'Version Control Settings' dialog to complete the definition of any invalid or missing version
control configurations.

3 Click on an error message in the System Output window to highlight the corresponding Package in the
Project Browser.

4 Right-click a Package node and select 'Package Control | Configure Package' to open the 'Package
Control Options' dialog.

Correct any problems with the version control details for the Package.

Correct any problems with the Package's associated XMI file.
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Resynchronize the Status of Version Controlled Packages

It is possible to update the version control status of version controlled Packages within your project to re-synchronize
with the status reported by your version control provider. This can be useful if you are creating copies of your project,
where checking in a Package from one copy of the model leaves the Package in the second copy of the model with an
out-of-date version control status.

For a given Package, the re-synchronization process queries the corresponding version control provider to find the status
of the Package file associated with the version-controlled Package. If necessary, the process then updates the Package
flags within the model database, to synchronize the Package status recorded in the model with the value reported by the
version control provider.

Access
Ribbon Configure > Version Control > Re-Synch Status (applies to all packages in model)
Menu Project > Version Control > Update and Synchronize All Package Statuses
Context Menu Right-click on Package > Package Control > Re-synch Status With VC Provider

(applies to single package only)

Resynchronize version control status

Step Action

1 The results of the re-synchronization process are sent to the System Output window.
2 Double-click on any result message to select, in the Project Browser, the corresponding Package.
Notes

e This process does not cause any Package data to be either exported from your model to the associated Package file,
or imported from a Package file into your model's Package data

e Ifa Package has been checked-out and modified with Enterprise Architect, but your version control provider reports
the Package file as checked-in, running this process marks the Package within Enterprise Architect as being
checked-in, without exporting and committing the pending changes; subsequently checking-out the Package imports
the latest revision of the Package file from version control, effectively discarding the uncommitted modifications
from the model

e Similarly, if a Package file is checked-out to you in your local working copy folder, but not in the Enterprise
Architect model, running this process marks the Package within the model as checked-out, but it does not import the
associated Package file from the version control system; consequently, it is possible to check-in a Package from
Enterprise Architect that is potentially out of date, compared to the latest revision of the Package file within the
version control system
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Tracking Changes

If you want to track changes to data across your project, you can use two separate but complementary facilities -
Auditing and Baselines.

Facilities
Facility Detail
Auditing of model changes Auditing is a project-level feature, available in the Corporate, Business and

Software Engineering, System Engineering and Ultimate editions, that enables you
to record model changes in Enterprise Architect.

By enabling this feature, model administrators can view a range of information
regarding changes, such as:

e Who changed an element

e  How many elements they changed
e  When they changed the data

e  What the previous values were, and

e  What type of elements they changed

Baselining and differencing The Enterprise Architect Corporate, Business and Software Engineering, System

to capture and roll back Engineering and Ultimate editions provide a facility to ' baseline ' or snapshot a

changes model branch in XMI format at a particular point in time, and store it within the
model in compressed format.

More than one baseline can be stored against a single Enterprise Architect Package;
using baselines, you can compare Packages at the current and earlier stages of
development, using the Compare (Diff) utility.

The Compare utility is available in the Professional, Corporate, Business and
Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect; it enables you to compare the current model with:

e A Baseline
e An exported Enterprise Architect XMI file on disk
e A version-controlled Enterprise Architect XMI file on disk
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Auditing

Auditing is a project-level feature that model administrators can use to record model changes in Enterprise Architect.
After switching Auditing on, you can view information on changes such as:

o  Who changed an element

e How many elements they changed

e  When they changed the data

e  What the previous values were, and
e What type of elements they changed
Auditing does not record changes to:

e Document Templates

¢  Model Documents

e Baselines or

e  Profiles

We provide a Quickstart procedure to help you enable Auditing and see it in action, from which point you can explore a
number of set-up options and display features.

Features

Feature Detail

The Audit View To view what has been recorded by the audit, use the Audit View, which provides
an interface to everything recorded by Auditing.

If security is enabled, you must have Audit View permission to display data in the
Audit View.

Model Views You can also obtain a snapshot of selected items in the model, using the Model
View facility.

In the Corporate, Business and Software Engineering, Systems Engineering or
Ultimate editions of Enterprise Architect, you can use this facility to automatically
generate a snapshot at intervals and, if there are changes in the items collected by
the defined search, to trigger a notification to you of such changes.

This helps you to monitor workflow and other events of concern to you.

Document Report You can generate a document report that includes the audit history information for
the selected element or Package, by choosing the basic + audit template.

Audit History Using Auditing, you can track changes to an element or connector over time.

However, enabling Auditing also enables an 'Audit History' tab in the System
Output window, which summarizes all changes made to the selected element or
connector.

Performance Issues By enabling Auditing on a project, you increase the time taken for most actions.

For most modeling tasks, this increase is insignificant; however, there are some
instances where the difference is more substantial.
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Notes

e The Auditing facility is available in the Corporate, Business and Software Engineering, System Engineering and
Ultimate editions

e  Warning - If your site runs separate editions of Enterprise Architect, when Auditing is turned on in a project any
Desktop or Professional edition users are locked out of the project; to restore access, turn Auditing off in the project
from the Corporate, Business and Software Engineering, Systems Engineering or Ultimate edition instance of
Enterprise Architect

(c) Sparx Systems 2015 - 2016 Page 257 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

Auditing Quickstart

It is very simple to enable Auditing and see it in action.

Access
Ribbon Configure > Model > Audit : Audit Settings
Menu Project | Auditing : Audit Settings
Enable Auditing
Step Action
1 In the 'Audit View', click on the Audit Settings button.
The 'Audit Settings' dialog displays.
2 Select the 'Enable Auditing' checkbox.
3 Click on the OK button to close the 'Audit Settings' dialog.
4 Close the 'Audit View' dialog.
5 Change and save your project.
e Add anew Package
e Add anew Class
e Add a new connector
e Change the name of an element
e Delete an element
6 Open the Audit View again and click on the Refresh (or Load) button to display a record of the changes
you have made.
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Auditing Settings

Using the 'Audit Settings' dialog, you can change what is recorded by the Auditing facility and:

e Define the areas of processing in Enterprise Architect to audit

e Administer your audit records

e Indicate the kind of model objects for which changes are to be recorded

e Configure Auditing to record changes to only certain types of elements

Access

Ribbon

Menu

Configure Settings

Field/Option/Button

Enable Auditing

Audit XMI Import

Audit XMI Export

Audit Reverse Engineering

Use Database Timestamp

Save Logs
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Configure > Model > Audit : Audit Settings

Project | Auditing : Audit Settings

Action

Select this checkbox to turn the Auditing facility on.

Select this checkbox to record changes arising from XMI importing in the audit.

As version control uses XMI, you must select this option to record changes from
checking out Packages.

Select this checkbox to record changes arising from XMI exporting in the audit.

As version control uses XMI, you must select this option to record changes from
checking out Packages.

Select this checkbox to record changes arising from reverse engineering in the
audit.

Select this checkbox to use the database server's timestamp instead of each user's
local timestamp; this improves security.

This option is not available for project files.

Click on this button to save a copy of the logged audit items currently held in the
project. These items remain in the project; you can use the Clear Logs button to
remove them.

The system prompts you to specify whether to save items covering a specific period
of time.

e  Click on the No button to save all log items currently held in the database

e  Click on the Yes button to display the 'Time Filter' dialog, on which you
select a standard time period or define your own

This function can be accessed through the Automation Interface.
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Clear Logs Click on this button to permanently delete all log data from the current project; use
the Save Logs button first, to save the audit records outside the project.

The system prompts you to specify whether to clear items covering a specific
period of time.

e Click on the No button to clear all log items currently held in the database

e  C(Click on the Yes button to display the 'Time Filter' dialog, on which you
select a standard time period or define your own

This function can be accessed through the Automation Interface.

Load Logs Click on this button to load a previously saved set of logs back into the project. A
browser displays through which you select the log file to reload.

If the same record exists in both project and log file, that record is not reloaded.

Core Select this radio button to record changes to elements (including attributes and
operations), Packages, connectors and some model-level information.

Standard Select this radio button to record the same changes as for the Core option, plus
changes to some of the 'housekeeping' data for diagrams - Name, Author, Version,
Stereotype, Notes and Date Modified.

You can check for changes to diagram content and structure using the Baseline
facility for reviewing visual changes to diagrams.

Extended Select this radio button to record the same changes as for the 'Standard' option, plus
changes to project security.

Maintenance Select this radio button to audit changes to maintenance elements only; that is:
e Package (element)
e Requirement
e TFeature

e Use Case

e Actor
e Note
e [ssue and
e Change
Core Structural Select this radio button to audit changes to maintenance elements (as above) plus

certain structural elements; that is:
e  Package (structure)
e C(lass

e Interface

e Signal

e Node

e Component
e Artifact

e Part

e Port and

e Device
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All Select this radio button to audit changes to all types of element.

Custom Select this radio button to audit changes to element types that you specify.

The Customize button is made available; click on this button to display a list of
element types, and select the checkbox against each element type to include in the
audit (or click on the Select All button to select every element type).

Click on the OK button to save the selection.

Notes

e  As the number of records increases, the performance of the Audit View reduces; it is recommended that audit
records that are not regularly required are saved to file, then cleared from the project, to help ensure high
performance

e  Connectors are audited when they are connected to an element that is included in the Audit Options

e If security is enabled, you must have Audit View permission to turn Auditing on, and Audit Settings permission to
change the audit settings
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The Audit View

The Audit View provides an interface to the information that has been recorded by auditing.

Access
Ribbon Configure > Model > Audit
Menu Project | Auditing

Sections of the Audit View

The Audit View is divided into three main areas:

Section Description

View controls The view controls provide a variety of settings for controlling auditing and the
display of audit records.

Audit tree The audit tree displays the log items that have been recorded by auditing.
What is displayed in the tree is affected by the view controls, such as:
e Sorting
e Filter (by time)
e Mode
e Auditing settings (what was actually recorded)

If synchronizing with the Project Browser, it is also affected by the Package,
diagram or element you have selected.

= [] Class Elements
=] MyClass
- 2007-03-13 10:38:55
¢ 2007-03-13 10:3%:01
W 2007-03-13 10:32:04

In the audit tree:

e The green tick indicates a creation
e The yellow pencil indicates an edit
e The red cross indicates a deletion

Right-clicking an element in the audit tree (such as MyClass) displays a context
menu that enables you to locate the selected element in:

e The Project Browser

e  Any diagrams in which it exists

Record display The record display is in two parts: the identity of the selected change, and the actual
change made.
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The data in the record display is determined by the view controls and mode and, if
synchronizing with the Project Browser, by the Package, diagram or element you
have selected.

Identity

User  rchester{admin)
Time  2009-06-04 14:30:01
Details Package. (Class Model)

The identity of a change consists of:

e The Windows username of the user that made the change; if security is
enabled, the name is of the format WindowsUsername(SecurityUser)

e  When the change was made

e The path of the change; for example: Class Class]1 - Attribute Attl - Attribute
Constraint Constraint

Changes

Changes are displayed in a table format, showing the:
e  Property (or data item) name

e [ts original value before the change and

e [ts value after the change

If you double-click on an item in the list of changes (or right-click and select the
'Show Differences' option) the Difference window displays:

Before Change After Change
Proposed] Validated

This shows the specific changes that have been made, highlighting the edited,
created, deleted or formatted characters.

Changes to the format of text in the element, made through the element 'Properties'
dialog, are not apparent in the initial table; they are visible in the Difference
window, identified by HTML formatting tags.

Notes

e Ifsecurity is enabled, you must have Audit View permission to display data in the Audit View
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Audit View Controls

The Audit View controls provide a variety of settings for controlling auditing and the display of audit records.

Options
Field/Option/Button Action
Load or Refresh Click to reload the Audit Tree, updated with any new audit results.
Search Click to search through log items for a particular area - you can search by Name,
Type or GUID.
The items are loaded and filtered with the current Sort By, Time Filter and Mode
settings.
If you refresh the Audit View, you must run the search again.
Audit Settings Click to open the 'Audit Settings' dialog.
Sort-by Select the appropriate radio button for the required display setting:
e Type - changes are grouped under element type (such as Class or
Requirement), and then grouped under the changed element
= [ Class Elements
=- B MyClass
«* 2007-03-13 10:38:55
¢ 2007-03-13 10:39:01
% 2007-03-13 10:39:04
e  User - changes are grouped under user name, each with the number of changes
for that user
Under each user name, changes are grouped as for the Type sort
= rﬁ'-,lz admin (3)
[=1-__] Class Elements
= & MyClass
«* 2007-03-13 10:46:06
¢ 2007-03-13 10:46:10
% 2007-03-13 10:46: 15
Filter By Date/Time Select to enable the Filter Settings button, to filter the audit results by time period.
Changes that occur outside the selected filter period are not shown in the Audit
View.
Filter Settings Click to display the 'Time Filter' dialog, to set the filter time period:

e Today - to display changes occurring today

e Previous Hour - to display changes occurring in the last 60 minutes
e Previous 24 Hours - to display changes occurring in the last 24 hours
e Previous Week - to display changes occurring in the last 7 days

e  Previous 30 Days - to display changes occurring in the last 30 days

e Previous Year - to display changes occurring in the last 365 days
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e Custom - to define your own time period, using the From and To fields

The six pre-configured time periods automatically update when you click on the
Refresh button; custom periods are static and do not automatically update.

If you have set a filter period, and you deselect the 'Filter By Date/Time' checkbox,
the period remains set; the custom time period, too, is retained so that you can
re-use it or modify it later if required.

Status Text Read to see which:
e  Mode has been selected and

e Time filter is being applied to the data

Mode Click to display a menu of options to change the mode of the Audit View.
Select:

e 'Standard' - to automatically synchronize with the Project Browser; where
changes have been made, the Audit View reflects your selection from the
Project Browser - if you click on:

- An element, the Audit View displays the history for that element

- A Package, the Audit View displays the history for that Package and its
immediate children (but not the contents of nested Packages)

- A diagram, the Audit View displays the history for that diagram and its
contents (which could be drawn from a wide area of the Project Browser)

e 'Advanced' - to load large sets of log items independent of the Project Browser;
in this mode, a special Audit Settings group can be displayed in the Audit Tree,
which records:

- When Auditing has been enabled and disabled

- Who made the change

- The date and time of the change

- Changes to the Audit Settings

- When Audit Operations are executed

- Security changes (which can be browsed in the same way as other changes)

e 'Deleted' - to display only deleted records, but otherwise data is shown as in
Advanced mode; records can be sorted by element type or by user as required

e 'Raw' - to display all audit records in chronological order without sorting,
enabling you to see a progression of changes; this can be especially useful in
determining date-time inconsistencies
Any search and filtering you define still apply, enabling you to view all of
today’s changes in order, or all changes for a particular element in order, or
both
Additional database information is displayed; this additional information might
be insignificant or only in machine-readable format
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Audit History Tab

When Auditing is turned on, an 'Audit History' tab is enabled in the System Output window. The tab shows a history of
changes to whichever element or connector you have selected in the:

e Current diagram

® Project Browser
e Audit View, or

e Package Browser

As you select different elements or connectors, the 'Audit History' tab automatically updates to reflect your current
selection. For each change made to the element or connector, the tab shows:

e Who made the change

e When the change was made

e Where the change was made

e  The value of the characteristic before the change

e  The value of the characteristic after the change

Access
Ribbon Show > Window > System Output > Audit History
Menu View | System Output > Audit History

Notes

e To see this tab, you must have the Audit View open; the tab continues to display if you subsequently close the Audit
View

e If security is enabled, you must have Audit View permission to display data on the 'Audit History' tab

(c) Sparx Systems 2015 - 2016 Page 266 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

Auditing Performance Issues

Enabling auditing on a project increases the time taken for most actions.

For most modeling tasks, this increase is insignificant; however, there are some situations where the difference is more
substantial.

Operation Delays

Operation Detail

Large Deletions Deleting large Packages or Package structures, or large numbers of elements, takes
significantly longer with auditing on.

You might disable auditing before performing such a deletion.

XMI Imports Importing XMI takes longer with auditing enabled.
A project-level option is provided for disabling auditing of XMI Imports.

Reverse Engineering Reverse engineering code takes longer with auditing enabled.

A project-level option is provided for disabling auditing of reverse engineering.

Replication You cannot remove replication from a model with Auditing enabled.

If you have to remove replication, disable Auditing and - if prompted to do so -
allow Enterprise Architect to roll back the database version; you can then remove
replication.
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Audit View Performance Issues

The Audit View can cause slow performance, generally because of the volume of records it has to process.

Considerations and Responses

Consideration Detail

Navigating the Project Try setting the time filter to a period in the immediate past, such as Today, Previous
Browser Within Auditing is 24 Hours or Previous Week; this time period updates each time you open or refresh
Slow the Audit View.

Save log items outside the project with the Save Logs button; if you then clear the
logs you have just saved, the load time of the Audit View is reduced.

You can reload logs into the project at any time, using the Load Logs button.

The Audit View is Slow in Try setting the time filter to a period in the immediate past, such as Today, Previous
Loading and Changing 24 Hours or Previous Week; this time period updates each time you open or refresh
Modes the Audit View.

Save log items outside the project with the Save Logs button; if you then clear the
logs you have just saved, the load time of the Audit View is reduced.

You can reload logs into the project at any time, using the Load Logs button.

Navigating the Audit Tree Close the 'Audit History' tab in the System Output window
is Slow
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Package Baselines

Enterprise Architect includes tools to help you manage and review changes to your models over time. These tools apply
the concepts of Baselines, Differencing and Merges.

You use Baselines, Differencing and Merges essentially to compare two snapshots of a specific part of your project, to
capture the differences between them and either roll back or incorporate selected changes or all changes.

Baselines

Enterprise Architect provides a facility to create a Baseline or 'snapshot' of the contents of a selected Package and its
child Packages at a particular point in time; this enables you to later compare that branch of the model at that time with
the current state of the branch.

Baselines are stored in the same XML format as is used for version control, but are stored within the project in
compressed format.

You can also have parallel copies of parts of your model for team development, and create Baselines within each copy to
merge changes into the project master.

Differencing

Differencing (Diff, or Compare) helps you to explore the differences between:
e The current state of a specific part of your project, and

e  Previous or parallel versions captured in a Baseline or an XMI 1.1 file on disk

Merges

Once Differencing is complete, you can merge information from the Baseline into the current project; it is not possible to
go the other way.

You can:

e  Merge information manually, change by change

e Merge information automatically by electing to merge in all changes in one batch procedure
e Revert completely to the original Baseline by importing the stored XMI directly

e  Merge information and elements from a Baseline in a different project, making it possible to keep multiple versions
of a single model in synch

The merge options are available through the toolbar, context menus and the keyboard on the 'Compare Utility' tab, which
shows the results of a comparison.

Visual differences in diagrams

Changes to a model might include:
e Adding or removing elements and connectors on a diagram, or
e Changing the position of elements or the overall layout of a diagram

You might believe that a diagram has changed, and select to compare it with a baseline using a context menu option from
the Project Browser. Alternatively, you might perform a baseline comparison on a Package or a model and select from
the comparison output any diagrams that are flagged as changed.
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Notes

e Package Baseline facilities are available in the Corporate, Business and Software Engineering, Systems Engineering
and Ultimate editions of Enterprise Architect

e  The Enterprise Architect Corporate, Business and Software Engineering, System Engineering and Ultimate editions
provide another facility, Auditing, which you can switch on to perform continuous monitoring of changes across the
project; you can dovetail your use of each facility to meet the range of your change management requirements

e Ifa Package under version control forms part of a Baseline, and that Package is checked in to the model, you cannot
merge the original data from the Baseline into that Package

e You can also obtain a snapshot of selected items in the model, using the Model Views facility; this facility enables
you to automatically generate the snapshot at intervals and, if there are changes in the items collected by the defined
search, to trigger a notification to you of such changes, which enables you to monitor workflow and other events of
concern to you

e Ifsecurity is enabled you must have 'Baselines - Manage' permission to create, import and delete Baselines, and
'Baselines - Restore' permission to merge data from a Baseline; security permissions are not required to select an
existing Baseline and perform a comparison with the model
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Baselines

Enterprise Architect provides a facility to 'Baseline' (snapshot) a model branch at a particular point in time for later
comparison with the current Package state.

Baselines

Baseline comparison is most useful for determining the changes made to the model during development compared to
some Baseline saved at a crucial point - for example the completion of a phase or version iteration.

More than one Baseline can be stored against a single Enterprise Architect Package.

Baselines are particularly useful during requirements management to check for changes, additions and deletions that
have occurred since the start of the current work phase; knowing how a model has changed is an important part of
managing change and the overall development process.

Baselines are stored within the model in compressed XML format; you can save a Baseline to an external XML file for
storage or archive, or for distributing to other users working on models derived from a master project.

Baselines are generally used in conjunction with the Compare utility.

Scenario

A typical scenario for using Baselines would be:

e C(Create the base model branch to a sufficient point to create a Baseline (checkpoint); create and store the Baseline as
Version 0.1a

e As work continues on development, managers and developers can check the current model branch against the
Baseline for important modifications, additions and deletions; the Compare utility can be invoked from the Baseline
dialog to check the current model branch against the stored version

e Asrequired, minor Baselines can be created to check recent progress; these 'temporary Baselines' are useful for
managing change when a lot of work is being done and it is important to only see what has changed in, for example,
the last 24 hours

At sign-off or the move to a new version/phase, a major Baseline can be created to capture the new state of the model.

Minor Baselines created earlier can be deleted if required to save space

Considerations

e Baselines are based on the GUID or unique ID of a particular Package:
e  Enterprise Architect checks for that ID as the root element within the XML document being used as a Baseline

e  When you export a Package to XML, the Package you export is the root element; likewise when you create a
Baseline, the current Package is the root Package of the XML Baseline

e When you save information in a version control system, the current version-controlled Package is again the root
Package of the document

e [t is not useful to create a Baseline by importing an XMI Package file created by version controlling a Package that
itself contains version-controlled child Packages; that type of XMI Package file contains stubs for the child
Packages, not full information on the child Packages and elements

e [f a Package under version control forms part of a Baseline, and that Package is checked in to the model, you cannot
merge the original data from the Baseline into that Package

XML files must be in the same format used by the Baseline engine - currently the UML 1.3 XMI 1.1 format (plus
Enterprise Architect extensions), which contains all the information necessary to reconstruct a UML model, even a UML
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2.x model

Notes

e The Baseline facility is available in the Corporate, Business and Software Engineering, System Engineering and
Ultimate editions of Enterprise Architect

e  The Compare utility is available in the Professional edition of Enterprise Architect, as well as in the Corporate and
extended editions above
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Manage Baselines

Enterprise Architect provides a range of facilities for working with and managing Baselines.

Access
Ribbon Design > Tools > Baselines > Manage Baselines or
Design > Package > Manage > Baselines
Context Menu Right-click on Package > Package Control > Package Baselines
Keyboard Shortcuts Ctrl+ Alt+B

Baseline Management

Create, select and process Baselines using the 'Package Baselines' dialog.

Field/Option Action
Current Baselines For Review the Baselines for the current model branch, listed by version reference with
Package: <Name> the highest alphabetical/numerical value at the top.

If an entry is longer than the display area, a horizontal scroll bar displays at the
bottom of the panel; use this to scroll to the text that is not shown.

Show Differences Run the Compare utility on the selected Baseline and the current model branch or
diagram, to display the differences between the two.

Restore to Baseline Completely restore the model branch from the selected Baseline.

New Baseline Create a new Baseline.

Delete Selected Delete the selected Baseline.

Load Other Baselines Display a drop-down menu that enables you to load Baselines from another model,

in either a project file or a DBMS repository.
e  For project files, a browser displays; locate the required project file

e For DBMS repositories, the Windows 'Data Link Properties' dialog displays;
select the data provider and click on the OK button to display the 'Select Data
Source' dialog, from which you select the required project

In either case, the Connected To: message at the bottom of the 'Package Baselines'
dialog changes to the name of the alternative model.

To return the dialog to the original project, select the third option on the drop down
list: 'Load From Selected Package'.

Import File Import an XML 1.1 file from the file system as a new Baseline for this current
model branch.
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Export File Export the selected Baseline to an XML file on disk.

Compare Model to File Compare the selected model branch with an XML 1.1 file on disk; a browser
displays, which you use to locate the file.

Options Set filters to make the comparison more specific.

Notes

e Package Baseline facilities are available in the Corporate, Business and Software Engineering, Systems Engineering
and Ultimate editions of Enterprise Architect
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Create Baselines

This topic details the basics of creating new baselines of Model Packages.

Access

Select a Package in the Project Browser, then open the 'Baselines' dialog using one of the methods outlined below.

In the 'Baselines' dialog, click the New Baseline' button.

Ribbon Design > Tools > Baselines > Manage Baselines : New Baseline or

Design > Package > Manage > Baselines : New Baseline
Context Menu Right-click on Package > Package Control > Package Baselines : New Baseline

Keyboard Shortcuts Ctrl + Alt + B : New Baseline

Create a new baseline

Field Action
Name Display the Package name of the currently selected model branch.
Version Type a unique version reference for this Baseline, which can consist of any

alphanumeric characters.

The 'Package Baselines' dialog sorts the Baselines according to the value of this
field.

Include Sub-packages Include the entire sub-Package hierarchy of this branch in the Baseline; this option
defaults to selected.
If you deselect the checkbox, only the immediate contents (XMI stubs) of the
Package are included in the Baseline.

Note Edit the default current time and date to any other value.
The field is a single-line entry, for display on the 'Package Baselines' dialog (a

one-line-per-entry list).

OK Click to create a new Baseline and return to the 'Package Baselines' dialog.

Notes

e  Package Baseline facilities are available in the Corporate, Business and Software Engineering, Systems Engineering
and Ultimate editions of Enterprise Architect
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The Compare Utility (Diff)

Enterprise Architect has a comprehensive and powerful built in Compare (diff) utility, which enables you to:
e Explore what has changed within a model over time
e Explore how previous versions of a model branch differ from what is currently in the model

e Perform a full model comparison by exporting all of Model A to XMI, then using 'Compare Model to File' from
within the current model (Model B)

Comparing and checking model development at various points in the process is an important aspect of managing change
and development, monitoring what is being modified and ensuring the development and design process is on track.

Using the Compare Utility you can:

e  Compare a model branch in Enterprise Architect with a Baseline created using the Baseline functionality (Corporate,
Business and Software Engineering, System Engineering and Ultimate editions)

e  Compare a model branch in Enterprise Architect with a Baseline stored in a different model

e Compare a model branch in Enterprise Architect with an XML 1.1 file on disk created previously using the
Enterprise Architect XML export facility (user selects file)

e Compare a model branch in Enterprise Architect with the current version-controlled XMI 1.1 file on disk as created
when using Version Control in Enterprise Architect (file automatically selected)

Access

Select a Package in the Project Browser, then open the 'Baselines' dialog using one of the methods outlined below.

In the 'Baselines' dialog, click the 'Show Differences' button.

Ribbon Design > Tools > Baselines > Manage Baselines : Show Differences or

Design > Package > Manage > Baselines : Show Differences

Context Menu Right-click on Package > Package Control > Package Baselines : Show
Differences or

Right-click on Package > Package Control > Compare with XMI File (for package
not under version control) or

Right-click on Package > Package Control > Compare with Controlled Version (for
package under version control)

Keyboard Shortcuts Ctrl + Alt + B : Show Differences

Differencing With Baselines

As a Baseline is stored within a model and contains all the information, elements and connections for a Package at a
point in time, it can be used within Enterprise Architect to track changes to model elements over time.

The Differencing engine first builds a representation of the current Package in memory, based on what is currently in the
model.

It then compares this with the stored Baseline, highlighting changes, new elements, missing elements and elements that
have been moved to other Packages.

It is possible to filter the resultant output to display only one particular kind of change: for example, additions to the
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model.

If a Baseline has been created to ignore child Package content, a comparison between that Baseline and the model does
not include any child Package content in the model.

See the Example comparison.

Notes
e  This utility is available in the Professional, Corporate, Business and Software Engineering, System Engineering and

Ultimate editions of Enterprise Architect

®  You cannot compare the current model with an XMI 2.1 file; the utility can only compare with an XMI 1.1 file
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Compare Options

You use the 'Compare Options' dialog to refine the output of the Compare utility when it compares the current model
with a Baseline.

To display the dialog, either:
e  Click on the Options button on the 'Package Baselines' dialog, or
e  Click on the 'Compare Options' icon on the 'Compare Utility' tab toolbar

If the 'Compare Utility' tab shows the results of a Baseline comparison, when you click on the OK button the display
refreshes to refine the information according to the options you have selected.

Notes

e Package Baseline facilities are available in the Corporate, Business and Software Engineering, Systems Engineering
and Ultimate editions of Enterprise Architect

Options

Option Action

Always Expand to Always display the list of elements fully expanded to show changes.

Differences If you deselect the checkbox, when the 'Compare Utility' tab is first opened it lists

the Package contents to element level, and you expand each element as required to
show the changed items.

For large branches of the model, it is better to leave the checkbox unselected.

Show Elements that are List elements that:
e Have been changed since the Baseline was created

e Are in the Baseline only (that is, have been deleted from the model since the
Baseline was created)

e  Are in the model only (that is, have been created since the Baseline was
created)

e Have not changed since the Baseline was created (you might generally leave
this checkbox unselected)

Suppress these Changes Exclude:
e  Changes to diagrams
e  Changes to the 'Date Modified' field for an item
e Changes to the Date Created' field for an item
e  Child items of a deleted item
e  Changes to advanced properties (defaults to selected)

Baseline Diagram Compare Select the checkbox to always open the first parent Package for which there is a
Options Baseline, when you select the diagram for comparison from the Project Browser.
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Check Visual Changes to Diagrams

The Baseline Diagram Compare feature is a quick and easy way to visually compare a current diagram with an earlier
version from a saved Baseline, and highlight any elements in the diagram that have been added, deleted, resized or
moved.

You can then review these changes and optionally roll back each change if needed to its previous state from the Baseline.

The changes are identified on the 'Baseline Diagram Compare' dialog and on the diagram itself. If the diagram is not
already open, the compare feature also opens the diagram.

Access
Ribbon Layout > Diagram > Manage > Compare to Baseline
Menu Package > Baselines > <select baseline> : Show Differences > Locate and
right-click on diagram name > Compare to Baseline
Context Menu In Project Browser - Right-click on Package > Package Control > Package
Baselines > <select baseline> : Show Differences > Locate and right-click on
diagram name > Compare to Baseline
In Project Browser - Right-click on Diagram > Compare Diagram to Baseline
In open Diagram - Right-click on diagram background > Advanced > Compare
Diagram to Baseline
Processing

In two of these access paths, you perform a comparison of a Package and Baseline, and then select the diagram from the
results on the 'Baseline Comparison dialog' to display the 'Baseline Diagram Compare' dialog. Refer to the Results
section and the Options table.

In the other access paths, you first select the diagram to check, and then might have the option of selecting the Package
from which to use a Baseline, on the 'Load Baselines from Package' dialog.
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P ™y
Load Baselines from Packigi ﬁ

Mare than one Package contains a Baseline for this Diagram.
Choose a Package containing the Baseline you wish to
compare with.

Packages without a Baseline appear with a faded image.

(=) || Management Project
= | 5] Class Model
i _| Pa::kage.ﬁ.

Always open first parent with a Baseline
Mote: Option can be disabled from "Manage Baselines” | Options”

QK Cancel Help

This dialog displays if you have NOT selected the:

e 'Always open first parent with a Baseline' checkbox on the dialog itself or

e 'Baseline Diagram Compare Options' checkbox on the 'Compare Options' dialog
(Selecting or clearing one of these checkboxes resets the other one as well.)

When you create a Baseline, it can be for a Package that contains one or more levels of child Package, and you might
create Baselines for the Package(s) at each level. If the diagram you are checking is at a lower level in the hierarchy,
there might therefore be a number of Baselines that contain information on the diagram, perhaps taken at different times
and capturing different changes to the diagram. The 'Load Baselines from Package' dialog provides the facility to
compare the diagram with one of a broader range of Baselines than just those from the diagram's immediate parent.

Click on the Package, and click on the OK button. In this case, or if the dialog did not display at all (the checkboxes
were selected), the 'Baselines dialog displays.

Click on the required Baseline and on the Show Differences button. The 'Baseline Diagram Compare' dialog displays.
Refer to the Results section and the Options table.

Results

The 'Baseline Diagram Compare' dialog shows the elements that have been changed on the diagram, and what kind of
change was made ('Status' field).
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- ™

Select an Element below to display how it differs from the active Baseline on the Diagram.
To revert an item to the Baseline click the check box and click OK or Apply.

Diouble click an item to center Baseline Object in Diagram, Ctd + Dbl click for Model Objects.

Mame Status Action -
|:| [D «testcases Order 5., Changed
_;:l F{eq-Load Stress3 Baseline anly
|:| F{eq-Load Stress2 Baseline only
= Req - Load Stress1  Changed
[] [ view Basket Test Madel only
|:| [‘Ea [external reference] Element not found in baseline

Visually link new and old position for checked tems.

Check Al

As you select elements on the dialog, images are shown on the diagram itself to indicate where the changed element was
and what kind of change it underwent.

Options
Option Detail
Select (click on) name of The 'Status' column indicates whether the element has been:
clement e Moved or re-sized (Changed)

e Deleted from the diagram (Baseline only)
e  Added to the diagram since the Baseline was captured (Model only), or

e Deleted from its parent external Package, and there is no record in the current
Baseline (because the Baseline is only for the current diagram's parent
Package)

This diagram-linked element has been deleted from the model. The element
might be found in a different baseline either in a parent Package baseline or a
different Package baseline outside of the current Package. If the external
referenced element is restored to the model, the visual comparison will be able
to resolve the missing diagram object in the current baseline.

When an item is selected, the corresponding element on the diagram is highlighted
as shown:

e Deleted from the diagram

e  Added to the diagram
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Position the diagram to
show the selected element

Leave the changes in the
item as they are

Roll the changes back to
the Baseline position
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The highlighted element on the diagram is marked with a colored dot, as shown, to
indicate that it is in focus.

To scroll the diagram so that you can see the original (Baseline) position of an
element, double-click on the item in the list.

To scroll the diagram so that you can see the current (model) position of the
element, press and hold Ctrl while you double-click on the item.

Ensure that the checkbox against the item is not selected.
Click on the OK button.

Click on the checkbox against each required item (or click on the Check All button
to select every item).

The 'Action' column displays the action required to roll each element's relationship
to the diagram back to the Baseline relationship, and on the diagram the selected
elements are represented as shown:

e This deleted element will be restored

e This added element will be removed
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e This element from another Package, deleted from the diagram, cannot be
restored from this Baseline
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The comparison automatically shows a blue direction arrow for each reposition or
resize that has been checked. For a heavily edited diagram this might be confusing.
However, you can hide the arrow for all elements except the one currently in focus;
to do this:

e Deselect the 'Visually link new and old position for checked items' checkbox
To roll back the changes for all items for which a checkbox is selected:
e  Click on the Apply button

Notes

e Diagram Baseline facilities are available in the Corporate, Business and Software Engineering, Systems Engineering
and Ultimate editions of Enterprise Architect
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This diagram shows the result of a comparison between a Package (Log in/out Use Cases) in the current project and that
Package in a Baseline captured at an earlier date.

The results of the comparison are displayed on the 'Baseline Comparison' tab.
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Model Elements Property Maodel Bazeline
= ] Loginfout Use Cases Abstract False false
t& Aot Alia=s
IE Actor? Authar rchester rchester
Date Created 470972013 24750 PM 4/08/2013 2:47:50 PM
f@ Delete Cells Date Modified 7102013 11:37:55 AM 5/09/2013 2:35:04 PM
Complexity 2 1
Filername
Language <None: <none:
|sLeaf false false
lz5Spec falze false
|sRoot false false
Keywords
Multiplicity
Mame Actor? Act?
Motes

Parent Package

Persistence

Log infout Use Cases Login/out Use Cases

Review Changes

Aspect Description

Interpretation A hierarchy of model elements is displayed in the left-hand pane.

It is clearly visible, from the triangle-based icons and the highlighted lines on the
report, which items in the hierarchy have, since the Baseline was captured, been:

e Changed

e Deleted from the model (in the Baseline only)

e  Added to the model (in the Model only) or

e Switched to different Packages (changes in the Parent Package property)

If you click on an item in the left hand pane, the right-hand pane displays a table of
properties showing the values of those properties in the current model and in the
Baseline.

For each property where there is a difference between the model and the Baseline,
the row is highlighted.

The 'Compare Utility' tab enables you to perform operations (such as merging or
rolling back changes) on the reported information, using the toolbar, context menu
and keyboard.

Increase Level of Detail The right panel of the 'Compare Utility' tab might, for some fields, display only part

of the value.
It might also not be immediately obvious what a change is.

In either case, you can double-click on the property to display full details and to
highlight the exact differences; this example shows the highlighted changes to the
'Name' property.
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Model Baseline
Actor2 Act?

Notes

e The Compare utility is available in the Professional, Corporate, Business and Software Engineering, Systems
Engineering and Ultimate editions of Enterprise Architect
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Baseline Comparison Tab Options

The "Baseline Comparison' tab enables you to perform operations on the reported information, using the toolbar, context
menu, 'Merge' dialog and certain keyboard keys.

Toe bt e A E T @

The toolbar is at the top of the left-hand panel; the icons operate either on the comparison as a whole or on the
currently-selected item in the left hand panel of the 'Baseline Comparison' tab

Each item in the hierarchy has a context menu, which you display by right-clicking on the item; the options
displayed depend on the level of the item in the hierarchy

The 'Merge' dialog enables you to specify which changes to roll back in the model from the baseline

You can use a selection of keyboard keys to move up and down the hierarchy, or to roll back changes

Toolbar Options

Context Menu Options

(c) Sparx Systems 2015 - 2016

Option
Refresh
Merge To Model
Next Change
Previous Change
Expand All
Collapse All

Expand To Changed Items

Find in Project Browser

Log To XML

Compare Options
Manage Package Baselines

Help

Action

Re-run the comparison to refresh the current display.

Merge the values of the currently-selected item in the Baseline back into the model.
Highlight the next changed item (this skips Moved items).

Highlight the previously-changed item.

Fully expand the selected item.

Collapse the changed items in the selected item.

Expand the selected item to show changed items only (in the event that you have
selected to also show unchanged items in the comparison).

Highlight the item in the Project Browser.

Log the changes to an XML file.

A browser displays, on which you specify the file name and location.
Display the 'Compare Options' dialog.
Display the 'Package Baselines' dialog.

Display the Help topic Package Baselines.
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Option Action
Merge from Baseline Restore the item in the model to the Baseline state, or restore a deleted item from
Add from Baseline the Baseline.
Delete from Model Remove a recently-created item from the model.

Merge From Baseline (with (For the root node of the hierarchy on the 'Compare Utility' tab.)

Options) Display the 'Merge' dialog, which you can use to specify options for rolling back

the whole model branch to the Baseline state.

Refresh (Object-level items.)

Re-run the comparison to refresh the current display.

Find in Project Browser Locate and highlight the item in the Project Browser.
Open Baseline Diagram (For a diagram listed in the comparison.)
Compare

Display the Baseline Diagram Compare window, showing differences in diagram
content and layout.

Expand All Fully expand the selected item.
Expand To Changed Items Expand the selected item to show changed items only.
Collapse All Collapse the changed items in the selected item.

Log To XML Log the changes to an XML file.

A browser displays, on which you specify the file name and location.

Compare Options Display the 'Compare Options' dialog.

Merge Dialog Options

Field/Button/Option Action
Changed Restore all changed items in the model branch to the Baseline state.
In Baseline Only Restore all deleted items to the model branch from the Baseline.
In Model Only Remove all recently-created items from the model branch.
Moved Restore all moved items to their original locations, as identified in the Baseline.
Full Restore from XMI Completely restore the model branch to the version held in the Baseline XMI 1.1

file, (using the 'XMI Import' function).

(This option automatically selects all the other options)
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Keyboard Keys

e Ctrl+ | - expand and highlight the next changed item
e Ctrl+ 1 - expand and highlight the previous changed item

e  Ctrl+ « - undo the changes for a selected item (roll back to the Baseline values)
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Compare Projects

A number of operations can make changes to your project that you either want to monitor carefully or not have at all.
Such events include:

e Recovering from a database crash
e Restoring a backup

e  Performing a Project Data Transfer
e Importing from XMI, and

e Deleting model elements

You might have made a copy of the original project or the purpose of the operation is to generate a copy, in which case
you can compare the size and row counts of the 'before’ and 'after’ copies as a convenient 'sanity check'. The copies can
be on different platforms; you have options to:

e Compare a project file to another project file
e  Compare a project file to a DBMS-based repository
e Compare two DBMS repositories

The comparison examines the number of project rows in each database, producing a report indicating the total records in
each and the difference in record count between the two. If discrepancies are found, you must investigate further
manually. The comparison does not examine the actual data in the tables.

Access
Ribbon Configure > Model > Check Integrity > Project Compare
Menu Project > Data Management > Project Compare

Compare two projects

Step Action

1 On the 'Project Compare' dialog, select the radio button for the database types of the two projects you
want to compare:

e _EAPto .EAP

e DBMS to .EAP
e _EAP to DBMS
e DBMS to DBMS

2 In the 'Source Project' and 'Target Project’ fields, type the name or connection string for the source and
target projects to compare.

3 Click on the Compare Projects button.

The results of the comparison display in the panel at the bottom of the dialog.

4 If you want to print the results of the comparison, click on the Print List button.
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Project Maintenance

The repository is an important data store that must be maintained to ensure that it is running efficiently and that the
information it contains has integrity. Enterprise Architect has built-in features that allow you to keep the repository in
good health. These include tools to maintain the database itself, such as Repair and Compact functions (for file based
repositories), and a series of tools to manage the data and models, such as model validation and data integrity checks.
Reference data can be imported and exported from the repository which can be shared between repositories ensuring
consistency. The Project Browser allows repositories to be refactored easily by dragging and dropping Packages,
elements, features and diagrams to new locations. The Element Discussion and Team Review features allow the model
to be critically analyzed and reviewed.

Topics
Topic Detail

Check the integrity of the If you have a failed XMI import, network crash or other unforeseen event that could

data in a project disrupt the integrity of information in the model, it is recommended that you run a
Project Integrity Check.

Reset Auto Increment XMI Import/Export can affect the table auto increment column values and push

Columns in Tables them towards the maximum datatype value; you can re-sequence the columns to
avoid this problem.

Upgrade an old project to The structure of Enterprise Architect project files is occasionally changed to

enable use of new features support more features; when this happens, existing project files must be upgraded
to the new format to ensure correct operation and to take advantage of all the new
features.

Rename a project If you want to rename an Enterprise Architect project, you can do so through
Windows Explorer.

Compact a project After some time, a project .EAP file might benefit from compacting to conserve

space.

Repair a project if it did not If a project has not been closed properly, such as during system or network outages,
close properly on rare occasions the .EAP file does not re-open correctly.

Notes

®  You only rename, compact and repair models created as .eap files; these processes are not required for models stored
in a DBMS
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Check Project Data Integrity

If you have a failed XMI import, network crash or other unforeseen event that could disrupt the integrity of information
in the model, it is recommended that you run the Project Integrity Check function to check that your project data is
structurally complete.

You can select a variety of items to check. The integrity check examines all database records and ensures there are no
'orphaned' records or inaccurate or unset identifiers. This function does NOT check UML conformance, only the data
relationships and repository structure.

You can run the integrity checker first in report mode to discover if anything should be corrected, and then run it again in
'recover/clean’ mode.

When Enterprise Architect 'cleans' the model, it attempts to recover lost Packages and elements, and generates a new
Package at the model root level called recovered . Check through any elements that are found and, if required, drag
them into the model proper. If they are not required, delete them.

Access
Ribbon Configure > Model > Check Integrity > Project Integrity
Menu Project > Data Management > Project Integrity Check

Check the data integrity of your project

Step Action

1 Open the project.

2 Select the 'Project Integrity Check' menu option.
The 'Project Integrity Check' dialog displays.

3 Select the checkbox for each check to run:
e Package Structure
e  Object Structure
e  Object Features
e All GUIDs
e Cross References
e  Connectors
e UML 2.0 Migration

4 Select either:
e The 'Report Only' option to just view a report on the state of your model, or

e The 'Recover/Clean' option to recover and clean your project; before selecting this option back up
your project file first

5 To write a log of the integrity check, click on the Save Results button and select a log file.
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6 Click on the Go button to run the check.
If you want to display the resulting information in a more readable layout, you can resize the dialog and
its columns.

UML 2.0 Migration

The UML 2.0 Migration check enables you to migrate the project from UML 1.3 semantics to UML 2.0 semantics. The
migration process currently converts activities that are invocations of operations into called operation actions as per the

UML 2.0 specification.

The UML 2.0 Migration option is an exclusive process that does not enable any of the other checks to be selected. When
you click on the Go button to perform the migration, a prompt displays for you to confirm the operation.

Notes

e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have Check Data Integrity permission to perform a data integrity check
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Reset Table Auto Increment or Identity Columns

This topic explains possible impacts of XML Export/Import on table auto increment columns, and how to re-sequence
the columns whose value approaches the maximum datatype value.

Topics

Topic Detail

XML Export/Import XML Export/Import can cause gaps in the numbering sequence of auto increment
columns.

Each XML Import deletes rows from several tables; the import then adds rows
starting from the maximum value of the auto increment column.

Repeated XML imports can result in the value of the auto increment approaching
the maximum value of the database datatype; for example, SQL Server's int
datatype has a maximum value of 2,147,483,647.

Replication Large auto increment values can also arise where the project originated as an EAP
replica or design master.

The Jet engine assigns random values for auto increment columns with each XML
Import into the project.

These random values can approach the maximum range of the repository data type,
which could present a problem when the EAP project is transferred to a repository.

Access

Ribbon Configure > Model > Check Integrity > Reset IDs

Menu Project > Data Management > Reset IDs

Re-sequence auto increment columns

Step Action

1 Open the project.

2 Select the 'Reset IDs' menu option.
A dialog displays listing all non-empty tables that contain an auto increment or identity column.
e The 'Rows' column shows the number of rows in the table
e The 'Maximum ID' column shows the current maximum value of the auto increment column

e The 'Action' column shows either No Action' or 'Reset', depending on how close the column value is
to the datatype's maximum
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Tables requiring a reset are automatically selected in the list.

3 Click on the Go button to reset the auto increment column values.

Notes

e Connection to the project must be via a direct connection; IDs cannot be reset while the connection to the repository
is via Cloud Services

e Project Auditing must be disabled before IDs can be reset

e  MySQL repositories will require re-starting of the MySQL server so that the reset auto increment columns start from
the reset value

e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have Check Data Integrity permission to reset IDs
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Upgrade a Project

The structure of Enterprise Architect project files is occasionally changed to support more features. In such cases, the
project might have to be upgraded. Upgrading to the new file structure is a simple and quick process that brings your
project to the current level to:

e  Ensure correct operation and

e Support all the latest Enterprise Architect features

Initial Check

When you load a project that was created in an earlier release of Enterprise Architect (for example, an archived project)
using a recent release of Enterprise Architect, the system determines whether the project should be upgraded and, if the
upgrade is necessary, displays the Upgrade Wizard.

The Upgrade Project Wizard

The Upgrade Project Wizard takes you through the upgrade process and:

e Advises you of the necessity to upgrade

e  Advises you to back up the current project; it is essential to back up before any changes are made
e  Checks which upgrade path is required

e Guides you through the steps to perform the upgrade

e  Opens the newly converted project

Notes
e Ifyou are using replication in your models, and the upgrade wizard detects that the project you are opening is a

replica and not a Design Master, a different upgrade path is required

e Once upgraded, the project cannot be opened with the version of Enterprise Architect in which it was created
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Upgrade Replicas

Models that have replication features added might have to be upgraded differently from regular projects.

e Ifthe model is a Design Master (the root model of all other replicas) then you can upgrade the model to suit the
current version of Enterprise Architect; after upgrading a Design Master you should re-create the replicas, rather
than synchronizing

e If the model is not a Design Master, you must first remove the replication features, then upgrade the project in the
normal manner; the Upgrade Wizard guides you through the steps
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Run SQL Patches

Occasionally, Sparx Systems might release a patch to correct a model fault.

The patch generally checks how many records are to be updated, and reports on what is to be done.

Access
Ribbon Configure > Model > Check Integrity > Run Patch
Menu Project > Data Management > Run Patch
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Rename a Project
If you want to rename a project, you can only do so at the Windows file system level, using Windows Explorer.

Rename an Enterprise Architect project file

Step Action
1 If you have the project open, close it.
2 Ensure no other users have the file open.
3 Open Windows Explorer and navigate to the project.
4 Rename the project file using Windows Explorer.
5 You should keep the file extension to preserve compatibility with the default project type, as installed in
the registry at installation time.
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Compact a Project

After a period of time, through general use, a project .eap file might occupy more disc space than necessary. You can
move the project to a local drive and compact the file to recover the unused space.

Access
Ribbon Configure > Model > Check Integrity > Manage .EAP File > Compact .EAP File
Menu Project > Data Management > Manage .EAP File > Compact .EAP File

Compact a project

Step Action

1 If you have the project open, shut it down.

2 Ensure no other users have the file open.

3 Select the 'Compact .EAP File' menu option.

4 Follow the on-screen instructions to complete the process.
Notes

e  Always compact projects on a local drive, never on a network drive

e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have Administer Database permission to compact a project
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Repair a Project

If a project has not been closed properly, such as during system or network outages or on poor network connections, on
rare occasions the .eap file does not re-open correctly. A message displays informing you the project is of an
unrecognized database format or is not a database file. In such cases, you can move the project file to a local drive and
repair it.

Access
Ribbon Configure > Model > Check Integrity > Manage .EAP File > Repair .EAP File
Menu Project > Data Management > Manage .EAP File > Repair .EAP File

Repair a project that was not closed properly

Step Action

1 Ensure that all users are logged off the project you are attempting to repair.
2 Copy the project file to a local drive on your workstation.
3 In Enterprise Architect, select "Tools | Options' to display the 'Options' dialog.

On the 'General' page, deselect the 'Use Jet 4.0 - requires restart' checkbox.

4 Close and restart Enterprise Architect - you do not need to open any model, including the one you are
repairing.
5 Select the 'Repair .EAP File' menu option, and follow the on-screen instructions.
6 Once you have repaired the project, it is recommended that you perform a data integrity check.
Notes

e Always repair projects on a local drive, never on a network drive
e The 'Compact a Project' option can also repair corrupt .eap files

e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have Administer Database permission to repair a project
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Reference Data

Reference data is used in Enterprise Architect to provide meta-information for the modeler, and is often seen in drop
down lists and selection boxes. It includes such things as status codes, requirement types, model authors and more.

For convenience Enterprise Architect comes pre-configured with useful reference data, but it is best practice to review
this existing data when setting up a project and either replace or edit it to ensure it is appropriate for the project.

There are a number of different types of reference data, some of which applies at a repository level such as status codes
and authors, and other data that is more technical in nature such as code engineering and database datatypes.

The reference data can be copied between repositories by exporting it from one repository and importing it into another;
this mechanism can save time and ensure consistency between repositories.

Project reference data can be entered and edited through the Project | Settings... menu and includes:

e  Stereotypes

e Tagged Value Types

e Cardinalities

e People

e  General Types

e Project Indicators

e  Estimation Factors

e  Datatypes

Notes

e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise

Architect, if security is enabled you must have Manage Reference Data - Update permission to update and delete
reference items
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Using the '"UML Types' dialog you can configure stereotypes, Tagged Value types and the cardinality list for your
project. In more detail, you can:

e Add, modify and delete stereotypes

e  Customize stereotypes appearance

e Updating shape scripts and metafiles associated with Stereotypes

e (Create/modify tagged values

e  Define cardinality rules

Access
Ribbon Configure > Reference Data > UML Types
Menu Project | Settings | UML Types
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Stereotype Settings

Enterprise Architect has an extensive set of Standard Stereotypes that you can apply to any UML construct. Using the
'Stereotypes' tab of the ' UML Types' dialog, a Technical Developer can also customize the stereotypes for your project
by adding, modifying and deleting them. For information on customizing stereotypes, see the Custom Stereotypes Help
Topic.

Stereotypes can be modified to make use of metafiles (image files) or customized colors, or to make use of the Enterprise
Architect Shape Scripts to make new object shapes to determine the shape and dimensions of the object.

Access
Ribbon Configure > Reference Data > UML Types
Menu Project | Settings | UML Types > Stereotypes

Manage Stereotypes

Field/Option/Button Action

Stereotype Type in the name of the new stereotype, or click on an existing stereotype in the list
in the right-hand panel.

Group name For a stereotype that applies to an element feature (an attribute or operation) type in
a name under which to group the features that have the stereotype. This is shown on
diagrams in the attributes or operations compartment of the element.

If you do not provide a group name, the label in the feature compartment defaults to
the stereotype name.

Base Class Click on the drop-down arrow and select an object type, so that the stereotyped
object will inherit the base characteristics from that existing object type.

Notes Type in any notes concerning the stereotype (and not the objects to which the
stereotype is to be applied).

None Select this radio button to use the default object appearance.

Metafile Select this radio button to use an image file for the appearance of the stereotyped
object.

Shape Script Select this radio button to apply a custom shape to the stereotyped object, which

you define using the Enterprise Architect Shape Scripting language.

Assign Click on this button to select or define the associated metafile or Shape Script to be
applied to the stereotyped object.

Remove Click on this button to remove the associated metafile or Shape Script from the
stereotype.
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Fill Click on the drop-down arrow and select a default color for the background of the
object.

This color will be applied to all occurrences of any object to which the stereotype
has been applied; if the color is subsequently changed, the change is immediately
applied to all occurrences of any object to which the stereotype was applied (as for
changes to any other property of the stereotype).

However, on elements created with the stereotype, the default color might be
overridden by other color definitions of a higher priority that have been applied to
the element, such as the Format Toolbar fill definition or the 'Alternative
Appearance' dialog (F4) definition.

Border Click on the drop-down arrow and select a default color for the object border.
Font Click on the drop-down arrow and select a default color for the stereotype font.
Reset Click on this button to reset the stereotyped object appearance definition to the

default object appearance.

Preview Provides a visual representation of the stereotyped object definition.

New Click on this button to clear the dialog fields so that you can define another
stereotype.

Save Click on this button to save the stereotype definition and add it to the list of current
stereotypes.

Delete Click on this button to immediately remove the selected stereotype from the list of

defined stereotypes.
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Shape Editor

A Technology Developer can use the Shape Editor to specify custom shapes via a scripting language; that is, to create
Shape Scripts. These custom shapes are drawn instead of the standard UML notation. Each script is associated with a
particular Stereotype, and is drawn for every element of that stereotype.

Access
Ribbon Configure > Reference Data > UML Types > Stereotypes > [select or specify a
stereotype] : Shape Script : Assign
Menu Project | Settings | UML Types > Stereotypes | [select or specify a stereotype] :
Shape Script : Assign
Reference
Field/Option/Button Action
Format The format in which the script is written.
Import Opens a Windows browser dialog, allowing for a script file to be loaded.
Export Opens a Windows browser dialog, allowing for a script file to be saved.
Edit window The area in which a script can be written.
Preview of main A visual representation of the compiled script. Nothing displays until the Refresh
button is clicked.
Next Shape If a composite shape is defined within the Edit Window, clicking on the Next
Shape button pages through the components of the shape.
Refresh Parses your script and produces a visual example of the shape in the Preview of
main window.
OK Exit from the Shape Editor; don't forget to save your scripts from the 'Stereotype’'
tab.
Notes

e Shape Scripts adopt the same color gradient settings as normal elements, as defined in the 'Standard Colors' page of
the 'Options' dialog

e Ifan element's appearance is modified by a Shape Script, many of the 'Advanced' context menu options for that
element are disabled
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e Once you have finishing writing your Shape Script, click on the OK button; to save the Shape Script you must click
on the 'Stereotypes' tab
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Tagged Value Types

Tagged Values are used in a variety of places within Enterprise Architect to specify additional information about an
element or connector. The 'Tagged Value Types' tab of the 'UML Types' dialog enables a Technology Developer to
rapidly create Tagged Values, using a range of predefined structured Tagged Values to create structured tags that adhere
to a specific format. For example, for model features that use the predefined tag Boolean you can use the Tagged Values
window to assign a value of True or False and no other value.

You can also add default Tagged Value names and create predefined reference data Tagged Value types and custom
masked Tagged Value types.

Any Tagged Value names created display in the drop-down lists of Tagged Value names in the 'Tagged Value' dialogs
for elements, operations and attributes.

Access
Ribbon Configure > Reference Data > UML Types > Tagged Value Types
Menu Project | Settings | UML Types > Tagged Value Types

Create a Tagged Value Type

Field Action

Tag Name Type the new name of the Tagged Value.
Description Type a description of the Tagged Value.
Detail Type any additional information necessary.
New Click to begin creating a new Tagged Value.
Save Click to save the details of a Tagged Value.
Delete Click to delete a Tagged Value from the Defined Tag Types list.
Defined Tag Types A list of previously defined Tagged Values.

Notes

®  You can transport these Tagged Value Type definitions between models, using the 'Export Reference Data' and
'Import Reference Data' options; Tagged Value Types are exported as Property Types
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Cardinality

The 'Cardinality Values' tab of the 'UML Types' dialog enables you to add, modify and delete values in the default
cardinality list.

The cardinality values are used to define the multiplicity of source and target elements in relationships. This is the range
of instances of the role that can be active in the relationship; for example, one employee can be assigned to tasks; for the
target role you define the range of instances (such as tasks) the employee could be assigned to.

The cardinality values are also used to define the multiplicity of a Classifying element; that is, the number of instances of
the element that can exist. For example, the Class element 'Building Walls' might have a multiplicity of 2..n, meaning
that at least two walls must exist (to support the roof) but there can be many walls if the building design required it.

The values have these formats:

e * or(.* - zero, one or many instances

e 0..n - zero or up to n instances, but no more than n
e n - exactly n instances

e n.*-n, or more than n instances.

Access
Ribbon Configure > Reference Data > UML Types > Cardinality Values
Menu Project | Settings | UML Types > Cardinality Values

Reference

Field Action

Cardinality Type the new name of the Cardinality Value.
New Type a description of the Cardinality Value.
Save Saves the Cardinality value and adds it to the Cardinality List.
Delete Deletes a Cardinality value from the Cardinality List.
Cardinality List A list of already defined Cardinality values.

Notes

e  You can transport these cardinality values between models, using the 'Export Reference Data' and 'ITmport Reference
Data' options
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In your project, you can set up and configure the people and stakeholders involved in and relevant to this model; that is:

Maintain Authors involved within a project
Define role types that are captured within Enterprise Architect
Record information on project resources

Capture client details associated with the current model

Access

Ribbon Configure > Reference Data > Project Types > People

Menu Project | Settings | Project Types | People

(c) Sparx Systems 2015 - 2016 Page 310 of 353

Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

Project Authors

You can define the people who are working on a project, such as the authors of specific elements.

Access
Ribbon Configure > Reference Data > Project Types > People > Project Author(s)
Menu Project | Settings | Project Types | People > Project Author(s)

Notes

e If you enter multiple names, Enterprise Architect adds them separately and in alphabetical order to the 'Defined
Authors' list; if you then click on one of these names, Enterprise Architect displays that name only in the "Name(s)'
field

e Ifyou type in a role, this is not added to the roles on the 'Project Roles' tab

e You can transport these author definitions between models, using the 'Export Reference Data' and Tmport Reference
Data' options

Reference
Field Action

Name(s) Type the name of the person registered as a Project Author.
If you are using a Windows Active Directory, you can select names from the
directory; click on the LJ button to display the 'Select Users' dialog.
You can also type a list of names separated by semi-colons; this enables you to
define a group of people sharing a role, such as a team of Developers, Testers or
Analysts.
Do not leave any spaces between the names and the semicolons.

Role (Mandatory) Enter the role the Project Author plays in the project (such as
Designer, Analyst, or Architect).
You can type a role name or click on the drop-down arrow and select a role defined
through the 'Project Roles' tab.

Notes Type any additional notes concerning the Project Author.

New Add further Authors.

Save Add the new Author to the Defined Authors list.

Delete Removes an Author from the Defined Authors list.
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Defined Authors Review the Project Authors already defined.
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Select Users

If your company is using a Windows Active Directory, you can select the Project Author names from the local or
corporate-wide directory.

Access
Ribb . , N
fobon Configure > Reference Data > Project Types > People > Project Author(s) : l_J
M . . : : N
ent Project | Settings | Project Types | People > Project Author(s) : U
Reference
Field Action
Object Types... Opens the 'Object Types' dialog, which provides a choice of object types that can be
used.
Locations... Defines the root location from which to begin a search.
Check Names Matches object names listed in the Enter the object names to select section.
Enter the object names to Specify object names to search for.
select
Advanced... Opens the 'Advanced' dialog to provide further search options.
For more information on this dialog, please refer to Windows Help and Support.
Use to

e  Select Project Authors from Windows Active Directory

Notes

e  Multiple Entries can be typed into the 'Enter the object names to select' section; ensure that objects are separated by
semicolons (for example: Name01; Name(02)
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Project Roles

People associated with a project play a role in analysis, design or implementation, such as Application Analyst,
Architect, Developer and Project Manager. Project roles define the activities that resources can undertake.

Access
Ribbon Configure > Reference Data > Project Types > People > Project Roles
Menu Project | Settings | Project Types | People > Project Roles
Reference
Field Action
Role Type or select the name of the role.
Description Type a description of the role.
Notes Type any additional information related to the role.
New Add further Roles.
Save Add the new role to the Defined Roles list.
Delete Removes a role from the Defined Role list.
Defined Roles Review the Project Roles already defined.
The 'Defined Roles' list is available for selection for any element in the model; for
example, you can select roles on the 'Project Authors' page of the 'People’ dialog,
and the Resource Allocation window.
You can also specify other roles on these dialogs, but such roles are not added to
the 'Defined Roles' list.
Use to

e Define role types that are captured within Enterprise Architect

Notes

e Deleting a role has no effect on any Project Author definition having this role; the deleted role becomes a simple text
entry in the Project Author definition
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e  You can transport these role definitions between models, using the 'Export Reference Data' and 'Import Reference
Data' options
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Project Resources

Resources are, for example, project authors, analysts, programmers and architects. That is, anyone who might work on
the system over time, either adding to the model or programming and designing elements of the system outside
Enterprise Architect.

Access
Ribbon Configure > Reference Data > Project Types > People > Project Resources
Menu Project | Settings | Project Types | People > Project Resources
Reference
Field Action
Name Type or select the name of the person listed as a resource.
The resource name is available for use in Resource Management.
Organization Type the name of the organization employing the resource.
Role(s) Type or select the role the resource plays in the project (for example, Designer,
Analyst, Architect).
Phone 1, Phone 2, Mobile, Type the contact telephone numbers for the resource.
Fax
Email Type the email address for the resource.
Notes Type any additional notes on the resource.
Available Resources Review resources that have already been defined.
New Add further resources.
Save Add a new resource to the Available Resource list.
Delete Delete a resource from the Available Resources list.
Use to

e Record information on project resources
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Notes

e You can transport these resource definitions between models, using the 'Export Reference Data' and 'Import
Reference Data' options
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Project Clients

Project clients are the eventual owners of the software system.

Access
Ribbon Configure > Reference Data > Project Types > People > Project Clients
Menu Project | Settings | Project Types | People > Project Clients
Reference
Field Action
Name Type or select the name of the client.
Organization Type the name of the organization that employs the client.
Role(s) Type the role the client plays in the project (for example, Manager, Sponsor).
Phone 1, Phone 2, Mobile, Type the contact telephone numbers for the client.
Fax
Email Type the email address of the client.
Notes Type any additional notes on the client.
Defined Clients Review clients that have already been defined.
New Add details of further clients.
Save Add a new client to the Defined Client list.
Delete Delete a client record from the Defined Client list.
Use to

e Capture client details associated with the current model

Notes

®  You can transport these client definitions between models, using the 'Export Reference Data' and 'Import Reference

(c) Sparx Systems 2015 - 2016 Page 318 of 353 Created with Enterprise Architect



User Guide - Model Repository 15 July, 2016

Data' options
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General Types

When you create or edit the properties of an element, you define the type or status of the property by selecting from a
drop-down list that initially contains system-provided values. You can add to or replace any of these system values with
your own customized values. The properties you can customize are:

e  Status

e Constraint

e  Constraint Status
e Difficulty

e  Priority

e  Test Status

e Requirement

e Scenario

Each of these can be separately managed through the 'General Types' dialog.

Access
Ribbon Configure > Reference Data > Project Types > General Types
Menu Project | Settings | Project Types | General Types
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Status Types

In an element 'Properties' definition, the status of the element in the development management process is defined in the
element 'Status' field. You can select the appropriate value from a drop-down list, which initially contains the system
values:

e Approved

e Implemented
e  Mandatory

e  Proposed and
e Validated

You can add to or replace any of these values with your own custom values. You can also assign a color band to each
status type, and define the types of element that can display those colors.

Access
Ribbon Layout > Diagram > Appearance > Configure Status Colors, or
Configure > Reference Data > Project Types > General Types > Status
Menu Diagram | Appearance | Configure Status Colors, or

Project | Settings | Project Types | General Types > Status

Customize Element Status Types

Field Action
Status Type the name of the status.
Description Type a short description of the status.
Status Type Color Using the drop-down arrow, select a color to be applied to the current status type.
Preview Displays a visual representation of an element with the selected status type color.
Restore Default Restore the status type color to its default setting.
Applies to... By default, status colors only apply to Requirement, Issue and Change elements.

You might decide to also apply these colors to other UML elements, such as Use
Cases or Classes.

To do this, click on the Applies to ... button and, in the 'Applied Status Colors' list,
select the checkbox against each element type to which to apply the status colors.

New Clear the dialog fields to create a new status.

Save Save the status, and add it to the Type list.
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Delete Remove the currently selected status from the Type list.
Type Lists the current status types and descriptions for each status.
Notes

e To display status colors on your diagrams, you must select the 'Show status colors on diagrams' checkbox on the
'Objects' page of the 'Options' dialog

e You can transport the status types (and the colors assigned to status types) between models, using the 'Export
Reference Data' and 'Tmport Reference Data' menu options

e  Requirement, Feature, Issue and Change elements have a status color compartment, whereas the status color for
other elements is applied to the element shadow; to show the element shadows (and hence the status colors), select
the 'Element Shadows on' checkbox on the 'Diagram Appearance' page of the 'Options' dialog
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Constraint Types

In an element 'Properties' definition, each constraint on the element is defined by type in the 'Constraint’' field. You can
select the appropriate value from a drop-down list, which initially contains the system values:

e Invariant

e  Post-condition
e  Pre-condition
e Process and

e OCL

You can add to or replace any of these values with your own custom values.

Access
Ribbon Configure > Reference Data > Project Types > General Types > Constraint
Menu Project | Settings | Project Types | General Types > Constraint

Customize Constraint Types

Field/Button Usage

Constraint Type the name of the constraint to define.
Description Type a brief description of the constraint.
Note Type any further details concerning the constraint.
New Clear the fields to define a new constraint.
Save Save the constraint definition and add it to the Defined Constraint Types list.
Delete Remove the currently selected constraint from the Defined Constraint Types list.
Defined Constraint Types Lists the currently-defined constraint types and their descriptions.

Notes

e  You can transport customized constraint types between models, using the 'Export Reference Data' and 'Tmport
Reference Data' menu options
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Constraint Status Types

In an element 'Properties' definition, each constraint's status in the development process is defined in the constraint
'Status' field. You can select the appropriate value from a drop-down list, which initially contains the system values:

e Implemented

e Build

e Validated

e  Approved

e  Mandatory and
e  Proposed

You can add to or replace any of these values with your own custom values.

Access
Ribbon Configure > Reference Data > Project Types > General Types > Constraint Status
Types
Menu Project | Settings | Project Types | General Types > Constraint Status Types

Customize Constraint Status Types

Field/Button Usage
Status Type the name of the constraint status to define.
Make Default To make the selected constraint status the default for all constraint 'Status' fields,

select the checkbox.

New Clear the fields to define a new constraint status.

Save Save the constraint status definition and add it to the Type list.
Delete Remove the currently selected constraint status from the Type list.
Type Lists the currently available constraint status types.

twinarrows Move the selected constraint type higher or lower in the Type list.

This defines the ordering used in the Status drop down combo boxes, and in sorting
any report or list when the Constraint Status Type is used as the sort-by property.

Sort Alphabetically Reorganize the entries in the Type list into alphabetical order.

Restore Defaults Remove all customized constraint status values and restore the system defaults.
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Notes

®  You can transport customized constraint status types between models, using the 'Export Reference Data' and 'Import
Reference Data' menu options
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Difficulty Types

Developing a particular element might be a simple task or more complex. In the element Properties definition, the level
of difficult of developing that element is defined in the 'Difficulty’ field. You can select the appropriate value from a
drop-down list, which initially contains the system values 'High', 'Medium' and 'Low'. You can add to or replace any of
these values with your own custom values.

Access
Ribbon Configure > Reference Data > Project Types > General Types > Difficulty
Menu Project | Settings | Project Types | General Types > Difficulty

Customize Difficulty Types

Field/Button Usage
Difficulty Type the name of the Difficulty to define.
Make Default To make the selected Difficulty the default for all 'Difficulty’ fields, select the
checkbox.
New Clear the fields to define a new Difficulty type.
Save Save the Difficulty definition and add it to the Type list.
Delete Remove the currently selected Difficulty from the Type list.
Type Lists the currently available Difficulty types.
twinarrows Move the selected type higher or lower in the '"Type' list.

This defines the ordering used in the 'Difficulty’ drop down combo boxes, and in
sorting any report or list when the Difficulty type is used as the sort-by property.

For example: you have several Change elements on a diagram, and you select
'Diagram View'; then you sort on the 'Difficulty' column. The 'Diagram View'
entries are grouped by difficulty, in the order you defined in this "Type' field.

Sort Alphabetically Reorganize the entries in the Type list into alphabetical order.
Restore Defaults Remove all customized Difficulty values and restore High, Medium and Low.
Notes
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e You can transport customized Difficulty types between models, using the 'Export Reference Data' and 'Tmport
Reference Data' menu options
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Priority Types

In an element Properties definition, the priority of developing that element is defined in the Priority' field. You can select
the appropriate value from a drop-down list, which initially contains the system values High', Medium' and '"Low'. You
can add to or replace any of these values with your own custom values.

Access
Ribbon Configure > Reference Data > Project Types > General Types > Priority
Menu Project | Settings | Project Types | General Types > Priority

Customize Priority Types

Field/Button Usage
Priority Type the name of the Priority to define.
Make Default To make the selected Priority the default for all Priority' fields, select the checkbox.
New Clear the fields to define a new Priority.
Save Save the Priority definition and add it to the Type list.
Delete Remove the currently selected Priority from the Type list.
Type Lists the currently available Priority types.
twinarrows Move the selected type higher or lower in the '"Type' list.

This defines the ordering used in the Priority' drop down combo boxes, and in
sorting any report or list when the Priority type is used as the sort-by property.

For example: you have several Change elements on a diagram, and you select
'Diagram View'; then you sort on the 'Priority' column. The 'Diagram View' entries
are grouped by priority, in the order you defined in this 'Type' field.

Sort Alphabetically Reorganize the entries in the Type list into alphabetical order.
Restore Defaults Remove all customized Priority values and restore High, Medium and Low.
Notes

®  You can transport customized Priority types between models, using the 'Export Reference Data' and 'Tmport
Reference Data' menu options
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Test Status Types

All tests defined in the Testing window and 'Test Details' dialog have a status value to show what point in the testing
cycle the test has reached. The system values you can select from the test 'Status' field are:

e Not Run
e Pass
e Fail

e Deferred and
e (Canceled

You can add to or replace any of these values with your own custom values.

Access
Ribbon Configure > Reference Data > Project Types > General Types > Test Status
Menu Project | Settings | Project Types | General Types > Test Status

Customize Test Status Types

Field/Button Usage
Status Type the name of the Test status to define.
Make Default To make the selected test status the default for all test 'Status' fields, select the
checkbox.
New Clear the fields to define a new Test status.
Save Save the Test status definition and add it to the Type list.
Delete Remove the currently selected Test status from the Type list.
Type Lists the currently available Test status types.
twinarrows Move the selected type higher or lower in the '"Type' list.

This defines the ordering used in the test 'Status' drop down combo boxes, and in
sorting any report or list when the Test Status Type is used as the sort-by property.

For example: you have run several tests on a Package, and you run a Test Details
report; then you sort on the 'Status' column. The report entries are grouped by test
status, in the order you defined in this 'Type' field.

Sort Alphabetically Reorganize the entries in the Type list into alphabetical order.

Restore Defaults Remove all customized Test status values and restore the system defaults.
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Notes

e You can transport customized Test status types between models, using the 'Export Reference Data' and 'Tmport
Reference Data' menu options
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Requirement Types

In a Requirement definition, the requirement is categorized according to type or function, in the 'Type' field of the
Requirement 'Properties' dialog. This helps to maintain a single set of typed requirements. You can select the appropriate
'"Type' value from a drop-down list, which initially contains the system values:

e Display

e  Functional

e  Performance
e  Printing

e Report

e  Testing and
e Validate

You can add to or replace any of these types with your own customized values.

Access
Ribbon Configure > Reference Data > Project Types > General Types > Requirement
Menu Project | Settings | Project Types | General Types > Requirement

Customize Requirement Types

Field Usage
Requirement Type the name of the requirement.
Description Type a short description of the requirement.
Weight Type a weighting to apply to the requirement type.
New Clears the dialog fields so that you can define a new requirement type.
Save Saves the requirement type details and adds it to the Defined Requirement Types
list.

Delete Deletes a selected requirement type from the Defined Requirement Types list.
Defined Requirement Lists the currently available requirement types.
Types

Notes
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e You can transport these requirement types between models, using the 'Export Reference Data' and 'Import Reference
Data' menu options
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Scenario Types

In the Scenario definitions for an element each scenario is of a specific type, which you define in the 'Type' field on the
'Scenario' page of the 'Properties’ dialog. You can select the appropriate value from a drop-down list, which initially
contains the system values:

e Exception
e Alternate and
e Basic Path

You can add to or replace any of these system types with your own customized values.

Access
Ribbon Configure > Reference Data > Project Types > General Types > Scenario
Menu Project | Settings | Project Types | General Types > Scenario

Customize Scenario Types

Field Usage
Scenario Type Type the name of the scenario type.
Description Type a short description of the scenario type.
Weight Type a value for the weighting to apply to the scenario type.
Notes Type any additional information to describe the scenario type.
New Clears the dialog fields so that you can define a new Scenario type.
Save Saves the scenario type and adds it to the Defined Scenario Types list.
Delete Deletes a selected scenario type from the Defined Scenario Types list.
Defined Scenario Types Lists the currently available scenario types to offer in the drop-down list of a

'Scenario Type' field.

Notes

®  You can transport customized scenario types between models, using the 'Export Reference Data' and Tmport
Reference Data' menu options
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Metrics and Estimation

TCF values, EFC values and Default Hour Rate for a project are controlled from the 'Estimation Factors' dialog.
Risk, metric and effort types for a project are controlled from the 'Project Indicators' dialog.

For further information on these see the Project Management and Project Resources topics, or specifically:

e  Technical Complexity Factors

e  Environment Complexity Factors

o  Default Hours

e  Effort Types
e Metric Types
e Risk Types
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Maintenance

Within your project, you can set up Maintenance types that determine the base Problem Types to be used within the
model.

Access
Ribbon Configure > Reference Data > Project Types > Maintenance
Menu Project | Settings | Project Types | Maintenance
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Problem Types

NOT CURRENTLY USED

For the maintenance and change control screens, you can use the 'Maintenance' dialog to set the base Problem Types that
are handled. Examples are hardware-related issues, performance problems, software bugs and network problems.

Access
Ribbon Configure > Reference Data > Project Types > Maintenance > Problem Types
Menu Project | Settings | Project Types | Maintenance > Problem Types

Define Problem Types

Field Action

Problem Type Type in the name of the problem type.

Description Type a short description of the problem type.

Weight Provide a weighting to apply to the problem type.

Note Type any additional information on the problem type.

Defined Types Displays all of the pre-defined and saved problem types.

New Click on this button to clear the dialog fields so that you can add a new problem
type.

Save Click on this button to save the scenario details and add it to the 'Defined Types'
list.

Delete Click on this button to delete a selected scenario from the 'Defined Types' list.

Notes

e You can transport these problem types between models, using the 'Export Reference Data' and 'Tmport Reference
Data' options

e You transport the problem types together with test types as a Maintenance Types file
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Testing Types

You can use the '"Test Types' tab of the 'Maintenance' dialog to add testing types to the basic set that comes with
Enterprise Architect. Typical test types are load tests, performance tests and function tests.

Access
Ribbon Configure > Reference Data > Project Types > Maintenance > Test Types
Menu Project | Settings | Project Types | Maintenance > Test Types

Notes

®  You can transport these test types between models, using the 'Export Reference Data' and Tmport Reference Data'
options

e  You can either export the test types together with the default problem types, as a Maintenance Types file, or
separately as a Test Types file

Reference
Field Action

Test Type Type the name of the test type.
Description Type a short description of the test type.
Weight Type a weighting to apply to the test type.
Note Type any additional information on the test type.
Defined Types Displays all of the pre-defined and saved test types.
New Add a new test type.
Save Saves the scenario details and adds it to the 'Defined Types' list.
Delete Deletes a selected scenario from the 'Defined Types' list.
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Data Types

Different programming languages support different inbuilt data types. It is possible for you to manage and extend this set
of inbuilt data types for a standard programming language, as well as define new programming languages for use within
Enterprise Architect.

Access
Ribbon Configure > Reference Data > Settings > Code Engineering Datatypes
Menu Project | Settings > Code Engineering Datatypes

Programming Language Datatype Options

Field Usage
Product Name Click on the drop-down arrow and select the name of the programming language.
Add Product Click on this button to display a prompt for the name of a new programming
language.

Type the name and click on the OK button.
Datatype Type the language-specific name of the datatype.

Common Type Type the common (or generic) name of the datatype; for example, the Java boolean
datatype has a common datatype Boolean.

New Click on this button to clear the fields to create a new datatype.

Save Click on this button to save the newly created or updated datatype.

Delete Click on this button to delete the selected datatype.
You can delete your own custom data types, but you cannot delete any of the
predefined data types.

Defined Datatypes for Review the list of datatypes for the selected language, and click on any that you

Programming Languages want to edit or delete. The details for the selected datatype display in the dialog
fields.

Notes

e You do not need to set the options in the 'Size' panel

e  Once you have defined at least one datatype for a new language, that language name is added to the drop-down list
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for the 'Language' fields in the 'Programming Languages Datatypes' dialog, in the Code Template Editor, and in the
'"Properties' dialog for each Class element within the model

e  You can transport these data types between models, using the 'Export Reference Data' and Tmport Reference Data'
menu options

e In the Corporate, Business and Software Engineering, System Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have 'Configure Datatypes' permission to update and delete data types
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The Resources window is a repository of project-standard and re-usable document generation templates, MDG
Technologies, Relationship Matrix profiles, commonly-used model elements, stylesheets, UML Profiles and UML
Patterns. The window provides facilities for creating and modifying these structures and facilities and, in some cases, for
applying the facility to the current model directly from the window.

Access

Ribbon

Menu

Keyboard Shortcuts

Start > Explore > Resources
Show > Window > Resources

Configure > Reference Data > Resources
View | Resources

Alt+6

Resources available through the Resources window

Notes

e In the Corporate, Business and Software Engineering, Systems Engineering and Ultimate editions of Enterprise
Architect, if security is enabled you must have 'Configure Resources' permission to maintain Resources window

items

e  For a number of folders in the Resources window, the right-click context menu also offers a 'Help' option that, when
you select it, displays a brief description of the folder

Resource

Document Generation
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Description

The Document Generation folder holds a number of sub-folders, each of which
provides the facilities for generating a particular type of document or report from
your model.

e System Templates - this sub-folder itself has sub-folders containing
system-defined report templates, Fragments, Cover Pages, Style Sheets and
Table of Contents definitions
You can right-click on these template names and select options to display the
template contents or to copy the template as the basis of a user-defined
template that you work on in the Document Template Editor, under a different
name; you can also select the 'Override' option to create a copy of the system
template as a user template with the same name

e User Templates - this sub-folder also has sub-folders for report templates,
Fragments, Cover Pages, Style Sheets and Tables of Contents, but these are the
templates that you have created yourself using the Document Template Editor,
either as new or by copying and editing another template
You can right-click on these template names and select options to create,
delete, rename, modify, move or copy a user-defined template; you have
additional options to mark a report template as a Fragment, or a Fragment as a
report template, if they are suitable for this reclassification
You can also 'drag and drop' user-defined templates between user-defined
groups, and between these groups and the appropriate standard 'type' folders;
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for example, from DavidCover to Cover Pages

e  Technology Templates - If you have loaded an MDG Technology containing
document templates, those are also listed under the Technology name

e  Web Style Templates - this sub-folder contains the HTML style templates that
you have created as alternatives to the system-supplied <default> template
To create a new template, right-click on the folder name and select the 'Create
HTML template' option, and provide a template name; this opens the HTML
and CSS Style Editor, in which you create the template from HTML
fragments
You can right-click on the template names and select options to delete the
template or modify the template contents

e Defined Documents - this folder holds the Resource documents (report
specifications) you have created in the Document Report Generator; you can
right-click on the document name to generate documents individually or as a
batch, open the generated document, or delete the report specification

e Linked Document Templates - this folder holds the non-standard Linked
Document templates, either user-defined or supplied with each MDG
Technology enabled on the system; you can edit or delete any of these existing
templates, or create new ones from scratch or by copying an existing template,
including the system-provided linked document templates
You can also re-assign the templates to different template groups, either
another of the existing groups or a new one that you create as part of the
assignment

e Legacy Templates - if you are, or have been, using the original (legacy)
Enterprise Architect report generator, this sub-folder contains the report
templates that you use to generate the documents
You can continue to create, modify, use and delete legacy style templates, but
it is recommended that you switch to the later report generator

MDG Technologies The MDG Technologies folder lists the MDG Technologies that have been
imported directly into the Resources window. Each technology extends the
modeling capabilities and facilities of Enterprise Architect.

You can import Technologies into your project by right-clicking on the MDG
Technologies folder and selecting the 'Import Technology' menu option. The 'Copy
Technology to Application Data' dialog then gives you the option to import the
Technology to:

e 'User, for your individual use; the Technology is imported into the
%APPDATA% folder and is not listed in the Resources window

e 'Model', for all project users to access; the Technology is imported into the
Resources window

If you have any MDG Technologies in the folder, each has its own subfolder
containing the Profiles, Patterns and code modules used in the technology. You can
right-click on these and select options to delete the technology, review the Patterns
or Profiles, or invoke the code modules.

If you remove the technology, it is removed from the Resources window, the 'MDG
Technologies' dialog, and the model.

Consider the fact that some MDG Technologies can be large and might impose
some delays on the workstation as they load each time a user connects to the model.

Matrix Profiles The Matrix Profiles folder contains a list of Relationship Matrix Profiles that you
or your team members have created using the Relationship Matrix or Specification
Manager. You simply double-click on a Matrix Profile name to quickly open the
Relationship Matrix under the settings defined in the Profile.

Favorites The Favorites folder provides a shortcut to each commonly-used element that you
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have added to the folder, so that you can quickly and easily locate the elements and
add them to diagrams.

Stylesheets The Stylesheets folder contains XSL stylesheets that you or your team members
have imported into the model. These XSL stylesheets support the optional step of
converting XMI files exported from the model into alternative formats such as
HTML, XSL or source code. Stylesheets imported here are then available in the
drop-down lists on the 'XML Export' dialog and the 'Generate GML Application
Schema' dialog.

Combined with UML Profiles, this is a powerful means of extending Enterprise
Architect to generate almost any content required.

To import a stylesheet:
1. Right-click on the folder name and select the Tmport Stylesheet' option.

2. Locate and select the stylesheet file in the browser, and click on the Open
button.

3. Provide a reference name for the file, and click on the OK button.

Once the stylesheet is in the folder, you can select context menu options to reload it
(if it has been changed at the source) or delete it.

UML Profiles A Profile is a source of modified or extended element and connector types that you
have developed from the UML base types. You can import each new Profile into
this folder, and then create elements and connectors of the new types by dragging
the icons from the Profile onto a diagram.

Once you have Profiles in the folder, you can select options for arranging them in
order of name or type, viewing a Profile description, or deleting a Profile.

It is possible to synchronize the Tagged Values and constraints for any elements
created from a Profile element in the Resources window.

Importing and applying Profiles through the Resources window is no longer
recommended; from Enterprise Architect release 7.0. it is recommended that you
load and apply Profiles as components of MDG Technologies.

UML Patterns The UML Patterns folder is a folder of UML Design Patterns that you or your team
members have imported into the model. A Pattern captures complex new elements
and features that you can drag into a diagram without having to retype or
reconfigure each element.

Within the folder, the Patterns are grouped by type. Once you have Patterns within
a group, you can select options to delete all Patterns in the group or just the selected
Pattern, view a Pattern's details, or apply a Pattern to an empty diagram.
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Favorites

If you have any elements that you or your team use frequently - such as the list of Actors in a system - you can add them
to the Favorites folder in the Resources window, and use that as the source for conveniently dragging and dropping
instances of or links to these elements into other diagrams. This makes it much easier to locate and use the elements as
you create and manage your model.

a [_] Favorites

4 Class
AddressBook
Contacts

Access
Ribbon Start > Explore > Resources > Favorites, or
Show > Window > Resources > Favorites, or
Configure > Reference Data > Resources > Favorites
Menu View | Resources | Favorites
Keyboard Shortcuts Alt + 6 | Favorites

Actions on the Favorites Folder

Action Detail
Add an element to the e In adiagram, right-click on the element to add
Favorites Folder e From the context menu select the 'Find | Add to Favorites' option

e  Switch to the Resources window and expand the Favorites folder; the added
element is listed within its element-type category (such as Class)

You add elements to the Favorites folder individually.

Delete an element from the e Right-click on the element within the Favorites folder in the Resources
Favorites Folder window

e From the context menu select the 'Delete Favorite' option

e A confirmation prompt displays; click on the Yes button

View Properties of an e  Select and right-click on the element in the folder
element in the Favorites e  From the context menu, select the 'Element Properties' option; the element
Folder "Properties’ dialog displays

Notes
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e When you have had the Favorites folder open for some time and other users might have been adding to it, right-click
on the folder name and select the 'Refresh Favorites' option to update your view of the folder with the new contents
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Sharing Reference Data

You can conveniently update your models with reference data (including Glossary and Issue information) by exporting
the data to and importing the data from .XML files to (for example):

o Copy glossaries from one model to another

e Add additional profiles by merging new stereotypes into the model

e  Update reference data from files supplied by Sparx Systems as a maintenance release
e  Copy resources, clients and so on from one model to another

You import data into the model automatically or manually from a reference data . XML file, exported from another model
or an iteration of the current model.
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Link Reference Data to a Shared Repository

If you have a number of projects that use the same sets of reference data, you can use a central project containing that
common data as a shared repository. The common data includes system resources such as Security Users and Groups,
Glossary terms or Data Types. Shared repositories make it possible for teams working on multiple projects to leverage a
common and consistent set of system resources. Common standards and definitions can be applied across all projects
using this repository. Any time a new project is started, that project can automatically inherit some or all of these
common resources from the repository; there is no need to establish these resources again for each project.

Shared repositories apply to Database Management System (DBMS) based Enterprise Architect projects and can link all
projects residing within one DBMS.

A new DBMS based project in Enterprise Architect is initially created with its own stand-alone repository. A single step
process then allows that new project to be linked to the shared repository residing on its DBMS. Any older or
pre-existing Enterprise Architect projects can also be linked to the shared repository, taking their resource data from the
master version. This then allows for centralized management of the contents of the repository, promoting or enforcing
common usage and standards.

Any changes to the shared repository are automatically available to every participating project.

Access
Ribbon Configure > Model > Transfer > Shared Repository
Menu Project > Data Management > Shared Repository

Set up a shared repository

Step Action

1 Create the script file to set up the shared repository, as explained in the next table.

2 Execute the generated SQL script using a third-party tool.

Select the repository tables to share

Field/Button Action

Script File Type in the location into which the script file will be generated by this dialog, or
click on the D button and search for it.

Main Repository Type in the name of the current main repository.

Shared Repository Type in the name of the database to be used as the shared repository.

This name cannot be the same as the name of the main repository.
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Table Groups In the list of table groups that can be linked to the shared repository, select the
checkbox against each table group to share in the repository.

Tables in each group (Read only) Review the list of database tables in the currently-selected table group.
All of these tables in the selected group will be available through the shared
repository.

Generate Click on this button to generate the SQL script to link the selected tables of the

current (main) repository to the shared repository. The script is generated into the
file location you specified in the 'Script File' field.

View Script Click on this button to open the generated script file in the default Code Editor, and
to close the dialog.

Close Click on this button to close the dialog.

Notes

e This feature is not applicable to projects that are based on local project files (.eap or .feap)

e Shared repositories are supported for MySQL, SQL Server and Oracle
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Export Reference Data

When you have a complete project set up, with fully defined project data, it is possible to capture either selected
categories or all categories of that data, and export it to a single XML file. You can then review the data, and import it to
another project or tool so that you do not have to define it all again. The exported data includes all instances of the
selected data type in the project; for example, all defined cardinality values, or all Document Style Templates.

Access
Ribbon Configure > Model > Transfer > Export Reference Data
Menu Project > Data Management > Export Reference Data

Select and Export Reference Data

Step Action

1 On the 'Export Reference Data' dialog, click on the ' + ' box against each table group you want to expand.

2 Select the checkbox against each table or table group to export.

If you select the top-level, group-name checkbox, all tables in that group are selected for export.

3 Click on the Export button.
4 When prompted to do so, enter a valid file name with a . XML extension.
5 Click on the Save and OK buttons.

This exports the data to the file; you can use any text or XML viewer to examine the file.

Notes

e You can resize the 'Export Reference Data' dialog; drag the dialog edges to the size you need

e If there are no instances of a selected data type in the project, the export does not generate any output for that data
type in the XML file

e  Currently, Standard Complexity Types cannot be directly edited and are therefore effectively standard for all
models; they can be listed using the Predefined Reference Data Tagged Value type ComplexityTypes
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Import Reference Data

It is possible to import reference data into your model from an . XML file that was exported from another model or from
an iteration of the current model, either:

e Manually, whenever you know there is new or changed data to apply, or

e Automatically whenever the model is reloaded into Enterprise Architect (if the file has changed since the previous
import)

The automatic import checks if the source file has changed since the last import; if the file has not changed, the import
does not proceed. If the file has changed, the changed data is imported; however, you can configure the system to display
a prompt for you to allow or cancel the import.

Access
Ribbon Configure > Model > Transfer > Import Reference Data > Import File
Configure > Model > Transfer > Import Reference Data > Shared File
Menu Project > Data Management > Import Reference Data > Import File

Project > Data Management > Import Reference Data > Shared File

Import reference data manually (Import File)

Step Action

1 On the 'Tmport Reference Data' dialog, click on the Tmport File' tab and on the Select File button, then
select the filename to import data from.
This would be an XML file produced by the Enterprise Architect Data Exporter.

2 If you have selected a valid file, a list of available tables to import displays in the 'Select Datasets to
Import' panel.

3 Click on one or more of the tables to import.

Press Ctrl or Shift to click on multiple tables.

4 Click on the Import button to start the process.

A message displays when the import is complete; generally the process is quite fast.

Import reference data automatically (Shared File)

Step Action

1 On the 'Import Reference Data' dialog, click on the 'Shared File' tab.
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2 If you are changing an existing configuration to import from a different XML file, click on the Clear
button to clear the dialog fields.

3 Click on the Select File button and browse for the filename to import data from.
This would be an XML file produced by the Enterprise Architect Data Exporter.

4 If you have entered the name of a valid file, a list of tables to import displays in the 'Datasets in File'
panel.

Click on one or more of the tables to import. Press Ctrl or Shift to click on multiple tables.

5 If you prefer to control whether or not the automatic import takes place, select the 'Always prompt before
import' checkbox.

6 Click on the Import button to import the reference data now, and to enable the automatic check and
import for subsequent reloads.

Notes

Concerning General Types data:

e For Statuses, Constraints, Requirements and Scenarios, the imported data is merged with the existing data; if a
record already exists it is updated to the new values, and if the record does not exist, a new record is added - records
are never deleted

e  For Constraint Status Types, Difficulty, Test Status and Priority, the complete existing list is replaced by the
imported list

Concerning Calendar events and event types, Team Review configurations, Patterns and Gap Matrix Profiles:

e The imported data is merged with the existing data; if a record already exists it is updated to the new values, and if
the record does not exist, a new record is added - records are never deleted

Concerning Images; for MS SQLServer Repositories:
e Importing images as reference data into a SQLServer repository is not supported when connected via Cloud Services

e To import images as reference data you must have additional MS SQL Server permissions, so that you can perform
'Set Identity On/Off' commands; the role of db_ddladmin provides the required permissions, however this approach
might not be allowed in your environment so discuss this requirement with your DBA to find an appropriate solution
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